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1 Introduction
GFI FaxMaker is a fax server that enables your network users to send and receive faxes and SMS directly from their
machine. GFI FaxMaker centralizes your fax infrastructure, without maintaining multiple fax machines distributed across
the office(s) and eliminates the need to print a fax before sending or when receiving a fax.

GFI FaxMaker for Exchange/SMTP integrates with various mail servers such as Microsoft® Exchange Server, Lotus Notes
and with other SMTP/POP3 mail servers.

While every effort is made to ensure that all functionality and references to third party software is correct, there might be
discrepancies due to updates at the discretion of the aforementioned third party vendors. Report any variations to
documentation@gfi.com.

1.0.1 Conventions used in this manual

Convention Description

> Step by step navigational instructions to access a specific function.

Bold text Items to select such as nodes, menu options or command buttons.

Italics text Parameters and values that you must replace with the applicable value, such as custom paths and file names.

Code Indicates text values to key in, such as commands and addresses.

1.1 How fax sending works

Step 1: Various methods used to send a fax

The fax content is sent to GFI FaxMaker using one of the various supported methods:

Via email

GFI FaxMaker Client application

mailto:documentation@gfi.com
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NetPrintQueue2Fax

Text, XML or Web Service API

Formore information, refer to How users send faxes (page 63).

Step 2: GFI FaxMaker processes fax content

GFI FaxMaker processes the received content and prepares it for transmission. Amongst others, GFI FaxMaker:

Resolves and formats the number to dial

Converts content to fax format

Adds any coverpages

Adds any headers and footers

Formore information, refer to Configuration - Sending faxes (page 109).

Step 3: Fax transmission

GFI FaxMaker transmits the fax:

to an installed fax device which in turn transmits the fax over the telephone line

or to a hosted fax service.

1.2 How fax receiving works

Step 1: Receive fax call

The sender transmits the fax. This is received by GFI FaxMaker either from a fax line or from a hosted fax service.

Step 2: GFI FaxMaker processes fax & content

GFI FaxMaker processes the received fax. Amongst others:

(Optional) Blocks junk faxes.

(Optional) Optically recognizes text in fax (OCR).

Determines recipients according to fax routing settings.

Forwards fax by email to appropriate users.

Formore information, refer to Configuration - Receiving faxes (page 144).
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Step 3: Recipients receive the fax

The fax recipients receive the fax in their mailbox. Formore information, refer to How users view received faxes
(page 67).
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2 System Requirements
Before installing GFI FaxMaker, ensure that the systemmeets or exceeds the below requirements. If these requirements
are not met, youmay encounter problems during installation or in functionality.

NOTE
The below requirements are for GFI FaxMaker software only. Third-party software or hardware (such as fax cards and
their drivers) may have higher or different requirements. Ensure that the systemmeets or exceeds the requirements
for both GFI FaxMaker and third-party software/hardware.

2.1 Software requirements 13

2.2 Hardware requirements 14

2.3 Backup software 15

2.4 Anti-virus software 15

2.5 Firewall settings 15

2.1 Software requirements

Supported operating systems

Install GFI FaxMaker on any of the 32-bit or 64-bit versions of the operating systems listed below.

Operating system (32-bit or 64-bit)

Windows Server® 2012 R2 Standard, Datacenter, Essentials & Foundation

Windows Server® 2012 Standard, Datacenter, Essentials & Foundation

Windows Server® 2008 R2 Standard & Enterprise

Windows Server® 2008 Standard & Enterprise

Windows Server® 2003 Standard & Enterprise

Windows® SBS 2011 Standard & Premium

Windows® SBS 2008 Standard

Windows® SBS 2003

Windows® 8 and 8.1 - Pro & Enterprise

Windows® 7 - Ultimate, Enterprise & Professional

Windows® Vista - Ultimate, Enterprise & Business

Supported mail servers

Install GFI FaxMaker in an environment with any of the mail servers listed below.

Microsoft® Exchange Server

Microsoft® Exchange cluster environments

Lotus Notes/Domino

Table 1: Supported mail servers
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Hosted mail servers

Other SMTP/POP3 servers

Formore information, refer to Mail server configuration (page 16).

NOTE
The GFI FaxMaker server requires a public IP address when using a hosted email service, such as Microsoft® Office
365™ or Google Apps for Business. Formore information, refer to Hosted email (page 39).

Other required components

Component Environment

Microsoft®

.NET Frame
work 4 or over

Required as from GFI FaxMaker version 2013 Service Release 3.

IIS SMTP ser
vice

Required when installing on a separate machine other than the mail server.
NOTES:

Ensure that the SMTP service is running in the Services applet.
This service is not available on Microsoft® Windows® 8.1, 8, 7 or Vista. In this case, fax/SMS emails cannot be routed

to GFI FaxMaker via this service. Use a POP3 mailbox instead. For more information, refer to Installing GFI FaxMaker
on Windows 8.1, 8, 7 or Vista (page 61).

Hub Transport
role

Required for Microsoft® Exchange Server 2007/2010/2013.

Internet
Explorer® 6 or
later

Required for HTML cover pages.

Table 2: Required components for installation

2.2 Hardware requirements
Install GFI FaxMaker on a server with the following minimum specifications.

Component Minimum requirement

Processor Intel Pentium or compatible - 2GHz 32 bit processor

Memory 1GB RAM (dedicated to GFI FaxMaker)

Physical
storage

500 MB required for GFI FaxMaker installation only.
Note: Temporary fax storage, archiving and backup require extra space depending on the amount and size of faxes
processed.

Table 3: Hardware requirements for installation

2.2.1 Fax transmission

GFI FaxMaker requires at least one mechanism that enables sending and receiving of faxes.

Component Description

Fax device A professional fax modem class 2, 2.0 or 2.1 using either the Microsoft® or the GFI fax modem drivers, such as: Brooktrout
TR 1034 or Trufax fax board, a Dialogic Diva Pro/Server fax card or an AVM active fax card.
For a complete list of supported devices, refer to: http://go.gfi.com/?pageid=FM_Devices
NOTE: For more information related to the installation of fax devices go to:
http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=FDIManual
NOTE: Minimum requirements for particular fax devices may be higher than GFI FaxMaker’s.

Table 4: Components for fax transmission

http://go.gfi.com/?pageid=FM_Devices
http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=FDIManual
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Component Description

Online fax
service

An account with a supported online fax provider. For more information go to http://go.gfi.com/?pageid=FM_
FaxServices.
To use this service, the GFI FaxMaker machine must be able to connect to the fax provider via Internet.

2.3 Backup software
Backup software can cause GFI FaxMaker tomalfunction if GFI FaxMaker is denied access to some of its files.

Backup GFI FaxMaker installation files only when GFI FaxMaker services are not running. From the Services applet, stop
the following services:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker WSAPI

Formore information, refer to Configuration backup (page 103).

2.4 Anti-virus software
Anti-virus software causes GFI FaxMaker tomalfunction if GFI FaxMaker is denied access to some of its files. Add an anti-
virus exclusion that prevents the anti-virus engine from scanning the GFI FaxMaker installation folder and other folders
used by the product, such as the Text and XML API folders.

2.5 Firewall settings
Configure your firewall to allow connections from the GFI FaxMaker server on the following ports:

Port Protocol Description

25 TCP/UDP IIS SMTP - Used by GFI FaxMaker to communicate with mail server.

135-139 TCP/UDP Microsoft® file sharing Server Message Block (SMB) - Used by the GFI FaxMaker remote management tools to
connect to the GFI FaxMaker share.

445 TCP/UDP Direct-hosted SMB traffic without a network basic input/output system (NetBIOS) - Used by the GFI FaxMaker
remote management tools to connect to the GFI FaxMaker share.

8555 TCP Used by the GFI FaxMaker Client and Web Services API. This port can be automatically opened whilst running
the GFI FaxMaker Configuration Wizard.
For more information refer to http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=FirewallPorts

Table 5: Communication ports used by GFI FaxMaker

http://go.gfi.com/?pageid=FM_FaxServices
http://go.gfi.com/?pageid=FM_FaxServices
http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=FirewallPorts
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3 Mail server configuration
When users send fax or SMS by sending an email tonumber@faxmaker.com, the mail server must route this email
to GFI FaxMaker to enable fax transmission. To enable this functionality, configure routing connectors on your mail server
that route all emails addressed to *@faxmaker.com and *@smsmaker.com to GFI FaxMaker.

NOTE
When installing GFI FaxMaker on Microsoft® Windows® 8.1, 8, 7 or Vista, faxes cannot be routed to GFI FaxMaker using
connectors. Use a POP3 mailbox instead. Formore information, refer to Installing GFI FaxMaker on Windows 8.1,
8, 7 or Vista (page 61).

Choose the email service type:

3.1 Microsoft Exchange 16

3.2 Lotus Notes/Domino 24

3.3 Hosted email 39

3.4 Other mail environments 49

3.5 Using GFI FaxMaker without a mail server 50

3.1Microsoft Exchange
In a Microsoft Exchange environment, GFI FaxMaker can be installed directly on the Microsoft Exchange server or on a
separate machine.

For Microsoft Exchange clusters, refer toMicrosoft Exchange cluster.

3.1.1 Install directly on Microsoft Exchange server
GFI FaxMaker can be installed directly on a Microsoft® Exchange Server 2000/2003/2007/2010/2013 environment.

NOTE
When installing on aMicrosoft® Exchange 2007/2010/2013 server, the Hub Transport role is required. Formore
information, refer to System Requirements (page 13).

Figure 1: GFI FaxMaker installed on the Exchange 2000/2003/2007/2010/2013 server
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During installation, GFI FaxMaker automatically configures Microsoft® Exchange to process faxes and SMS. No further
configuration is required post-installation.

Process Description

Client side Users send faxes/SMS via email using Microsoft® Outlook® or via the GFI FaxMaker Client application.

Sending
faxes/SMS

The mail server is automatically configured to route all emails addressed to faxmaker.com, smsmaker.com, Fax: &
SMS: to GFI FaxMaker.

Received
faxes/SMS

After determining the users to whom to forward incoming faxes/SMS, GFI FaxMaker sends transmission report via
Microsoft® Exchange.

3.1.2 Install on a machine separate than Microsoft Exchange
When GFI FaxMaker is not installed directly on the Microsoft Exchange server, configure connectors on the mail server
that route fax and SMS to GFI FaxMaker.

3.1.3 How it works

Figure 2: GFI FaxMaker installed on a dedicated server

Process Description

Client side Users send faxes/SMS via email using Microsoft® Outlook® or via the GFI FaxMaker Client application.

Sending
faxes/SMS

SMTP connectors on the Microsoft® Exchange server forward all emails addressed to *@faxmaker.com,
*@smsmaker.com, Fax: & SMS: to GFI FaxMaker.

Received
faxes/SMS

After determining the users to forward incoming faxes/SMS to, GFI FaxMaker sends transmission report via SMTP to
the Microsoft® Exchange server.

Creating the connectors

Create SMTP connectors on Microsoft® Exchange to route all emails addressed to faxmaker.com, smsmaker.com, fax:
and sms: to GFI FaxMaker.

NOTES

1. To use this setup, install the IIS SMTP service on the GFI FaxMaker server.

2. The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Formore information, refer to Fax and SMS domain names (page 85).

1. Run the GFI FaxMaker setup on the Microsoft® Exchange server (the Hub Transport role for Microsoft® Exchange 2007
onwards).

2. When choosing the components to install, disable GFI FaxMakerFaxServerand select Exchange
2000/2003/2007/2010/2013SMTPconnector.

3. In the next screen, specify the IP address or server name of the GFI FaxMaker server.
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4. Proceed with installation.

The setup creates the required connectors on Microsoft Exchange. For more information about connectors, go to:

Microsoft® Exchange 2007/2010/2013: Formore information, refer to Microsoft® Exchange 2007/2010/2013
Connector (page 18).

Microsoft® Exchange 2000/2003:Formore information, refer to Microsoft® Exchange 2000/2003 Connector
(page 19).

3.1.4 Microsoft® Exchange 2007/2010/2013 Connector
When using GFI FaxMaker in a Microsoft® Exchange 2007/2010/2013 environment, configure SMTP connectors
to route all emails addressed to faxmaker.com, smsmaker.com, fax: and sms: to GFI FaxMaker.

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Formore information, refer to Fax and SMS domain names (page 85).

Creating the connectors automatically

GFI FaxMaker installed on Microsoft® Exchange Hub Transport Server

During installation, GFI FaxMaker automatically configures Microsoft® Exchange to allow processing of faxes and SMS.

The setup creates a Foreign Connectorand a Receive Connectornamed GFIFaxMaker.

No further configuration is required post-installation.

GFI FaxMaker installed on a separate machine

To configure connectors when installing GFI FaxMaker on a separate machine than Microsoft® Exchange
2007/2010/2013 Hub Transport role server:

1. Run the GFI FaxMaker setup on the Microsoft® Exchange Hub Transport server.

2. When choosing the components to install, disable GFI FaxMakerFaxServerand select Exchange
2000/2003/2007/2010/2013SMTPconnector.

3. In the next screen, specify the IP address or server name of the GFI FaxMaker server.

4. Proceed with installation.

The setup creates a Send Connectorand a Receive Connectornamed GFIFaxMaker.

Formore information, refer to Installation procedure (page 53).

Creating the connectors manually

GFI FaxMaker installed on Microsoft® Exchange Hub Transport Server

Use the following Microsoft® Exchange Management Shell commands to create the connectors manually when GFI
FaxMaker is installed on Microsoft® Exchange Hub Transport Server. This procedure is not usually required since GFI
FaxMaker automatically configures the connectors automatically during installation.

1. Create a Receive Connector:

new-receiveconnector -name "GFIFaxMaker" -Bindings "0.0.0.0:25" -RemoteIPRanges
"127.0.0.1" -AuthMechanism "ExternalAuthoritative" -PermissionGroups
"ExchangeServers" -fqdn "faxmaker.com"
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2. Create and set a Foreign Connector:

New-ForeignConnector -Name GFIFaxmaker -AddressSpaces "SMTP:faxmaker.com" ,
"SMTP:smsmaker.com" , "FAX:*" , "SMS:*"

Set-ForeignConnector -Identity GFIFaxmaker -DropDirectory "C:\Program Files (x86)
\GFI\FAXmaker\Sinkdrop"

Change C:\Program Files (x86)\GFI\FAXmaker with the path to your GFI FaxMaker installation folder.

NOTE
A Send Connector should not be created when GFI FaxMaker is installed on the Hub Transport Server.

GFI FaxMaker installed on a separate machine

To create the connectors manually, when GFI FaxMaker is installed separately from the Microsoft® Exchange Hub
Transport server:

1. From the Microsoft® Exchange Management Shell, create a Receive Connector:

new-receiveconnector -name "GFIFaxMaker" -Bindings "0.0.0.0:25" -RemoteIPRanges
"10.10.10.10" -AuthMechanism "ExternalAuthoritative" -PermissionGroups
"ExchangeServers" -fqdn "faxmaker.com"

Replace 10.10.10.10 with the IP address of the GFI FaxMaker machine.

2. Create a Send Connector:

new-sendconnector -name "GFIFaxmaker" -AddressSpaces SMTP:faxmaker.com ,
SMTP:smsmaker.com , FAX:* , SMS:* -DNSRoutingEnabled:$false -SmartHosts
"10.10.10.10"

Replace 10.10.10.10 with the IP address or name of the GFI FaxMaker machine.

NOTES
1. The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. If using custom domains, key in the custom domains instead.

2. A Foreign Connector should not be created when installing GFI FaxMaker separately from the Hub Transport
Server.

3.1.5 Microsoft® Exchange 2000/2003 Connector
The SMTP connector is a standard Microsoft® Exchange SMTP connector, configured to route to GFI FaxMaker server all
emails addressed to faxmaker.com, smsmaker.com, fax: and sms:.

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Formore information, refer to Fax and SMS domain names (page 85).

Access the connector from:

1. Launch Exchange System Managerand expand Connectorsnode.

2. Right click FaxMakerSMTPconnectorand select Properties.

Creating the connector automatically

GFI FaxMaker installed on Microsoft® Exchange Server

During installation, GFI FaxMaker automatically configures a Microsoft® Exchange connector to allow processing of faxes
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and SMS.

No further configuration is required post-installation.

GFI FaxMaker installed on a separate machine

To configure connector when installing GFI FaxMaker on a separate machine than Microsoft® Exchange 2000/2003
server:

1. Run the GFI FaxMaker setup on the Microsoft® Exchange Hub Transport server.

2. When choosing the components to install, disable GFI FaxMakerFaxServerand select Exchange
2000/2003/2007/2010/2013SMTPconnector.

3. In the next screen, specify the fully qualified domain name of the GFI FaxMaker server. Youmay also specify the GFI
FaxMaker server IP address but this may be subject to change.

4. Proceed with installation.

Formore information, refer to Installation procedure (page 53).

Creating the connector manually

1. FromMicrosoft® Exchange server, launch Exchange System Managerand right-click Connectorsnode.

2. Select New > SMTPConnector.

Screenshot 1: Specifying IP/Name of GFI FaxMaker machine

3. From General tab, configure the following settings:
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Key in name GFI FaxMakerSMTPConnector

Select option Forward all mail through this connector to the following smart hosts

Key in the name or IP of the GFI FaxMaker server enclosed within square brackets (for example, [100.130.130.10])

Click Add… in Local bridgeheadsand select the default virtual SMTP Server.

4. From the AddressSpace tab, click Add.

5. Select Otherand click OK.

Screenshot 2: Specifying FAX as an address space

6. In OtherAddressSpace Propertiesdialog, key in FAX in Type text box, and * in the Address text box. Click OK.

NOTE
This will forward all mails addressed to FAX: to GFI FaxMaker. You can repeat steps 4, 5 & 6, specifying SMS in the
Type text box to forward SMSs addressed to SMS: to GFI FaxMaker.

7. From the AddressSpace tab, click Add.

8. Select SMTPand click OK.
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Screenshot 3: Specifying faxmaker.com

9. In Internet AddressSpace Propertiesdialog, key in faxmaker.com in E-mail domain text box. Click OK.

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. If using custom domains, key in the custom domain instead.

10. Repeat steps 7, 8, 9 for smsmaker.com domain.
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Screenshot 4: The address space tab

9. In the Connectorscope section, select Routing group.

10. Click OK to create the connector.

3.1.6 Microsoft Exchange cluster
To install GFI FaxMaker in a Microsoft® Exchange cluster environment:

1. Install GFI FaxMaker on amachine that does not form part of the cluster.

2. On each cluster node, setup Microsoft® Exchange SMTP connectors to forward emails addressed to *@faxmaker.com,
*@smsmaker.com, Fax: & SMS: to GFI FaxMaker.

Create connectorsautomatically: Run the GFI FaxMaker setup (same one used to install GFI FaxMaker) on each
cluster node. When choosing which components to install, disable GFI FaxMakerFaxServerand select Exchange
2000/2003/2007/2010/2013SMTPconnector. In the next screen, specify the IP address or server name of the GFI
FaxMaker server. Formore information, refer to Installation procedure (page 53).

Create connectors manually:

Microsoft® Exchange 2000/2003:Formore information, refer to Microsoft® Exchange 2000/2003 Connector
(page 19).

Microsoft® Exchange 2007/2010/2013:Formore information, refer to Microsoft® Exchange 2007/2010/2013
Connector (page 18).
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NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. If using different domains, specify your custom domains. After installation, specify the
domains in the GFI FaxMaker Configuration. Formore information, refer to Fax and SMS domain names (page
85).

3.2 Lotus Notes/Domino
Use Lotus Notes/Dominowith GFI FaxMaker to send faxes and SMS.

GFI FaxMaker can be installed in a Lotus Domino/Notes 4/5/6/6.5 environment, either directly on the server or on a
separate machine. For larger networks it is recommended to install GFI FaxMaker on a separate machine than Lotus
Notes/Domino.

3.2.1 How it works

Figure 3: GFI FaxMaker installed on the Lotus Notes machine

Process Description

Client
side

Users send faxes/SMS using:
GFI FaxMaker Client - via the Fax Message Form.
Lotus Notes/Domino email client - send email to fax/SMS using the following address format <faxnum-

ber>@faxmaker.com or <smsnumber>@smsmaker.com.

NOTE: The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI FaxMaker
administrator. Use the configured fax or SMS domain accordingly. For more information, refer to Fax and SMS domain
names (page 85).

Sending
faxes/SMS

Lotus Notes/Domino routes faxes/SMS to a dedicated mailbox. GFI FaxMaker retrieves faxes/SMS from this mailbox via
POP3. To do this:

Create a dedicated mailbox for GFI FaxMaker in Lotus Notes/Domino.
Route all emails addressed to *@faxmaker.com and *@smsmaker.com to this mailbox.
Configure GFI FaxMaker POP3 Connector to retrieve emails stored in this mailbox.

NOTE: The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI FaxMaker
administrator.

Received
faxes/SMS

After determining the users to forward incoming faxes/SMS to, GFI FaxMaker sends transmission report via SMTP to the
Lotus Domino/Notes server.

Select the appropriate version:

Lotus Domino/Notes server 6.5

Lotus Domino/Notes server 6
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Lotus Notes 4 and 5

3.2.2 Lotus Notes 4 and 5

Step 1: Create a dedicated database for GFI FaxMaker

Screenshot 5: Creating a Notes Fax database

1. In the Notes Workspace select File > Database > New.

2. In New Database dialog, set the following options:

Option Setting

Server Local

Title GFI FaxMaker

Template Server Local

Template Mail (R5.0/6.0).

Table 6: Create database options

Click OK.

3. Right-click new database and select AccessControl.

4. In Managerrights, enable Delete document option.

Step 2: Define the database as a POPMailbox

1. From the Notes Workspace, navigate to Serverand open the server Addressbook.

2. Click Add Person.

3. From Basics tab, enter a Name and Password for the Mailbox and set the user name Fax.

4. From Mail tab, set Mail system to POPor IMAP.

5. From Internet message storage option, set Mail section to Notesand Internet Mail.

6. Click Save and Close.
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Screenshot 6: Setting up the POP mailbox for GFI FaxMaker

Step 3: Set up forwarding of the domain

1. From the Lotus workspace, open the address book and navigate to Server> Domains.
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Screenshot 7: Setting up a Foreign Domain in Lotus Notes

2. Click Add domain.

3. In the Basics section, set Domain type to Foreign Domain.

4. In the Foreign Domain Name field, enter the name of the domain youwant to set up (for example, fax).

5. Select the Mail information tab.



GFI FaxMaker 3Mail server configuration |28

Screenshot 8: Foreign Domain options

6. In Gatewayservername, key in the name of the server where the GFI FaxMaker mailbox is found (for example,
fax\gfi).

7. In Gatewaymail file name, key in the name of the GFI FaxMaker mailbox (for example, mail\GFI FaxMaker.nsf).

8. Click Save and close.

Step 4: Modifying the GFI FaxMaker Notesmailbox views

Set up the GFI FaxMaker mailbox views to allow the GFI FaxMaker MTA to see the forwarded mail.

1. Log on to the GFI FaxMaker mailbox client from a Notes client.

2. Select Design > Views.
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Screenshot 9: Modifying the mailbox views

3. Double-click ($POP3).

4. Delete all the entries in the script windows (lower window).

5. Save and close.
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Screenshot 10: The ($POP3) view
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3.2.3 Lotus Domino/Notes server 6

Step 1: Create a mailbox database on the Domino server

Screenshot 11: Creating a new database

1. FromDomino Administrator menu bar, select File > Database > New.

2. Select your Domino Server. Choose mail directory and enter GFIFaxMaker.nsf as the filename.

3. Click OK to create the database.

Step 2: Configure the Person for the GFI FaxMaker Domino database

1. FromDomino Administrator, click Add Person.
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Screenshot 12: Add a person

2. Fill in the following fields:

Option Setting

First name GFI FaxMaker

Last name Mailbox

User name GFI FaxMaker

Short name/User ID GFIFaxMaker

Internet Password Choose a POP3 password.

Mail System POP or IMAP

Mail Server Domino Server name

Internet Address The email address which will be able to receive email on the server.

Table 7: Lotus Domino Add person options

3. Click Save and Close.

Step 3: Give the GFI FaxMaker Person permission on the GFI FaxMaker database

1. In the Domino Administrator, select File > Database > Open to open the GFI FaxMaker database.



GFI FaxMaker 3Mail server configuration |33

Screenshot 13: Open the GFI FaxMaker database

2. Select server and browse to the GFI FaxMaker database. Click Open.

3. Navigate to File > Database > AccessControl.

Screenshot 14: Configuring permissions
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4. Click Add to add the GFI FaxMaker Person.

5. Select the GFI FaxMaker Person and from the Attributes section, select User type: Person, Access: Manager.

6. Select Delete Documents.

7. Click OK.

Step 4: Remove default $POP3 View

1. From Lotus Domino Designer, select File > Database > Open.

2. Select your Domino server, the mail directory and GFIFaxMaker.nsf.

3. From Viewsnode, double-click $POP3.

Screenshot 15: Removing the default POP3 view

4. Click OK to the warning prompt.

5. Select the following two lines and delete them from the $POP view object.

DEFAULT DeliveredDate := “”;

SELECT DeliveredDate != “”
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Screenshot 16: Delete lines from $POP view

6. Save and exit Domino Designer.

Step 5: Add the FAX Foreign Domain

1. Load Domino Administrator.

2. Select Configuration tab and select Messaging\Domains.

4. Click Add Domain and select Foreign Domain.

6. Enter fax as the Foreign Domain Name.

7. Select the Mail Information tab.

8. Enter the Domino server name as the Gatewayservername.

9. Enter mail\GFI FaxMaker.nsf as the GatewayMail File Name.

NOTE
When RFC822 phrase handling is enabled on outbound email, the fax number appears twice when GFI FaxMaker
sends the fax. To resolve this, perform the following fromNotes Administrator:

1. From the Configuration tab, select Messaging > Configurations.
2. Click Edit Configuration on the server with the GFI FaxMaker mailbox.

3. Select the MIME tab > Advanced Tab > Advanced Outbound Message Options tab.

4. Set RFC822 Phrase Handling to Do not add phrase.

3.2.4 Lotus Domino/Notes server 6.5

Step 1: Allow mail relay from Lotus Domino/Notes server

1. From the GFI FaxMaker server, load the Internet Information Servicesconsole.

2. Right-click Default SMTPVirtual Servernode and select Properties.

3. From Access tab, click Relay….
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Screenshot 17: Relay restrictions dialog

4. Select Onlythe list below and click Add….

5. Select Single computerand in the IPaddress field specify the Lotus Domino/Notes Server IP address. Click OK.

6. Click OK in all dialogs to apply changes.

Step 2: Add a foreign SMTP domain on the Lotus server

1. From Domino Administrator, select Configuration tab.

2. Navigate to Messaging > Domainsnode.
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Screenshot 18: Adding a new domain

3. Click Add Domain.
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Screenshot 19: Configuring the domain type

4. From New Domain page, select Basics tab and set the Domain type to Foreign SMTPDomain.

5. Select Routing tab and from MessagesAddressed to, set Internet Domain to:
faxmaker.com,smsmaker.com.

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. If using different domains, specify your custom domains. After installation, specify the
domains in the GFI FaxMaker Configuration. Formore information, refer to Fax and SMS domain names (page
85).
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Screenshot 20: Configure the routing settings

7. Under Should be Routed to section, set Internet host to the IP address (enclosed in [ ] ) or name of the GFI FaxMaker
server.

8. Save and close Foreign SMTP Domain entry.

9. Reload Domino router from the Domino server console with the following commands:

tell router stop

tell router start

3.3 Hosted email
When using an online hosted email service, create connectors that route fax and SMS to GFI FaxMaker.

Select your hosted email provider:

Microsoft® Office 365™ Enterprise accounts

Microsoft® Office 365™ Email only accounts

Google Apps for Business - Gmail

Internet Service Provider

Other hosted email providers
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3.3.1 Microsoft® Office 365™ Enterprise accounts
Refer to the following steps to use GFI FaxMaker with Microsoft® Office 365™ Enterprise account types.

Step 1: Install GFI FaxMaker and set mail server details

Step 2: Set Connectors

Step 3: Test functionality

Step 1: Install GFI FaxMaker and set mail server details

Install GFI FaxMaker on amachine that meets or exceeds the GFI FaxMaker system requirements. Formore information,
refer to System Requirements (page 13).

Launch the GFI FaxMaker installer and follow the wizard to complete installation. Formore information, refer to
Installation procedure (page 53).

On install completion, the installer automatically launches the Configuration Wizard that assists you through the basic
steps of configuration. Configure the following wizard steps:

1. In the Configuration Wizard welcome screen click Next.

2. Choose Myemail serverwill forward faxesand SMSsto thisGFI FaxMakermachine. Click Next.

3. Specify the mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server name or
IP address

Key in smtp.office365.com

Use SSL Select this option to enable SSL.

Use SMTP
Authentication

Select this option and enter the credentials of a Microsoft® Office 365™ mailbox user. Key in the user's full email
address in the Account name and the Password.
Do not select Secure Password Authentication.

NOTE
If GFI FaxMaker is already installed, configure the above mail server details from GFI FaxMaker Configuration >
Email2FaxGateway.

4. Proceed with wizard to finalize configuration. Formore information, refer to Run the GFI FaxMaker Configuration
Wizard (page 55).

Step 2: Set Connectors

NOTE
Connectors are not available with all Office 365 plans. If your plan does not support connectors, refer toMicrosoft®

Office 365™ Email only accounts.

Configure fax and SMS outbound connectors from the Microsoft® Office 365 Exchange Admin Center.

The connectors are configured to route emails where the recipient domains are *@faxmaker.com and
*@smsmaker.com, to GFI FaxMaker.

When your email users send emails to these domains, Microsoft® Office 365™ automatically routes the emails for
processing by GFI FaxMaker.
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1. In the Exchange Admin Center, navigate to Mail Flow > Connectors.

2. In the Outbound Connectors section, click +.

Screenshot 21: Adding outbound connectors in FOPE

3. In Add Outbound Connector, key in:

Option Description

Name Key in a friendly name for the connector, such as: GFI FaxMaker fax & SMS connector

Enable outbound con
nector

Select this checkbox to enable the connector.

Connector Type Choose On-premises.

Retain service headers on
transmission

Do not select this option. This option is used only when using Office 365 with an on-premise Microsoft
Exchange server (hybrid environment).

Comment Key in a connector description.
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Option Description

Connection Security Choose a protocol to use for encrypting messages securely during delivery to GFI FaxMaker server.

Outbound Delivery Select Route mail through smart hosts and click +. Specify the GFI FaxMaker server public IP address or
Fully Qualified Domain Name and click Save.

Scope Do not select Use for Criteria Based Routing (CBR).
Select Route all accepted domains through this connector.

Domains Click + and key in faxmaker.com. Click OK.
Repeat for smsmaker.com.

4. Click Save.

Your users should now be able to send faxes using the standard addressing format <fax
number>@faxmaker.com (for example,12345678@faxmaker.com).

Step 3: Test functionality

Test fax sending

Use a hosted email user to send a fax or sms via email.

View the email being processed in the GFI FaxMaker Monitor and confirm that the fax is received by the recipient.

If you cannot see the fax email being processed in the GFI FaxMaker Monitor, troubleshoot the relaying of the email from
the mail server to GFI FaxMaker.

Test fax receiving

From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

View the incoming fax status fromGFI FaxMaker Monitor.

Unless Routing rules were previously configured, the fax is delivered through the Default Routers (Available from GFI
FaxMakerConfiguration > Routing > Properties> Default Routers). Ensure that the fax is successfully delivered to the
Default Routers’ mailbox.

3.3.2 Microsoft® Office 365™ Email only accounts
Refer to the following steps to use GFI FaxMaker with Microsoft® Office 365™ Email only account types or for other plans
that do not include email connectors.

With the following setup, users cannot use faxmaker.com and smsmaker.com when sending faxes since
connectors cannot be created. Instead, configure fax and sms DNS records, such as fax.mydomain.com and
sms.mydomain.com.

Step 1: Install GFI FaxMaker and set mail server details

Step 2: Create alias records

Step 3: Configure GFI FaxMaker domains

Step 4: Test functionality

Step 1: Install GFI FaxMaker and set mail server details

Install GFI FaxMaker on amachine that meets or exceeds the GFI FaxMaker system requirements. Formore information,
refer to System Requirements (page 13).

Launch the GFI FaxMaker installer and follow the wizard to complete installation. Formore information, refer to
Installation procedure (page 53).
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On install completion, the installer automatically launches the Configuration Wizard that assists you through the basic
steps of configuration. Configure the following wizard steps:

1. In the Configuration Wizard welcome screen click Next.

2. Choose Myemail serverwill forward faxesand SMSsto thisGFI FaxMakermachine. Click Next.

3. Specify the mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server name or
IP address

Key in smtp.office365.com.

Use SSL Select this option.

Use SMTP
Authentication

Select this option and enter the credentials of a Microsoft® Office 365™ mailbox user. Key in the user's full email
address in the Account name and the Password.
Do not select Secure Password Authentication.

NOTE
If GFI FaxMaker is already installed, configure the above mail server details from GFI FaxMaker Configuration >
Email2FaxGateway.

4. Proceed with wizard to finalize configuration. Formore information, refer to Run the GFI FaxMaker Configuration
Wizard (page 55).

Step 2: Create alias records

NOTE
If you are not familiar with DNS, contact your DNS hosting company to create these records.

Create two new alias records (“A” record) with your DNS hosting provider that are dedicated for the fax and sms domains
(for example,fax.mydomain.com and sms.mydomain.com).

Point the destination of these records to the public IP address of the GFI FaxMaker server.

When emails are addressed to these domains, the hosting provider's mail relay server routes the email to GFI FaxMaker.

NOTE
DNS changes can take up to 72 hours to take effect.

Step 3: Configure GFI FaxMaker domains

1. FromGFI FaxMaker Configuration, right-click Email2FAXGatewaynode and select Properties.

2. From the Fax/SMS domains tab, specify custom Faxdomain name and/or SMS domain name (for example,
fax.mydomain.com and sms.mydomain.com).

3. Click OK to apply changes.

Step 4: Test functionality

Test fax sending

Use a hosted email user to send a fax or sms via email.

View the email being processed in the GFI FaxMaker Monitor and confirm that the fax is received by the recipient.
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If you cannot see the fax email being processed in the GFI FaxMaker Monitor, troubleshoot the relaying of the email from
the mail server to GFI FaxMaker.

Test fax receiving

From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

View the incoming fax status fromGFI FaxMaker Monitor.

Unless Routing rules were previously configured, the fax is delivered through the Default Routers (Available from GFI
FaxMakerConfiguration > Routing > Properties> Default Routers). Ensure that the fax is successfully delivered to the
Default Routers’ mailbox.

3.3.3 Google Apps for Business - Gmail
Refer to the following steps to use GFI FaxMaker with Gmail for Google Apps for Business.

With Google Apps, users cannot use faxmaker.com and smsmaker.com when sending faxes since connectors
cannot be created. Instead, configure fax and sms DNS records, such as fax.mydomain.com and
sms.mydomain.com.

Step 1: Install GFI FaxMaker and set mail server details

Step 2: Create alias records

Step 3: Configure GFI FaxMaker domains

Step 4: Test functionality

Step 1: Install GFI FaxMaker and set mail server details

Install GFI FaxMaker on amachine that meets or exceeds the GFI FaxMaker system requirements. Formore information,
refer to System Requirements (page 13).

Launch the GFI FaxMaker installer and follow the wizard to complete installation. Formore information, refer to
Installation procedure (page 53).

On install completion, the installer automatically launches the Configuration Wizard that assists you through the basic
steps of configuration. Configure the following wizard steps:

1. In the Configuration Wizard welcome screen click Next.

2. Choose Myemail serverwill forward faxesand SMSsto thisGFI FaxMakermachine. Click Next.

3. Specify the mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server name or
IP address

Key in smtp.gmail.com.

Use SSL Select this option.

Use SMTP
Authentication

Select this option and enter the credentials of a Google Apps mailbox user. Key in the user's full email address
in the Account name and the Password.
Do not select Secure Password Authentication.

NOTE
If GFI FaxMaker is already installed, configure the above mail server details from GFI FaxMaker Configuration >
Email2FaxGateway.
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4. Proceed with wizard to finalize configuration. Formore information, refer to Run the GFI FaxMaker Configuration
Wizard (page 55).

Step 2: Create alias records

NOTE
If you are not familiar with DNS, contact your DNS hosting company to create these records.

Create two new alias records (“A” record) with your DNS hosting provider that are dedicated for the fax and sms domains
(for example,fax.mydomain.com and sms.mydomain.com).

Point the destination of these records to the public IP address of the GFI FaxMaker server.

When emails are addressed to these domains, the hosting provider's mail relay server routes the email to GFI FaxMaker.

NOTE
DNS changes can take up to 72 hours to take effect.

Step 3: Configure GFI FaxMaker domains

1. FromGFI FaxMaker Configuration, right-click Email2FAXGatewaynode and select Properties.

2. From the Fax/SMS domains tab, specify custom Faxdomain name and/or SMS domain name (for example,
fax.mydomain.com and sms.mydomain.com).

3. Click OK to apply changes.

Step 4: Test functionality

Test fax sending

Use a hosted email user to send a fax or sms via email.

View the email being processed in the GFI FaxMaker Monitor and confirm that the fax is received by the recipient.

If you cannot see the fax email being processed in the GFI FaxMaker Monitor, troubleshoot the relaying of the email from
the mail server to GFI FaxMaker.

Test fax receiving

From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

View the incoming fax status fromGFI FaxMaker Monitor.

Unless Routing rules were previously configured, the fax is delivered through the Default Routers (Available from GFI
FaxMakerConfiguration > Routing > Properties> Default Routers). Ensure that the fax is successfully delivered to the
Default Routers’ mailbox.

3.3.4 Other hosted email
This topic explains how to setup an environment for fax server integration with a hosted mail server. Use your preferred
hosted email service to forward fax emails designated to GFI FaxMaker.

Users typically send fax or SMS by sending an email tonumber@faxmaker.com and
number@smsmaker.com. The mail server routes emails addressed to*@faxmaker.com and
*@smsmaker.com to GFI FaxMaker. If your mail provider does not allow routing to domain, configure alias domains
dedicated for fax and SMS, for example fax.mydomain.com.
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NOTES

1. Your hosted mail server configuration procedure may differ than the instructions provided in this topic. For more
information refer to the service provider’s help.

2. These instructions apply to fax subdomains. Repeat procedure for SMS domain if required.

IMPORTANT
While editing and configuring A (Host) and MX records, ensure that you are setting the records for the fax and SMS
subdomains only. Changes to the A (Host) and MX records for the primary domain can disrupt email/web traffic for
that domain.

Requirements

Ensure that you have adequate permissions to create subdomain forwarding:

Domain RegistrarControl Panel Access: Administrative access to the hosted email domain registrar control panel is
needed to:

Create and register the fax subdomain

Create and register a new A record for the fax subdomain

Create and register a new MX record for the fax subdomain

Mail Host Control Panel Access: From the mail host control panel, register the fax subdomain to the mail host and
determine the MX record information.

Step 1: Fax subdomain configuration

Log into your domain registrar control panel and open the Forward Subdomainsconfiguration to create a new fax
subdomain. Choose option to add a new subdomain.

Specify a new subdomain name, for example fax, and specify the public-facing IP address you intend to use with your
fax domain.

Screenshot 22: Adding a subdomain

Return to your domain control panel and open DNS Manager.
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Screenshot 23: Creating a Host Record

In the DNSManager, create a new A (Host) Record for your new subdomain, specifying the new subdomain name (for
example,fax) and the public-facing IP address you intend to use with your fax domain.

Screenshot 24: Creating an MX record

Create a new MX Record for the new subdomain and set the priority to 1.

Screenshot 25: The newly added record

It can take anywhere from 24 to 48 hours for the new subdomain changes to become active for use by your registrar.
When the wait-time for propagation has passed, verify that the subdomain name is pointing to your public IP address by
performing a Name Server lookup from command prompt, for example:nslookup fax.mydomain.com. Ensure
that the resulting IP address is your public IP address.

NOTE
Ensure that SMTP port 25 on your local firewall is open and forwards to the internal IP address of your GFI FaxMaker
server.

Step 2: GFI FaxMaker Domain Configuration

Configure GFI FaxMaker to convert emails addressed to your subdomain to fax. Formore information, refer to Fax and
SMS domain names (page 85).
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1. Open the GFI FaxMaker Email2FaxGatewayproperties and go to the Fax/SMS domains tab.

2. Key in the new fax subdomain, for example fax.mydomain.com.

3. Click OKand choose to restart your GFI FaxMaker services for changes to take effect.

Step 3: Specify the mail server details

Screenshot 26: MX records

1. Locate the MX record specified for your primary domain in the control panel and copy it.

2. Open the GFI FaxMaker Email2FaxGatewayproperties.

3. In the SMTPConnector tab key in the MX record for your primary domain in the Mail servername/IPand port box.

4. In the test email area, key in a valid email address for a user in your domain and click Send test email. Ensure that the
user receives a test email fromGFI FaxMaker.

Screenshot 27: Email2Fax configuration

Step 4: Test functionality

Ensure that fax emails are being forwarded to and processed by GFI FaxMaker.
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To do this, open a new message form in your web email client and send a sample fax. Ensure that the recipient’s domain
is the configured subdomain. For example, send a fax to+12345678@fax.mydomain.com. Replace
+12345678 with a test fax number and fax.mydomain.com with your subdomain.

Ensure that the fax was forwarded to GFI FaxMaker successfully by checking the GFI FaxMaker Monitor. Formore
information, refer to Monitoring GFI FaxMaker operation (page 68).

3.3.5 ISP hosted
GFI FaxMaker can be installed in an environment where the mail service is provided by the ISP.

Process Description

Client side Users send faxes/SMS using the GFI FaxMaker Client - Fax Message Form to route directly to GFI FaxMaker server.
NOTE: Users cannot use email client to send faxes/SMS.

Sending
faxes/SMS

GFI FaxMaker clients route faxes/SMS directly to GFI FaxMaker via SMTP.
NOTE: Install the IIS SMTP service on the GFI FaxMaker server.

Received
faxes/SMS

After determining the users to forward incoming faxes/SMS to, GFI FaxMaker sends transmission report via SMTP to
the hosted mail server.

3.4 Othermail environments
Other email server environments:

SMTP server

POP3 mailbox

Multiple Mail servers

SAP 4.7

3.4.1 SMTP server
GFI FaxMaker can be installed in an SMTP server environment such as MDaemon.

To do this:
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1. Create a routing rule on your mail server that routes all messages sent to faxmaker.com and smsmaker.com domains
to the GFI FaxMaker server.

2. Install the IIS SMTP service on the GFI FaxMaker server.

3. Install GFI FaxMaker on a separate machine than the mail server. Formore information, refer to Installation pro
cedure (page 53).

NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Use the configured fax or SMS domain accordingly. Formore information, refer to Fax and
SMS domain names (page 85).

3.4.2 POP3 mailbox
GFI FaxMaker can retrieve faxes/SMS from a dedicated POP3 mailbox.

1. On the mail server, create a POP3 mailbox that is dedicated for GFI FaxMaker.

2. Install GFI FaxMaker on a separate machine than the mail server. Formore information, refer to Installation pro
cedure (page 53).

3. In the Sending Options screen of the post-installation configuration wizard, specify the details of this POP3 mailbox
and proceed with the wizard.

4. Configure the GFI FaxMaker POP3 Downloader to retrieve emails stored in this mailbox. Formore information, refer
to POP3 Downloader (page 84).

When using a POP3 mailbox, the method of sending faxes/SMS via email is different than when routing emails via SMTP.
Formore information, refer to Sending faxes/SMS via a POP3 Mailbox (page 85).

3.4.3 Multiple mail servers
In a network where multiple mail servers are independent from each other, configure each email server individually to
forward faxes to GFI FaxMaker. Use the same methods described for each type of mail server.

Formore information, refer to Mail server configuration (page 16).

3.4.4 SAP 4.7
For more information how to configure SAP 4.7 to send faxes using GFI FaxMaker, refer to
http://go.gfi.com/?pageid=FM_SAP47.

3.5 Using GFI FaxMaker without a mail server
GFI FaxMaker can be configured to work in environments without a mail server. There are, however, some limitations
with certain features. For example, GFI FaxMaker users cannot send faxes and SMS via email when amail server is not
available.

Refer to the following sections for assistance on how to install, configure and use GFI FaxMaker in installations where a
mail server is not available.

3.5.1 Sending faxes and SMS
In installations where there is nomail server available, use amethod of sending faxes and SMS that does not require
email:

http://go.gfi.com/?pageid=FM_SAP47
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Using the GFI FaxMaker Client application

Printing content to GFI FaxMaker - NetPrintQueue2Fax

Via API

NOTE
If using the GFI FaxMaker Client application, set the Client to connect directly to GFI FaxMaker via HTTP.

3.5.2 Receiving faxes
When a fax is received, GFI FaxMaker typically sends out an email to the recipient(s). Use other methods to view received
faxes/SMS:

Automatically print incoming faxes

Store incoming faxes to a network share

Alternatively youmay also consider using an online mail service for GFI FaxMaker to send out notifications. Formore
information, refer to Using an online SMTP server (page 51).

3.5.3 Receiving SMS
When an SMS is received, GFI FaxMaker sends out an email to the recipient(s).

To view received SMSs when amail server is not available, refer to the SMS log files. Formore information, refer to SMS
log files (page 171).

Alternatively youmay also consider using an online mail service for GFI FaxMaker to send out notifications. Formore
information, refer to Using an online SMTP server (page 51).

3.5.4 GFI FaxMaker system notifications
GFI FaxMaker uses a mail server to send various system notifications to administrators, such as system errors. When amail
server is not available, GFI FaxMaker cannot send out these notifications.

Tomonitor GFI FaxMaker operation when amail server is not available, refer to the logs shown in the GFI FaxMaker
Monitor.

Alternatively youmay also consider using an online mail service for GFI FaxMaker to send out notifications. Formore
information, refer to Using an online SMTP server (page 51).

3.5.5 Transmission reports

GFI FaxMaker uses a mail server to send transmission reports to your users when they send out a fax or SMS. When amail
server is not available, GFI FaxMaker cannot send out transmission reports.

In this scenario, the status of sent faxes can be manually monitored from the Archive Viewer. Note that the Archive
Viewer is only accessible from the GFI FaxMaker server machine itself, so your users may not have access to it.

Alternatively youmay also consider using an online mail service for GFI FaxMaker to send out notifications. Formore
information, refer to Using an online SMTP server (page 51).

3.5.6 Using an online SMTP server
When amail server is not available, youmay consider using an online mail service that allows SMTP connections, such as
Gmail or Yahoo! Mail. GFI FaxMaker connects to the service using your account credentials to send out notification emails.
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To do this, create a dedicated mailbox on the chosen service and key in the SMTP and account settings in the GFI
FaxMaker mail server settings screen. GFI FaxMaker uses this server to send out emails.

Importantnotes on choosing amail serverprovider:

1. GFI FaxMaker can only authenticate with mail servers via SSL. Choose a provider that allows outgoing
SMTP connections via SSL. Authentication via TLS or STARTTLS is not possible.

2. Certain SMTP providers restrict the number of emails that can be sent per day.

3. With this type of SMTP server you will not be able to resend sent or previewed faxes by replying to the GFI FaxMaker
notification, since emails are not routed back from the mailbox to GFI FaxMaker.

4. Certain providers, such as Gmail, need to be configured to allow connections from third party applications. In Gmail,
go to the account settings and from the security options, enable access for less secure apps.
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4 Installing GFI FaxMaker for the first time
If you have an older version of GFI FaxMaker and wish to upgrade to the latest version, go toUpgrading from earlier
versions.

4.1 Installation procedure

4.1.1 Important notes

1. Check that the machine you are installing GFI FaxMaker on meets the system and hardware requirements.

2. Log on as Administrator or using an account with administrative privileges.

3. Save any pending work and close all open applications on the machine.

4.1.2 Start installation

1. Run the GFI FaxMaker installer. Formore information, refer to Downloading the latest version of GFI FaxMaker
(page 61).

faxmaker2014.exe to install GFI FaxMaker on 32-bit systems

faxmaker2014_x64.exe to install GFI FaxMaker on 64-bit systems

2. Select installation language and click OK.

3. In the welcome screen, click Next.

4. To check for a newer build other than the one being installed, select Checkfora newerbuild of GFI FaxMakeron
the GFIweb site and click Next. Otherwise, select Do not checkfora new build and click Next.

NOTE
An active Internet connection is required to check for newer build.

5. Read the license agreement and click Agree to accept and proceed.

6. If a license key is available, enter it in the License Keybox and click Next. Alternatively, click Next to install GFI FaxMaker
in evaluation mode and enter a license key post-installation.
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Screenshot 28: Selecting what components to install

7. Select components to install:

Component Description

GFI FaxMaker Fax Server Installs GFI FaxMaker on the machine.

GFI FaxMaker Remote Monitor Enables local or remote monitoring of GFI FaxMaker.

Exchange
2000/2003/2007/2010/2013
SMTP connector

Required by Microsoft® Exchange server when GFI FaxMaker is installed on another machine.
NOTE: Do not select this option when running setup on a machine that is not the Microsoft®

Exchange server or not using Microsoft® Exchange as your mail server.

Table 8: Installation components
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Screenshot 29: Account name for services

8. Provide credentials of an account with administrative privileges, and click Next.

NOTE
These credentials are used for GFI FaxMaker services management. If changing the password after installing GFI
FaxMaker, update the password for the GFI FaxMaker services from the Services applet. When GFI FaxMaker is
installed in a domain, these credentials are also used to connect to Active Directory and retrieve the list of users.

9. Click Next to continue installing GFI FaxMaker to the default folder, or Browse to select a new installation path.

10. Click Next to install GFI FaxMaker. If applicable, select option to restart the IIS SMTP service.

11. Click Next to install the GFI NetPrintQueue2Fax printer drivers.

NOTE
On Windows Server® 2003 64-bit, 32-bit version of the GFI NetPrintQueue2Fax printer drivers must be installed (so
that 32-bit clients can use the 32-bit driver). Select option Install 32-bit drivers forGFINetPrintQueue2Faxprinter.
Windows Server® 2003 CD is required during installation.

If Windows® shows a warning regarding the NetPrintQueue2Fax printer driver, click option to install anyway.

12. Click Finish.

After installation, the GFI FaxMaker Configuration Wizard is automatically launched to help you configure basic settings.
Formore information, refer to Run the GFI FaxMaker Configuration Wizard (page 55).

4.2 Run the GFI FaxMaker ConfigurationWizard
The GFI FaxMaker Configuration Wizard assists you through the basic steps of configuring GFI FaxMaker. The wizard runs
automatically after installation or run it manually from Start > Programs> GFI FaxMaker> GFI FaxMaker>
Configuration Wizard.
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1. Click Next in the welcome screen.

2. The GFI FaxMaker Client and other Web Services API applications connect to GFI FaxMaker over HTTP port 8555. If this
port is not open, click OK to have GFI FaxMaker automatically open these ports. You can also open these ports manually.
For more information go to: http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=FirewallPorts

NOTE
When GFI FaxMaker is installed on the Microsoft® Exchange 2000 or higher, skip to step 6.

Screenshot 30: Setting up the sending options

3. When GFI FaxMaker is not installed on the same machine running Microsoft® Exchange 2003 or higher, configure
mail server options. Select how to forward faxes and SMSs to GFI FaxMaker.

Option Description

Faxes and SMS will be forwarded directly to
this machine via SMTP email, via APIs or when
using the GFI FaxMaker Client.

Select this option when using any of the following methods to send faxes:
GFI FaxMaker Client
TextAPI, XMLAPI or Web Services API
Email such that your mail server is configured to forward all faxes and SMSs to

GFI FaxMaker via SMTP. For more information, refer to Mail server configuration
(page 16).

NOTE: Faxes & SMS cannot be sent via an SMTP mail server when GFI FaxMaker is
installed on Windows 8.1, 8 or 7. For more information, refer to Installing GFI
FaxMaker on Windows 8.1, 8, 7 or Vista (page 61).

GFI FaxMaker will download faxes and SMSs
from a POP3 mailbox

Select option if GFI FaxMaker downloads fax/SMS from a dedicated POP3 mailbox.
For more information, refer to POP3 mailbox (page 50).
Specify the details of the dedicated POP3 mailbox.
IMPORTANT: Ensure that there are no emails in mailbox and that it is dedicated to
GFI FaxMaker only. Any emails in mailbox are downloaded by GFI FaxMaker and
permanently deleted.

Table 9: Sending options

Click Next to continue.

http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=FirewallPorts
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Screenshot 31: The wizard will prompt you for amail server name

4. Specify mail server details where GFI FaxMaker forwards received emails.

Option Description

Mail server
name or IP
address

Enter the name or IP address of the mail server where to upload received faxes.

Use SSL Instructs GFI FaxMaker to connect and communicate with the mail server using SSL.

Use SMTP
Authentication

Instructs GFI FaxMaker to connect to the mail server using specific user credentials. Enter credentials in the Account
and password text boxes. Select Secure Password Authentication if required by the mail server.

Table 10: Mail server options

Click Next to continue.

5. Specify the Countrycode of the country where the fax lines are connected. This is used by GFI FaxMaker to determ
ine the appropriate number to dial (for example, removes the country code for faxes within the same country). Click
Next.
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Screenshot 32: Selecting the type of fax hardware to be used with GFI FaxMaker

6. Select the fax devices to use with GFI FaxMaker.

Fax device Description

Brooktrout
by
Dialogic

Select when using one or more Brooktrout devices or SR140 fax software. On clicking Next, click Yes to install driver
software for the device, or click No to use other drivers.

Sangoma
devices

Select when using one or more Sangoma fax devices. On clicking Next, click Yes to install driver software for the device,
or click No to use other drivers. A machine restart is required after installing Sangoma drivers.

ISDN
/CAPI
devices

Select:
TE-SYSTEMS XCAPI Fax over IP - Instructs GFI FaxMaker to use the TE-SYSTEMS XCAPI Fax over IP solution. Click Yes

to install XCAPI software to integrate the system with Fax over IP or an ISDN controller, or click No to use other drivers.
Other devices - Instructs GFI FaxMaker to use a device that is not TE-SYSTEMS XCAPI Fax over IP.

Fax
modems

Select to automatically detect fax modem drivers and click Next. GFI FaxMaker attempts to detect Microsoft® Fax drivers
and other modems already installed on the machine.

Fax ser
vices

Select to use an online fax service. Click Next to enter the fax service details.

Table 11: Type of fax device

IMPORTANT
1. Ensure that devices are properly installed before proceeding.

2. For some devices, youmay be prompted to configure the fax lines.

For more information go to: http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=FDIManual

Click Next to continue.

http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=FDIManual
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Screenshot 33: Specifying users

7. Specify the GFI FaxMaker users and administrators.

Environment Description

If you have
Active Directory

GFI FaxMaker connects to Active Directory to enable you to choose users. If no fax administrators are configured,
add the administrators from the Select Users or Groups dialog and click OK. Click Add users to add fax users.

If you do not
have Active
Directory

To define the list of users:
Import list from Windows®: GFI FaxMaker imports the list of Windows® users from:

Local machine: GFI FaxMaker lists the user accounts configured on the local machine.
Remote machine: Select Use remote server and enter the name or IP address of the remote machine. Click

List Users to automatically detect and list the users on that machine.

Click Add to add the selected users to the Users selected for import list. Click Append domain name to add a
domain to the username.

Create manually - Enter users and their email addresses manually from the GFI FaxMaker management console.
For more information, refer to Licensed users (page 79).

After adding the list of users, specify which of the users are fax administrators.

Table 12: Adding GFI FaxMaker users

Click OKand click Next to continue.

8. Wizard will now test the mail server settings. Click Test to send a test email to the configured fax administrators. Click
Next to continue.

NOTE
If the test fails, the error condition is displayed. Use the error to troubleshoot and resolve issues. Formore
information, refer to Email2FaxGateway test fails (page 178).

9. GFI FaxMaker now starts the services. Click Next to continue.

10. Click Finish.
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4.3 Upgrading to the latest versionwhile retaining all settings
This topic describes how to upgrade a GFI FaxMaker installation to the latest version while retaining all settings.

4.3.1 Important notes when upgrading

1. This procedure is supported only for versions 12 or higher. For earlier versions, it is recommended to uninstall and
reconfigure GFI FaxMaker.

2. As of version 2011, Microsoft Windows 2000 is no longer supported by GFI FaxMaker.

3. It is recommended to back up the GFI FaxMaker configuration before upgrade. Formore information, refer to Con
figuration backup (page 103).

4. Obtain your new license key from the GFI Customer Area. For more information refer to http://sup
port.gfi.com/manuals/en/fax2014/Default.htm#cshid=LicenseKey.

5. Disable anti-virus software on the server machine during the upgrade installation. Re-enable it once upgrade is com
plete.

6. It is not necessary to upgrade the GFI FaxMaker Client when upgrading the GFI FaxMaker server installation.

7. Check that the machine you are installing GFI FaxMaker on meets the system and hardware requirements.

8. Log on as Administrator or using an account with administrative privileges.

9. Save any pending work and close all open applications on the machine.

4.3.2 Upgrade procedure

1. From your old GFI FaxMaker configuration, go to Advance > Document Conversion and take note of extensions that
have a custom command assigned.

2. Back up any custom coverpages. These are located in the coverpge folder within the GFI FaxMaker installation path.

3. When using a Brooktrout TR1034 fax board, go to the following path within the GFI FaxMaker installation folder:
..\GFI\FaxMaker\brooktrout\TR1034\Boston\config\. Back up callctrl.cfg and btcall.cfg.

4. Download the latest build of GFI FaxMaker. Formore information, refer to Downloading the latest version of GFI
FaxMaker (page 61).

5. Launch the installation file and follow the instructions in Installing GFI FaxMaker. Setup automatically uninstalls the
old installation and installs the latest version.

6. Use the license key obtained from the GFI Customer Area.

7. When installation is complete, the setup automatically launches the GFI FaxMaker Configuration Wizard. It is recom
mended to Cancel this setup so that existing settings are not overridden.

8. Copy the coverpages that were backed up in step 2 above, to the coverpge folder

9. From the GFI FaxMaker configuration, add the document conversion settings noted in step 1 above. Formore inform
ation, refer to Document Conversion (page 111).

10. If the default fax (*@faxmaker.com) and sms (*@smsmaker.com) domains were modified in the old installation, re-con
figure the new domains in GFI FaxMaker configuration. Formore information, refer to Step 2: Change domain names
from GFI FaxMaker Configuration (page 87).

11. When using a Brooktrout TR1034 fax board, copy the files that were backed up in step 3 above to the same location.
Also, stop the GFI FaxMaker services and open the Brooktrout Configuration Tool to verify settings. Save and close. Restart
the GFI FaxMaker services.

http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=LicenseKey
http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=LicenseKey
http://support.gfi.com/manuals/en/fax2014/Default.htm#cshid=LicenseKey
https://customers.gfi.com/
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12. Go to the GFI FaxMaker Monitor and ensure that fax lines are present and initialized. If you encounter problems, refer
to: http://go.gfi.com/?pageid=FM_LineInitialize.

13. Optionally you can test the functionality of GFI FaxMaker by sending and receiving a test fax. Formore information,
refer to Testing your installation (page 62).

4.4 Downloading the latest version of GFI FaxMaker
To download the latest version or service release of GFI FaxMaker, go to:

http://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download

If you have an existing GFI Customer account, click Login and key in your Username and Password.

If you do not have a GFI Customer account, fill in the form details to register for an account.

Next, go to the GFI FaxMaker downloads page and select the latest version of GFI FaxMaker. Choose:

GFI FaxMaker x86 Download this file when installing on a 32-bit machine.

GFI FaxMaker x64 Download this file when installing on a 64-bit machine.

Other downloads:

GFI FaxMaker ReportPack The setup file for the GFI FaxMaker ReportPack.

GFI FaxMaker eCopy
ShareScan Connector

Download this connector when using GFI FaxMaker with Nuance eCopy ShareScan. For more inform
ation, refer to Multi-function peripherals (page 138).

GFI FaxMaker Client x86 The GFI FaxMaker Client application for 32-bit machines.

GFI FaxMaker Client x64 The GFI FaxMaker Client application for 64-bit machines.

4.5 Installing GFI FaxMaker onWindows 8.1, 8, 7 or Vista
Microsoft® Windows® 8.1, 8, 7 and Vista do not include the Microsoft® IIS SMTP server that is used when the mail server
routes fax/SMS emails to GFI FaxMaker.

Consequently when installing GFI FaxMaker on these operating systems, faxes and SMS cannot be sent via email using
the domains @faxmaker.com and @smsmaker.com.

There are twomain methods of sending faxes/SMS that can be used instead:

Use the GFI FaxMaker Client application - A secure application installed on users' machines that delivers faxes to
GFI FaxMaker via HTTP or HTTPS. Composing faxes and SMS using this method is similar to composing emails in an email
client.

Use email via a POP3 mailbox - Users send fax/SMS emails to a dedicated POP3 mailbox. GFI FaxMaker picks up the
emails from this mailbox and prepares the content for transmission. This method is more difficult to use since it requires
TextAPI parameters to be included in the email body when composing fax/SMS emails. Formore information, refer to
Sending faxes/SMS via a POP3 Mailbox (page 85).

Alternatively when installing GFI FaxMaker on Windows 8.1, 8, 7 or Vista, youmay use other methods to send faxes and
SMS. These methods do not require the IIS SMTP service:

Using the GFI FaxMaker Client application

Printing content to GFI FaxMaker - NetPrintQueue2Fax

Via API

http://go.gfi.com/?pageid=FM_LineInitialize
http://www.gfi.com/products-and-solutions/email-and-messaging-solutions/gfi-faxmaker/download
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4.6 Testing your installation
Follow the steps in this topic to ensure that your GFI FaxMaker installation is processing sent and received faxes
successfully.

4.6.1 Send a test fax

1. From the email client of a user listed as a Licensed user, create an email, in the following format:

Field Configuration

To Enter recipient in the following format number@faxmaker.com. Replace number with the recipient’s fax number.
For example, 12345678@faxmaker.com.
NOTE: The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI FaxMaker
administrator. Use the configured fax domain.For more information, refer to Fax and SMS domain names (page 85).

Subject Key in Test fax.

Email body Key in some text.

Attachment Attach a one page PDF document containing some test content, such as text and graphics.

Table 13: Test email format

2. Click Send.

3. View the outgoing fax status from the GFI FaxMaker Monitor.

4. Ensure that the sender receives a transmission report for the sent fax, to confirm that GFI FaxMaker can send noti
fications over the configured mail server.

5. Confirm that the fax is received by the recipient and confirm that all settings, such as coverpage and headers/footers,
are applied.

4.6.2 Receiving a test fax
1. From a test fax line, send a fax to a fax line connected and configured in GFI FaxMaker.

2. View the incoming fax status from GFI FaxMakerMonitor.

3. The fax should be routed depending on the configured Routing rules. If no routing rule is matched or routing rules
are not configured, the fax is routed to aDefault Router. The fax should also be routed to users configured to receive all
faxes.
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5 Using GFI FaxMaker
This topic contains information about:

5.1 How users send faxes 63

5.2 How users view received faxes 67

5.3 Monitoring GFI FaxMaker operation 68

5.1 Howusers send faxes
There are various ways how users can send faxes:

Fax method Description

Email Users can send faxes directly from their favorite email client, such as Microsoft® Outlook®.
Address the email to faxnumber@faxmaker.com, where faxnumber is replaced by the recipient’s fax
number. The email body gets added to the coverpage and add any attachments to transmit via fax.
For more information, refer to Sending faxes via email (page 63).

GFI FaxMaker Cli
ent

The GFI FaxMaker Client is an application installable on client machines for sending faxes. It enables fax message
conversion and preview directly from the clients’ machines.
For more information, refer to The GFI FaxMaker Client (page 65).

NetPrintQueue2Fax To send faxes, users print content to the NetPrintQueue2Fax printer driver. The fax recipient number is keyed in
within the document in a customizable format, for example Fax: 12345678.
This enables fax sending in any format that allows printing of content (without installing application on GFI
FaxMaker machine).
For more information, refer to NetPrintQueue2FAX (page 130).

APIs Use third-party tools to automatically generate APIs containing the information about the faxes to send and
automate the fax sending process.
Store TextAPIs or XMLAPIs to a central location and GFI FaxMaker automatically processes files located in this
folder.
Or use Visual Studio to develop Web Service APIs which you can use to automatically send and receive faxes.
For more information, refer to GFI FaxMaker APIs (page 135).

Multi-function peri
pherals

Send faxes directly from network-connected multi-function peripherals (MFPs) that are managed using Nuance
eCopy ShareScan.
After installing the GFI FaxMakerNuance eCopy ShareScan Connector, place the documents to fax in the MFP
feeder. Scan the documents and use the Connector to send the fax to GFI FaxMaker.
For more information, refer to Multi-function peripherals (page 138).

5.1.1 Sending faxes via email
Licensed users can send faxes directly from their email client:

Use the Microsoft® Outlook® address book for recipients that have a fax number configured. Address the email to
[FAX:faxnumber], where faxnumber is replaced by the Outlook® contact’s fax number.

Address an email tofaxnumber@faxmaker.com, where faxnumber is replaced by the recipient’s fax num
ber. For example: +441273123456@faxmaker.com

The same fax can also be sent tomultiple fax numbers, using the same format for each and separated with a semi-
colon (;). For example: +441273123456@faxmaker.com; +420313414515@faxmaker.com;
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NOTE
The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI
FaxMaker administrator. Use the configured fax domain accordingly.

The first page of the fax contains the recipient’s name, sender’s name, email subject and email body. If the email
includes attachments, these are included in subsequent pages of the fax.

Screenshot 34: Sending a fax using the email client

This method is available for all email users, with no installation of other software or custom configurations required.

To use this method:

Add the users allowed to send fax in the Licensed Users list. Formore information, refer to Licensed users (page
79).

Configure mail servers to forward emails addressed to*@faxmaker.com,*@smsmaker.com,Fax:* and
SMS:* (or your custom domains) to GFI FaxMaker. Formore information, refer to Mail server configuration (page
16).

NOTE
This method is only applicable when routing emails via SMTP. This is not applicable when using the GFI FaxMaker
POP3 Downloader to poll faxes from a POP3 Mailbox. Formore information, refer to Sending faxes/SMS via a
POP3 Mailbox (page 85).
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5.1.2 The GFI FaxMaker Client

Screenshot 35: The GFI FaxMaker Fax Message form

The GFI FaxMaker Client is an application installable on client machines for sending faxes. It enables fax message
conversion and preview directly from the clients’ machines.

Most important features:

Can send faxes to GFI FaxMaker either via a mail server (SMTP) or connect directly to GFI FaxMaker via HTTP.

Installs a printer driver on clients' machines. When the content to be faxes is printed via this printer driver, file con
version is done on client side. This enables faxing from any application, without installing the application on the GFI
FaxMaker server.

Fax attachments (*.fax format) can be viewed, manipulated and annotated before transmission.

Faxes can be previewed before transmission.

Includes an address book or uses the Microsoft Outlook contact list.

The interface is available in numerous languages.

Download the GFI FaxMaker Client from: http://go.gfi.com/?pageid=FM_FaxClient

For information on how to deploy and use the Client, refer to the GFI FaxMaker Client Manual, available from:

http://support.gfi.com/manuals/en/faxmakerclient/Default.htm

5.1.3 Resending a fax
When GFI FaxMaker sends out a fax, an email is sent to the sender containing important fax job information - a
transmission report. If a fax fails or you wish to forward the same fax to a different recipient, use the transmission report to
resend the fax.

http://go.gfi.com/?pageid=FM_FaxClient
http://support.gfi.com/manuals/en/faxmakerclient/Default.htm
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To resend a fax to the original recipient, reply to the transmission report and do not change any of the email fields. GFI
FaxMaker does not include the transmission report in the fax, but re-sends the original fax message.

To resend the fax to a different recipient, reply to the transmission report, changing the To field to the new recipient's
fax number, in this format: <faxnumber>@faxmaker.com. For example,
+420313414515@faxmaker.com. Do not change any other message field and click Send. GFI FaxMaker re-
sends the original fax content, updating recipient-related coverpage fields tomatch those of the new recipient.

Importantnotes:

1. The subject field of the transmission report contains a ::resend API command and a job ID that enable GFI
FaxMaker to find the original fax job when resending a fax. If these details are modified, GFI FaxMaker will not be able to
identify the fax to be resent, resulting either in an error or sends out a fax containing the transmission report.

2. By default, GFI FaxMaker stores sent faxes for 2 days and failed faxes for 1 week. Users cannot resend faxes after these
periods.

3. The administrator may disable fax resending by not storing faxes. Formore information, refer to Storing faxes
(page 101).

4. The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI FaxMaker
administrator. Use the configured fax domain accordingly.
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5.2 Howusers view received faxes
Received faxes are forwarded to the user via email. The email will contain a fax report and the fax file included with the
email as an attachment. Faxes can be attached in several formats, such as PDF.

Configure routing options for GFI FaxMaker to route received faxes to the correct recipient. Formore information, refer
to Fax routing (page 145).

Screenshot 36: Faxes are received in the inbox
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5.3Monitoring GFI FaxMaker operation

Screenshot 37: The GFI FaxMaker monitor

Use the GFI FaxMakerMonitor tomonitor GFI FaxMaker operation. It can be used tomonitor multiple instances of GFI
FaxMaker and both local and remote installations.

Load GFI FaxMaker Monitor from Start > Programs> GFI FaxMaker> GFI FaxMakerMonitor.

GFI FaxMaker Monitor shows status of:

Feature Description

Status of fax lines &
devices

Navigate to the Fax Server node. This displays the list of fax devices/lines and their status.
Other functionality:

Initialize - Start devices/lines that are not initialized.
Abort - Stop a particular device/line.
Debug - Generate a debug log of the device in the logs folder within the GFI FaxMaker installation folder.
Change view - Change how to display list of devices/lines.
Restart server - Restart the GFI FaxMaker Fax Server service.

Table 14: Real-time monitoring features
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Feature Description

Faxes in queue Select the Queued Faxes node to show all faxes that are waiting to be sent.
Other options:

Refresh - Refresh view of queued faxes
Select all - Select all faxes in queue
Grid - Show/hide grid lines
Columns - Customize the columns to show per fax.
Delete - Delete selected faxes from queue.
Properties - View the properties of faxes in queue, including message date/time, sender and recipient.
View logs - Load log file containing details about sent faxes.

Status of the
Message Transfer
Agent

The Message Transport Agent is the transport service for SMTP, POP3 and SMS messages. Click Message Transfer
Agent node to view important information and statistics about message transport.

Email2Fax Gateway - Shows activity of number of threads that perform POP3 down loading, fax pre
paration, SMTP sending etc.

Inbound Queue - The number of faxes prepared for sending to SMTP clients.
Inbound transfer thread - Shows activity of the process that sends faxes to SMTP clients.
Last file - The last file being processed.
Outbound Queue - The number of faxes collected by the POP3 connector for queuing to fax server.
Outbound transfer thread - Shows process activity that downloads POP3 mail from POP3 mailbox.
Last address - Last email address or SMS number used by Message Transfer Agent.
SMS transfer thread - Shows status of thread that prepares and transfers messages to SMS server.
Incoming SMS transfer thread - Shows activity of incoming SMS.

Click:
Process messages - Forces the Message Transfer Agent to poll for any new fax/SMS.
Restart - Click to restart the GFI FaxMaker Message Transfer Agent service.

5.3.1 Installing GFI FaxMaker Monitor remotely
Tomonitor a remote fax server, install GFI FaxMaker Monitor on the remote fax server machine.

From the GFI FaxMaker installation, disable GFI FaxMakerFaxServerand select GFI FaxMakerRemote Monitorwhen
selecting the components to install. In the next screen, specify the server name or IP address of the GFI FaxMaker server.

For more information how to run the GFI FaxMaker installation, refer to the GFI FaxMaker Getting Started Guide available
from http://www.gfi.com/faxmaker/manual.

http://www.gfi.com/faxmaker/manual
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6.1 Fax Lines
A fax line is a physical telephone line assigned to a fax device (modem or ISDN/fax card). Depending on the device type,
fax devices may support multiple lines. GFI FaxMaker enables you to configure different options per fax line.

Screenshot 38: The Line/Devices dialog

Fax lines are configurable from GFI FaxMakerConfiguration > Lines/Devices> Properties.

For more information, refer to:

Adding new fax lines

Editing fax lines

Deleting fax lines

Faxmodem properties

Custom Modem Properties

6.1.1 Adding new fax lines

NOTE
You can add the maximumnumber of lines supported by your fax device, up to the GFI FaxMaker limit of 128 lines.

1. Navigate to GFI FaxMakerConfiguration > Lines/Devices> Propertiesand click Add….

2. When adding new fax modems after installing GFI FaxMaker, click Detect in the Lines/Devicesdialog to attempt
automatic detection and add them to the list of devices.
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Screenshot 39: Adding an ISDN channel

3. Specify the following details:

Setting Configuration

Available fax lines Select one of the available fax line numbers. This is used as a reference to that particular line.

Device type Specify the type of fax device used.

Physical line/port Select the channel or port to configure.

Copy settings from installed
device

To copy the settings of a previously configured fax line, select this option and specify the fax line to
copy settings from.

Table 15: Add fax line options

Click OK.

4. From the Device tab in the line properties dialog, configure:

Device Type Settings

ISDN
ISDN BRI CAPI2.0 devices
ISDN PRI/IP CAPI2.0 devices
ANALOG CAPI2.0 devices
Gateway devices

ISDN type - Select the ISDN device type.
MSN numbers - Enter the number to answer incoming calls for. Key in a full number entry

(for example, 82733099) or a prefix number (for example, 82733 to answer all numbers in the
range 82733000-8273099).

Answer All - Click to answer all incoming calls received on the ISDN channel.

Brooktrout Card type - Select the Brooktrout device type
Line capabilities - depending on the properties of your fax device, select the appropriate

type, None, DTMF or DID/ISDN.
Tone dialling - If supported, select for faster dialling. If disabled, pulse dialling is used.
Wait for dialtone - Starts dialling only when a dial tone is established.
Rings until answer - Configure the number of rings before answering incoming calls.

Analog Sangoma devices
ISDN PRI Sangoma Devices

Card type - Select the Sangoma device type
Line capabilities - depending on the properties of your fax device, select the appropriate

type, None, DTMF or DID/ISDN.

Table 16: Fax line device options
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Device Type Settings

GFI Fax Modem Driver Modem type - Select the fax modem type.
Advanced Modem Options - GFI FaxMaker ships with a number of pre-configured devices.

Click to create new devices or manually configure device options. For more information, refer to
Fax modem properties (page 78).

Initialization string - Displays the string used by the modem driver to initialize the modem.
Rings until answer - Configure the number of rings before answering incoming calls.
Tone dialling - If supported, select this option for faster dialling. If disabled, pulse dialling is

used.
Wait for dialtone - Starts dialling only when a dial tone is established.
Check for busy tone - Checks if line is busy before sending fax.
Speaker mode - Configure speaker settings: Always Off, Until Connected or Always On.
Speaker volume - Set the appropriate volume.

Microsoft® Fax Modem Driver Type - Select the Fax type.
Rings until Answer - Configure the number of rings before answering incoming calls.

NOTE: Ensure that the Fax Server role is installed and the Fax service is running from the Services
applet.

Fax Services Displays settings for the selected Fax Service line. To send faxes through an online fax provider,
specify your account details in the Fax Services node. For more information, refer to Fax services
(page 94).
To associate a line with a DID, choose the DID number from the list. This option requires that the
Fax service account is validated in the Fax services node.
IMPORTANT
Online fax services require the full recipient number, including the international dial symbol "+",
the country and area codes. Do not use hyphens, spaces or dashes between any parts of the fax
number.
The full recipient number is also required when sending faxes locally.

Screenshot 40: The line options tab
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5. From the Line options tab, configure:

Option Configuration

Max. resolution Set the maximum resolution for faxes sent and received on this line.

Max. speed Set the maximum speed for faxes sent and received on this line. A lower speed limit will increase call duration
but on an analog line, it helps to avoid loss of quality when there is noise in the telephone line.

Local fax ID This number is sent to recipient faxes as part of the transmission process. The fax number is usually entered here.
NOTE: Some PABX devices do not accept the local fax ID when making outbound calls. When the fax device is
behind this type of PABX device, leave this field empty.

Receive
incoming faxes

Allow receiving faxes on this fax line.

Send outgoing
faxes

Allow transmission of faxes on this fax line.

Dial prefix &
suffix

If your lines are located behind a PBX, you can specify a dial prefix or suffix.

Do not dial prefix
if fax number is

Exclude dialling of prefix when the fax number is less than, equal to or more than a certain number of digits. This
can be useful when using different providers for local, national or international faxes.

Fax header Key in the text to show at the very top of a fax, for example the company name.

Number of
retries

Sets the number of times GFI FaxMaker will try to re-send a fax.

Retry delay Set a delay between retries, in seconds.

Disable use of
ECM if available

By default, GFI FaxMaker automatically corrects errors caused by noise that interferes with the transmission of a fax.
Select this option to disable automatic correction.

Table 17: Fax line - Line options
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Screenshot 41: The advanced line/device options

6. From the Advanced tab, configure:

Option Configuration

Auto-print faxes
received on this line

Automatically print faxes received on this line.
1. Click Setup printers... to configure printing settings.
2. In the Incoming faxes auto-print setup, configure how to size faxes for printing or select Nearest size to
automatically detect the appropriate size to use.
3. Click Print setup... to select the printer to print for that particular paper size.
4. Click OK.

Backup faxes received
on this line

Stores a copy of all incoming faxes in a folder. Key in the folder where to store received faxes.

Backup faxes sent on
this line

Stores a copy of all outgoing faxes in a folder. Key in the folder where to store received faxes.

Backup faxes in the
following file format

Select the format to use when backing up faxes.

Number of DID
digits to capture

Routes faxes to individual users based on the DID number. Set the number of digits to capture. For example,
use 2 to capture from 00 to 99.

Generate beep tone
before capture

Fax device gives a beep when answering a call as a signal to the user to enter the DTMF number. If available,
it is recommended that this option is always selected. From the drop down list select the tone of the beep.

Flash after DTMF
capture and before
fax tone

Only used for Multitech modems. Select this option so that after successfully detecting a tone, the fax server
goes 500ms on hook (flash).

Table 18: Fax line advanced options
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Screenshot 42: The users tab

7. From the Users tab, select the users allowed to send faxes using this line. Configure:

Option Description

All users/groups can send on this line Allows all licensed users to send faxes on this line.

Listed users/groups can send on this line Limits the users that can send faxes on this line.

Add… Specify users/groups allowed to send faxes on this line.

Delete Deletes selected users/groups from the list of allowed users.

Reserve line only for listed users/groups Sets the line exclusively reserved for the selected users/groups

Table 19: Fax line users
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Screenshot 43: Line test tab

8. From the Line test tab, you can send a fax to test the line settings. Key in a fax number where to send the test fax in
Faxnumberto dial and click Send test fax. Click Monitor test fax to launch the GFI FaxMakerMonitorand monitor the
status of the test fax.

9. Click OK to save settings.

10. When changing settings for any lines/devices, it is necessary to restart the GFI FaxMakerFaxServer service for
changes to take effect. Click Yes to restart.

6.1.2 Editing fax lines

1. Navigate to GFI FaxMakerConfiguration > Lines/Devices> Properties.

2. Select the device line to edit and click Properties.

3. Perform the required changes in the rule properties and click OK to save changes.

4. When changing settings for any lines/devices, it is necessary to restart the GFI FaxMakerFaxServer service for
changes to take effect. Click Yes to restart.

6.1.3 Deleting fax lines

1. Navigate to GFI FaxMakerConfiguration > Lines/DevicesProperties.

2. Select the device line to remove and click Delete.

3. Click OK to save settings.
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4. When changing settings for any lines/devices, it is necessary to restart the GFI FaxMakerFaxServer service for
changes to take effect. Click Yes to restart.

6.1.4 Faxmodem properties
GFI FaxMaker can send and receive faxes using a wide range of fax modems connected to the server’s Communications
ports.

To send faxes using these devices:

1. In the Lines/Devices list, add the modem as a GFI FaxModem Driver.

2. In the device properties dialog, select the Modem type by model name and number, or select a Generic class that
best matches device’s properties.

3. Click Advanced modem options… and select:

Option Description

New modem (current
modem as template)…

Adds a new modem to modems lists. Initial properties are based on selected modem type. For more
information, refer to Custom modem properties (page 78).

Edit modem… Loads the modem properties. For more information, refer to Custom modem properties (page 78).

Delete modem Removes selected modem from list.

Reset all modem drivers to
default

Resets all modems properties to default.

Table 20: Manage fax modems

4. Configure the other device/line options and click OK.

Custommodemproperties

Screenshot 44: Custom modem properties dialog

Customize the following options, based on fax modem specifications:
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Option Description

Modem type Key in a user friendly name for the modem type, such as the device brand, name or model number.

Flow control
Fax class
Voice chipset
DLE codes method
Thread priority
Data initialization string
Fax initialization string
Voice initialization

string
Pre-command delay
Character delay

Provide settings based on device specifications.

Table 21: Advanced fax modem options

Click OK to apply settings.

6.2 Licensed users
The list of users who can send or receive faxes must be configured in GFI FaxMaker.

Screenshot 45: List of GFI FaxMaker users and groups

The list of licensed users is available from GFI FaxMakerConfiguration > Licensed Usersnode.

Managing
users/groups

Description

Adding
users or
groups

Active Directory: To add users or groups click New licensed user/group.... Key in the user/group name and click OK.
No Active Directory: To add users click New licensed user/group.... Key in the user login name, Full name and E-

mail address. Click Personal to enter more information. Click OK. You can also add users by bulk by importing users
from a CSV file or from the list of Windows® users.

User/Group
properties

Right-click a user/group and click Properties.
NOTE: When GFI FaxMaker is not installed in an Active Directory environment, user properties are customizable. When
GFI FaxMaker is installed in an Active Directory environment, user properties are imported from Active Directory.

Table 22: Managing licensed users and groups
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Managing
users/groups

Description

Web Service
API users

Register users that will make use of the GFI FaxMaker Web Service API functionality.
Right-click user to register and from the Web API Service tab select Web Service API User.
In an Active Directory environment, use the Active Directory credentials. In SMTP environments GFI FaxMaker
automatically generates a random password to use when using the Web Service API.
For more information refer to the GFI FaxMaker API manual.
NOTE: Received faxes that are routed to users registered for Web Service API are stored in the Web Service API queue
and not forwarded to the user via email.
To remove a user from the Web API register, right-click user and from the Web API Service tab uncheck Web Service
API User. Click OK.
NOTE: When unregistering users from the Web API Service, all faxes in their name that are in the service queue are
permanently deleted. Unregister users with caution.

Removing
users/groups

Right-click a user/group to delete and click Delete. Click OK to confirm.
NOTE: Deleted users are not recoverable and must be re-added.

NOTE
You can also create a dedicated Active Directory group (for example, GFI FaxMakerusers) so that you can manage all
GFI FaxMaker users directly in Active Directory.

6.2.1 Unlimited Users license - Types of users
This feature is only applicable to the GFI FaxMaker Unlimited Users license.

Configure the types of users allowed to send/receive faxes using GFI FaxMaker. Navigate to GFI FaxMakerConfiguration
> Advanced > Miscellaneousnode:

Allow non-ADusers to send faxes - Allows all faxes/SMS to be processed by GFI FaxMaker, even if user is not in Act
ive Directory.

Onlyallow users in the Licensed user list to send faxes - allows a user to send faxes/SMS only if included in the
Licensed User list.

6.2.2 Importing list of users from CSV

NOTE
Only available if GFI FaxMaker is installed on amachine not connected to a domain.

GFI FaxMaker can import the list of users from a Comma Separated Values (CSV) file. This allows bulk addition of users.

Ensure that the text is formatted as follows:

"first name","last name","company","department","fax number","voice number","email
address","display name","internet email address"

For example:

"Joe","Bloggs","MyCompany","Sales","+1-555-12345678","+1-555-87654321","JoeBloggs@A
BCinternal.com","Joe Bloggs","JoeBloggs@ABC.com"

NOTE
All fields can be left empty, except for Email address and Display name. Email address must be unique.

To import a list of users from a CSV file:

1. From GFI FaxMakerConfiguration, right click Licensed usersand select Import users from file….

2. Select CSV file and click Open.

http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=APImanual
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3. Launch GFI FaxMakerMonitorand from FaxServernode click Restart server to restart the GFI FaxMaker Fax Server
service.

6.2.3 Importing list of users from Windows®

NOTE
Only available when GFI FaxMaker is installed on amachine not connected to a domain.

GFI FaxMaker can import the list of Windows® users from the local or a remote machine.

1. Right-click Licensed usersand select Import users….

Screenshot 46: Import users from remote machine

2. (Optional) If importing list of Windows® users from a remote machine, select Use remote server, key in server name or
IP and click List users.

3. Select the users to add from the Userson server list and click Add.

4. To add a custom internal email domain, enter domain in Append domain name.

5. Click OK.

6. Launch GFI FaxMakerMonitorand from FaxServernode click Restart server to restart the GFI FaxMaker Fax Server
service.

6.3 Fax administrators
Fax administrators monitor and manage the fax server. They are also emailed when certain critical conditions occur.
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Screenshot 47: List of Fax administrators

Tomanage the list of Fax administrator, fromGFI FaxMaker Configuration navigate to Advanced > Faxadministrators.

Function Description

Add administrators Click New….

Edit administrator properties Right-click administrator and select Properties.

Remove administrators Right-click administrator and select Delete.

Table 23: Managing fax administrators

6.4Mail server settings
Configure the mail server to use when GFI FaxMaker sends emails:

1. FromGFI FaxMaker Configuration, right-click Email2FaxGatewayand select Properties.
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Screenshot 48: Email2Fax Gateway setup

2. From the SMTPConnector tab, configure the following options:

Option Description

Mail server name/IP
and port

Enter the name or IP address of the mail server and the port number.

Use SSL Instructs GFI FaxMaker to connect and communicate with the mail server using SSL.

Use SMTP
Authentication

Instructs GFI FaxMaker to connect to the mail server using a particular user credentials. Enter credentials in
the Account and password text boxes.

Secure Password
Authentication

Select this option if Secure Password Authentication is required by the mail server.

Table 24: SMTP Connector options

3. To ensure that GFI FaxMaker can send email through the configured mail server, enter an email address and click Send
test email. Ensure that the test email is received in the mailbox. If the test fails, troubleshoot setup and configuration. For
more information, refer to Email2FaxGateway test fails (page 178).

4. Click OK.
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6.5 POP3Downloader
GFI FaxMaker can be configured to retrieve faxes and SMS for transmission from a POP3 mailbox. Configure the POP3
Connector to poll and download faxes from a dedicated GFI FaxMaker POP3 mailbox.

IMPORTANT NOTES

1. This option is not available if mail server is configured to route faxes and SMS to GFI FaxMaker via SMTP.

2. Ensure that the POP3 mailbox is dedicated exclusively to GFI FaxMaker. GFI FaxMaker downloads all emails con
tained in this mailbox for processing and emails are permanently deleted from the mailbox after download.

3. The method of sending fax/SMS via email when using POP3 is different than SMTP. Formore information, refer
to Sending faxes/SMS via a POP3 Mailbox (page 85).

Configure POP3 mailbox settings:

1. FromGFI FaxMaker Configuration, right-click Email2FaxGatewayand select Properties.

Screenshot 49: The POP3 connector

2. From the POP3Downloader tab, configure the following options:

Option Description

Enable POP3 downloader Enable downloading of faxes from a POP3 mailbox.

Mail server name/IP and port Enter the name or IP address of the mail server and the port number.

Mailbox account and password Key in credentials to access mailbox.

Table 25: POP3 Downloader options
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Option Description

Full email address of mailbox specified
above

The email address of the POP3 mailbox.

Use SSL Instructs GFI FaxMaker to connect and communicate with the mail server using SSL.

Time interval to check for new faxes Key in the frequency for GFI FaxMaker to check for new faxes in the GFI FaxMaker
mailbox.

3. Click OK.

6.5.1 Sending faxes/SMS via a POP3 Mailbox
When using the GFI FaxMaker POP3 Downloader to poll fax/SMS emails from a dedicated POP3 mailbox, the method of
sending via email is different than when using SMTP.

Sending faxes via a POP3 mailbox

Licensed users can use their preferred email client and compose fax emails as follows:

Parameter Description

Email recipient In the To field, enter the POP3 mailbox email address. For example,
faxmakermailbox@mydomain.com.

Email subject The email subject is used as the fax subject and shown, if configured, in the fax coverpage.

First line of email body Key in the fax recipient's fax number in the first line of the email body in the following format:
::fax number
For example:
::+441273123456

Email body The rest of the email body is shown in the fax coverpage.

Attachment Include any attachments to include in the fax.

Sending SMS via a POP3 mailbox

Licensed SMS users can use their preferred email client and compose SMS emails as follows:

Parameter Description

Email recipient In the To field, enter the POP3 mailbox email address. For example, faxmakermailbox@mydomain.com.

Email subject The email subject is ignored.

Email body First line: key in ::SMS to declare that the email is an SMS.
Second line: key in the recipient's SMS number in the following format: ::SMS number
Third line: key in the short message text.

For example:
::SMS
::+44123456789
Hello John, how are you?

Attachment Attachments are ignored.

6.6 Fax and SMS domain names
When installing GFI FaxMaker, connectors are configured on the mail server (either automatically or manually) to route all
emails addressed to particular domains to GFI FaxMaker. The default fax and SMS domains are *@faxmaker.com and
*@smsmaker.com.

When domain users send emails to these domains, the mail server routes these emails to GFI FaxMaker which converts
and transmits them over fax or SMS.
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For example, with the default fax domain, users can send a fax to number 123456 by composing an email addressed to
123456@faxmaker.com.

6.6.1 Modifying the default faxand SMS domain names

IMPORTANT - Use this feature with caution.
Failing to complete the steps described in this topic will hinder mail flow and consequently fax transmission.

It is recommended to only modify the domain names when constraints in the mail environment do not allow using
the default domain names. For example, when using Microsoft® Office 365™ Email only account types.

GFI FaxMaker enables modification of the default fax and SMS domain names. When these are modified, users send an
email addressed to the custom domain name.

For example, when modifying the fax domain name tofax.mydomain.com, users can send a fax to number
123456 by composing an email addressed to123456@fax.mydomain.com.

Step 1: Configure connectors on mail server

NOTE
When GFI FaxMaker is installed on the Microsoft® Exchange Server, the connectors are modified automatically in
Step 2.

Create new or modify existing connectors on the mail server using the new domain names. Connectors should route all
emails addressed to the fax and SMS domain names to the GFI FaxMaker server.

For example, to use fax.mydomain.com as your fax domain name, on your mail server create a connector that
routes all emails addressed tofax.mydomain.com to GFI FaxMaker.

IMPORTANT
If the connectors on the mail server are not modified, emails addressed to the custom fax & SMS domains are sent
over the Internet, probably resulting in an NDR.

For more information how to configure connectors in your environment, refer toMail Servers.
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Step 2: Change domain names fromGFI FaxMaker Configuration

Screenshot 50: Customizing the fax and SMS domain names

1. FromGFI FaxMaker Configuration, right-click Email2FAXGatewaynode and select Properties.

2. From the Fax/SMS domains tab, specify custom Faxdomain name and/or SMS domain name (for example,
fax.mydomain.com and sms.mydomain.com).

3. Click OK to apply changes.

NOTE
To restore the default faxmaker.com and smsmaker.com domains, click Reset to default and click OK.

Step 3: Test the new settings

When completed, it is recommended to test this functionality by sending a test fax from an email account to the new
domain names. Check that the email is received by GFI FaxMaker in the GFI FaxMaker Monitor.

6.7 Dialling Options
Dialling options enable you to configure area codes and other special dialing procedures. This ensures that GFI FaxMaker
processes the fax number in a structured manner and dials numbers in the correct format for the phone system.
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NOTE
1. GFI FaxMaker can only apply dialling configurations for fax numbers that are entered in the following format:
+<countrycode> (<area code>) <faxnumber>. For example, +44 (0) 555 5555, +1 (151) 5555 5555, +356 2555
5555

2. Dialling options are not applied when sending faxes through online fax services.

To configure dialling options, fromGFI FaxMaker Configuration right-click Advanced > Dialling > Properties.

Screenshot 51: Dialing options

IMPORTANT
Customize options for your country’s telephone dialling system. Failure to do somay cause fax transmission to fail.

Configure the following options:

Option Description

My country
code is

Key in your country telephone code, excluding the international dial prefix (the dial prefix is usually defined as +). For
example, for the United States the country code is 1.
NOTE: The dial prefix is the number that a user must dial to place an international call. The country code is the number
identifying the country to call to.

My area
code is

Key in your area code.

Table 26: Dialling Options
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Option Description

International
dialling

Configure dialling options for sending faxes to international recipients. GFI FaxMaker identifies a call as international
when the number contains a + (dial prefix) in front of the number.
Configure the following options:

If dial string starts with my country code, strip it off - select this option to automatically remove the country code
from the number when dialling a number containing the local country code. If numbers match this condition, a cus
tom prefix can be added to the number.

If dial string does not start with my country code - select this option to replace the + symbol with the international
dial prefix, that is, the number required to place an international call from your country/area/telephone service pro
vider, for example 00, 010, 0011, 011, etc...

National
dialling

Configure dialling options when sending faxes within the same country but to a different area. GFI FaxMaker identifies
a call as national when an area code is included in a number in round parenthesis, for example, (234)-56789012.
Configure the following options:

If dial string contains my area code, strip it off - select to automatically remove area code from the number when
dialling a number containing the local area code. If numbers match this condition, a custom prefix can be added to
the number.

If dial string does not contain my area code - select to add a custom prefix when dialling a national number.

NOTE: The area code in the fax number must be included in round parentheses for the fax server to determine which
part of the number is the area code.

Exceptions Some national dialling procedures can be more complex and some exceptions may be required, for example to handle
multiple local area codes. Exceptions allow you to add a prefix and/or exclude an area code when a number matches a
particular combination.
1. Click Exceptions.
2. Key in the Area code for which to apply an exception.
3. If exception is required for a particular exchange number (number right after the area code), key in the Exchange
number, or key in * to apply for all numbers in that area code.
4. To add a prefix before the area code, select Dial prefix before the area code and key in the prefix.
5. To not dial the area code, select Do not dial the area code.
6. Click Add.
7. Repeat procedure for all exceptions.
NOTE: Use commas to add a delay between numbers, if required. Each comma represents approximately a two second
delay.

6.8 Fax archiving
GFI FaxMaker can archive all inbound and outbound faxes to a central location. This enables the recording all fax
communications and the retrieval of old faxes.

There are 2 methods of archiving:

Send faxcopies to an email address - copies of transmitted, received and/or failed faxes are sent via email to a mail
box. You can then use an email archiving solution, such as GFI MailArchiver, to archive the mailbox. Formore inform
ation, refer to Archive to mailbox (page 89).

Archive to a database - Store all faxes in a Microsoft® Access or a Microsoft® SQL/MSDE database. Formore inform
ation, refer to Archive faxes to database (page 90).

6.8.1 Archive to mailbox
Use this option to send a copy of incoming, outgoing and/or failed faxes to an email address. This includes transmission
reports and the fax as attachment.

1. FromGFI FaxMaker Configuration, right-click Archiving node and select Properties.
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Screenshot 52: Archiving to an email archiving package

2. In the Archive to Mailbox tab, select the type of faxes to archive:

Option Description

Enable mail archiving for
received faxes

Enable received faxes archival.

Enable mail archiving for sent
faxes

Enable sent faxes archival.

Enable mail archiving for
failed faxes

Enable failed faxes archival.

Email address Specify the email address where to forward archived faxes.
NOTE: Email address must be included in the Licensed users list of GFI FaxMaker.

Archive faxes in this format By default, GFI FaxMaker archives faxes in .fax format. To archive in a different format (for example PDF)
enable and select the format.

Table 27: Archiving to mailbox options

3. Click OK.

6.8.2 Archive faxes to database
GFI FaxMaker can archive all faxes and SMS to a Microsoft® Access or a Microsoft® SQL/MSDE database.

1. FromGFI FaxMaker Configuration, right-click Archiving node and select Properties.
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Screenshot 53: Archiving properties

2. In the Archive to Database tab, select Enable database archiving.
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Screenshot 54: Database configuration

3. Click Setup Database to configure the database where to store faxes:

Option Description

Microsoft®

Access database
Enable archiving to a Microsoft® Access database. Key in or browse to the location where to store the database file
and specify the database name in .MDB format.
NOTE: A Microsoft® Access database size is limited to 2GB in size. When the database reaches 2GB, GFI FaxMaker
automatically renames the old database and creates a new database.

Microsoft®

SQL/MSDE
database

Archive to a Microsoft® SQL Server® or MSDE database. Key in the server name/IP or select from the list of
automatically detected servers. Enter credentials to connect to the server.
In Select database, specify the database to archive to. Choose one of the detected databases from the list or archive
to a new database called FAXmakerArchive that is automatically created by GFI FaxMaker.
NOTE 1: GFI FaxMaker archiving requires mixed mode authentication to be enabled on the SQL Server®.
NOTE 2: Some databases may have size limitations. Ensure that this limit is not exceeded.

Table 28: Archiving to database options

4. Click Test to verify settings and click OK.

5. By default, GFI FaxMaker archives faxes in .fax format. To archive in a different format, for example PDF, select Archive
faxes in this format and specify custom format required.

6. Click OK.

6.8.3 Viewing faxes archived to a database
GFI FaxMaker includes a tool to view faxes archived to a Microsoft® Access or a Microsoft® SQL/MSDE database.

Go to the GFI FaxMaker installation folder and open the ArchiveViewer folder. Load GFI.FaxMaker.ArchiveViewer.exe.
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The GFI FaxMaker Archive Viewer reads from the database configured in the GFI FaxMaker Archive to Database options.
If database archiving is not enabled, the GFI FaxMaker Archive Viewer is not able to show any faxes.

Screenshot 55: The GFI FaxMaker Archive Viewer

The list of archived faxes is displayed, showing the most important information.

Click on a fax to show more detailed information.

Screenshot 56: Viewing fax details in the GFI FaxMaker Archive Viewer

When viewing the detailed fax information you can also:
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Click Preview to open the fax in the archived format.

(Outbound faxes only) Click Resend to resend the fax.

Searching archived faxes

To search through the list of archived faxes, click Filter to show the filtering pane.

Screenshot 57: Filtering faxes in Archive Viewer

Select a filtering parameter and key in or choose the data to filter. You can also:

Click Add filter to add more filters.

Click next to a filter to remove it.

When all the required filtering parameters are configured, click Apply to filter the results. The Archive Viewer shows faxes
that match all the specified filters.

6.9 Fax services
GFI FaxMaker can send and receive faxes through supported online fax providers. This enables faxing without installing
fax devices or dedicated phone lines.

To use this feature you are required to subscribe with a supported online fax service provider:

GFI Online Fax Service

etherFAX fax service

For more information go to http://go.gfi.com/?pageid=FM_FaxServices.

6.9.1 Specifying the faxnumber

IMPORTANT
Online fax services require the full recipient number, including the international dial symbol "+", the country and
area codes. Do not use hyphens, spaces or dashes between any parts of the fax number.

The full recipient number is also required when sending faxes locally.

Example 1: When sending a fax to Czech Republic number 313-414-515 use
+420313414515@faxmaker.com. Where:

+ is the international dial prefix

420 is the Czech Republic country code

313414515 is the fax number

Example 2: Sending a fax to a UK number, with area code 01273, and number 123-456. In this case use
+441273123456@faxmaker.com. Where:

http://go.gfi.com/?pageid=FM_FaxServices
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+ is the international dial prefix

44 is the UK country code

1273 is the area code (in the case of the UK the preceding 0 is dropped when using the international dial num
ber)

123456 is the fax number

6.9.2 Configuring a GFI Online FaxService account
When a GFI Online Fax Service account is available, specify the account details in GFI FaxMaker:

1. FromGFI FaxMaker Configuration, right-click FaxServicesnode and select New faxservice account.

2. Select GFIOnline FaxService and click OK.

Screenshot 58: New GFI Online Fax Service account

3. Configure the following options:

Option Description

Account name Key in a friendly account name which will be used to identify this service.

User ID Enter your GFI Online Fax Service user ID. This usually starts with MBX.

Password Key in you GFI Online Fax Service account password.

4. Click Validate Account to check if GFI FaxMaker can access the service using the details provided.

5. In Receive poll interval in minutes specify the frequency for GFI FaxMaker to check for new faxes.

6. Click OK.

Next, configure a fax line for the fax service so that GFI FaxMaker can start sending/receiving faxes from this service. For
more information, refer to Fax Lines (page 71).
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6.9.3 Configuring an etherFAX fax service
When an etherFAX account is available, specify the account details in GFI FaxMaker:

1. FromGFI FaxMaker Configuration, right-click FaxServicesnode and select New faxservice account.

2. Select etherFAX and click OK.

Screenshot 59: New etherFAX account

3. Configure the following options:

Option Description

Account name Key in a friendly account name which will be used to identify this service.

etherFAX Account Enter your etherFAX account. This usually starts with EFAX-.

etherFAX Server Choose your preferred etherFAX server location.

User ID Your etherFAX username specified when signing up to the service.

Password Key in you GFI Online Fax Service account password.

1. Click Validate Account to check if GFI FaxMaker can access the service using the details provided.

2. In Receive poll interval in minutes specify the frequency for GFI FaxMaker to check for new faxes.

3. Click OK.

Next, configure a fax line for the fax service so that GFI FaxMaker can start sending/receiving faxes from this service. For
more information, refer to Fax Lines (page 71).
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6.10 OCR
Optical Character Recognition (OCR) converts received and sent fax content to text. Due to the nature of fax technology,
the content of sent and received is not usable by the system. By converting faxes to text, the fax content is more usable,
for example, by enabling users and administrators to search through the fax content.

1. FromGFI FaxMaker Configuration right-click Advanced > OCRand select Properties.

Screenshot 60: OCR properties

2. Configure the following options:

Option Description

Set Languages Click to select the languages to use during OCR analysis.
NOTE: The languages available depend on license type.

Enable spell checking and correction By enabling this option, the OCR engine checks and corrects spelling problems.

Table 29: Enabling OCR

3. From the Inbound OCR tab, configure OCR options for received faxes:

Option Description

Append OCR output text
below fax report

Insert the OCR text in the body of the transmission report email. This enables searching through faxes
using the email client’s search function.

Attach OCR output text file
with fax report

Store the OCR text in a text file and attach it in the transmission report.

Maximum pages to convert Set the maximum number of pages to convert to text.

Table 30: Inbound OCR

4. From the Outbound OCR tab, configure OCR options for sent faxes:



GFI FaxMaker 6General configuration settings |98

Option Description

Enable OCR on sent faxes Select this option to run OCR on outgoing faxes.

Directory Specify a folder where to store the OCR content. The text is stored in a plain text file.

Maximum pages to convert The maximum number of pages that GFI FaxMaker converts per fax sent.

Table 31: Outbound OCR

5. Click OK.

6.11 Log files
Log files enable administrators to review the activity of GFI FaxMaker.

6.11.1 Managing log files

NOTE
The following settings apply to the log files described in List of log files.

1. From the GFI FaxMaker Configuration, right-click Advanced > Logging node and select Properties.

Screenshot 61: Logging settings

2. Configure the following options:

Option Description

Folder The folder where to store the log files.
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Option Description

Start logging
to new file

Select the condition when to start logging to new log files. Old log files are stored in the same folder, extension is
changed to BAK format (can be opened in text editor) and renamed as follows:
<log name><date>.fmlogger.bak
For example:
sendlog20140815.fmlogger.bak

Size limit
(Mb)

When selecting to start using new log files when a particular size is reached, specify the file size in megabytes. GFI
FaxMaker starts logging to a new log file when the current log file reaches this file size.

Delete old
files

Choose whether to keep or discard old log files. If enabled, GFI FaxMaker keeps only the number of log files
configured in Max number of files to keep. Older log files are automatically deleted.
NOTE: Deleted log files are permanently removed and not recoverable.

Compress old
files to keep

Log files are compressed to ZIP format.

3. Click OK.

6.11.2 List of GFI FaxMaker log files

Log file Description

sendlog.fmlogger.txt Contains a log of sent faxes in the following format:
Date, Time, SenderEmail, SenderName, BillingCode, RemoteId, RecipientName,
RecipientCompany, RecipientNumber, CallDuration, PagesTransferred, Result,
Info, Port, FilesInArchiveDir
For example:
"7/1/2014","2:16:48 AM", "jsmith@mydomain.com", "John", "", "88888888",
"Bob", "Company", "99999999", "05:30", "3", "SUCCESS", "Fax has been sent
successfully", "COM2", "C:\Sent\20110701_015642_00001.pdf"

rcvlog.fmlogger.txt Contains a log of received faxes in the following format:
Date, Time, RemoteID, CallDuration, PagesReceived, Result, Info, Port,
FileInArchiveDir, RoutedTo
For example:
"6/30/2014","8:47:01 AM","+557(833)343-3948", "03:30", "2", "SUCCESS", "Fax
received from +557(833)343-3948", "Line0", "C:\Received Faxes\20110630_
084657_00003.pdf", "jsmith@mydomain.com"

smtpin.fmlogger.txt A log of emails generated by GFI FaxMaker that are sent to local users. The log is in the following format:
Date, Time, Subject, Sender, Recipient, Status
For example:
2014-06-29, 08-34, Success: Test fax (Fax sent to 123456)
[::resend=s3030be58], '+123456789' <'+123456789'@faxmaker.com>,
jsmith@mydomain.com, Success - Message uploaded.

smtpout.fmlogger.txt A log of emails sent by fax users to GFI FaxMaker. The log is in the following format:
Date, Time, Subject, Sender, Recipient
For example:
2014-06-29, 08-42-40, Test fax subject, jsmith@mydomain.com,
+123456789@faxmaker.com

smsout.fmlogger.txt A log of sent SMS in the following format:
Date, Time, Subject, Sender, Recipient
For example:
2014-06-29, 09-21-05, This is subject, jsmith@mydomain.com,
+123456789@smsmaker.com

smsin.fmlogger.txt A log of received SMS in the following format:
Date, Time, Sender, Recipient, Status, Message, Details
For example:
"09/05/2014", "09:06:32", "+123456789", "jsmith@mydomain.com", "Success",
"This is SMS message text", "Success. SMS received."

Table 32: GFI FaxMaker log files
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6.12 HP Digital Sender integration
GFI FaxMaker supports HP Digital sender scanner/copier. This enables you to send faxes directly from the Digital sender
device, by entering the document in the tray and dialling recipient fax number. Faxes are sent via GFI FaxMaker and the
user will receive a confirmation in his mailbox. For the latest list of supported HP Digital Sender devices, refer to
http://go.gfi.com/?pageid=FM_HPDigitalSender.

To send faxes from an HP Digital sender:

Screenshot 62: Configuring the Digital Sender

1. From the HP Digital sender link applet, select Inbox tab.

2. Select Enable receive.

3. In Path to receive inbox, provide a directory where the HP Digital Sender will pick up the fax information files.

4. FromGFI FaxMaker Configuration, right-click HPDS/SAPnode and select Properties.

http://go.gfi.com/?pageid=FM_HPDigitalSender
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Screenshot 63: HP Digital sender set-up

2. From the HPDS tab, select Scan folder forHPF files. Key in or browse to the directory specified in the HP Digital
Sender app and select the HPFSCAN folder.

3. Click OK.

4. From the HP Digital sender JetAdmin utility, modify your HP Digital Sender to enable fax. Choose Othervendorswith
notification support as Network Fax Server.

6.13 Storing faxes
By default, GFI FaxMaker stores copies of fax attachments on the GFI FaxMaker server for a number of days:

Sent faxes - A copy is stored for 2 days.

Failed faxes - A copy is stored for 1 week.

These are stored in <GFI FaxMaker installation folder>\data\attachments folder. This allows resending of fax
attachments.

To configure storage of fax attachments:

1. FromGFI FaxMaker Configuration, right-click Advanced > Miscellaneousnode and select Properties.

2. From Faxserveroptionsarea, configure:

Option Description

Do not store sent fax attachments for resending Select option to not store sent fax attachments.

Do not store failed fax attachments for resending Select option to not store failed fax attachments.

Table 33: Storing faxes
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3. Click OK.

6.14 Licensing information
To review and modify licensing details, fromGFI FaxMaker Configuration, right-click General > Licensing and select
License product….

Screenshot 64: Viewing current licensing information

Use this node to view current licensing information or to enter your License key number.

Click EnterLicense Key to edit your license key.
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7 Maintenance
This topic contains information about how tomaintain your GFI FaxMaker installation:

7.1 Configuration backup 103

7.2 Moving your installation to a different server 104

7.3 Version information 107

7.4 Product Patches 108

7.1 Configuration backup
This topic describes how to backup your GFI FaxMaker settings to store your existing configuration. The backup can be
used to safeguard settings or when migrating GFI FaxMaker to a different server.

NOTES

1. These instructions apply to the latest version of GFI FaxMaker only.

2. Log on to the GFI FaxMaker server using an account with administrative privileges.

3. GFI FaxMaker services are stopped during backup. Consequently fax transmission is also stopped and no faxes are
sent or received.

7.1.1 Step 1: Stop GFI FaxMaker services
GFI FaxMaker services must be stopped when backing up the configuration. When using a backup software to automate
the backup, ensure that the selected backup software stops these services before the backup job starts. If services or files
are open and/or running, the backup may be unusable. If this is the case, a manual backup is recommended.

When stopping services manually, use either the Services applet or create a batch file using the net stop command.

GFI FaxMaker services to stop:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker WSAPI

NOTES
Older versions of GFI FaxMaker utilize different service names. In this case, stop all services with a name that start
with GFI FaxMaker or FAXmaker.

7.1.2 Step 2: Backup files
Copy the following files and folders that reside in the GFI FaxMaker installation folder.

Unless modified manually during installation, by default, GFI FaxMaker installs to the following path:

32-bit systems:C:\Program Files\GFI\FaxMaker\

64-bit systems:C:\Program Files (x86)\GFI\FaxMaker\
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It is recommended to take note of the installation path since if the backup needs to be used, the files need to be
deployed to the same path (either on the same or on a different server).

Files and folders to backup:

Files Type Notes

fmsmscomms.xml File

config.mdb File

doccvt.ini File

remclient.ini File

modems.dev File

fmdb_rul.mdb File

fmdb_usr.mdb File Only when GFI FaxMaker is installed in SMTP mode.

options.ini File If available.

mobiles.dev File If available.

rcvlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy the file from that
folder.

sendlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy the file from that
folder.

coverpge Folder Include all folder contents.

data Folder Include all folder contents.

archive Folder Include all folder contents.
This is the default location of the Microsoft® Access database fax archive feature. If you changed the
default location, backup that folder as well.

7.1.3 Step 3: Start the GFI FaxMaker services
Start the services that were stopped in Step 1.

When starting services manually, use either the Services applet or create a batch file using the net start command.

7.2Moving your installation to a different server
This topic describes how tomove your existing GFI FaxMaker installation to a new server while retaining your current
settings.

WARNING
Moving aGFI FaxMaker installation and settings to another server requires aconsiderable amountof manual work,
fax service downtime, third-party software re-configuration and extensive testing. It is highly recommended to
review the information in this topic and plan ahead before undertaking this task.

7.2.1 Important notes
Certain features in GFI FaxMaker use system resources such as locations on disk, printer drivers and third-party soft

ware. GFI FaxMaker has no control over these resources and must therefore be manually reconfigured. For example, OCR
may be configured to store a copy of OCR content on disk. This folder must be re-created on the new server or a new dir
ectory reconfigured in GFI FaxMaker. Refer to Step 6: Update feature settings in this topic.

This procedure is applicable for the latest version of GFI FaxMaker only.
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The old instance of GFI FaxMaker must be running the latest version of GFI FaxMaker and the same version used to
install the new instance.

If GFI FaxMaker is currently installed in Active Directory, the new installation should be in the same Active Directory
structure, referencing the same Active Directory domain.

When moving Brooktrout SR140 FoIP software, a rehosting of the license key is required since the license is tied to
the host machine. For more information refer to http://go.gfi.com/?pageid=FM_SR140rehostlicense

7.2.2 Step 1: Upgrade old server to the latest version
Before moving your installation:

1. Ensure that you are running the latest version of GFI FaxMaker on the old server. If an upgrade is required, upgrade the
old GFI FaxMaker installation. For more information refer toUpgrading GFI FaxMaker.

2. If you are using the GFI FaxMaker Client, ensure that you install the latest version on client machines. Download the
latest GFI FaxMaker Client from http://go.gfi.com/?pageid=FM_FaxClient.

7.2.3 Step 2: Copy the old configuration files
On the old server, stop all GFI FaxMaker services:

GFI FaxMaker Fax Server

GFI FaxMaker Message Transfer Agent

GFI FaxMaker WSAPI

Copy the following files and folders that reside in the GFI FaxMaker installation folder.

Unless modified manually during installation, by default, GFI FaxMaker installs to the following path:

32-bit systems:C:\Program Files\GFI\FaxMaker\

64-bit systems:C:\Program Files (x86)\GFI\FaxMaker\

Files and folders to copy:

Files Type Notes

fmsmscomms.xml File

config.mdb File

doccvt.ini File

remclient.ini File

modems.dev File

fmdb_rul.mdb File

fmdb_usr.mdb File Only when GFI FaxMaker is installed in SMTP mode.

options.ini File If available.

mobiles.dev File If available.

rcvlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy the file from that
folder.

sendlog.fmlogger.txt File This is the default location of log files. If you changed the default location, copy the file from that
folder.

coverpge Folder Include all folder contents.

data Folder Include all folder contents.

http://go.gfi.com/?pageid=FM_SR140rehostlicense
http://go.gfi.com/?pageid=FM_FaxClient
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Files Type Notes

archive Folder Include all folder contents.
This is the default location of the Microsoft® Access database fax archive feature. If you changed the
default location, backup that folder as well.

7.2.4 Step 3: Move configuration files
Move the files copied in step 3 to a folder on the new server. This folder will be used as the install directory for your new
installation.

7.2.5 Step 4: Install GFI FaxMaker

Ensure that the new server meets or exceeds the GFI FaxMaker system requirements. If using a fax modem, install the
modem on the new server.

Save and close any open applications and run the GFI FaxMaker installer using an account with administrative privileges.
Apply the settings below when prompted during the installation wizard:

When asked to choose the installation path, select the folder where configuration files were moved to in step 3. This
ensures that the old files are used when the new installation of GFI FaxMaker is installing.

Key in your existing license key to activate the product.

Do NOT run the post-install configuration wizard. Click Cancel to stop and close the post-install wizard. If you pro
ceed with the wizard, your old settings will be overwritten.

7.2.6 Step 5: Reconfigure mail server connectors
Adjust your mail server connectors to route fax and sms emails to the new GFI FaxMaker server. Change the connectors IP
address to the address of the new GFI FaxMaker server. Formore information, refer to Mail server configuration (page
16).

7.2.7 Step 6: Update feature settings
Various features in GFI FaxMaker utilize system resources. These settings are imported on to the new server as previously
configured on the old installation. Consequently these old settings require manual reconfiguration to be adapted to the
new server.

Examples:

XMLAPI and TextAPI pick up APIs from a folder on disk. After migration, the new installation is still configured to pick
up APIs from the directory configured on the old server. This path may, however, not exist on the new server. Re-con
figure the TextAPI and XMLAPI pickup folders to new paths on the new server. Third-party applications that auto
matically generate APIs for faxing will also require re-configuration to deploy APIs to the new pickup location.

Fax linesmay have been configured to backup sent/received faxes to a folder on disk. Re-configure the folder
where to backup faxes to a new location on the new server. Fax lines may also be configured to automatically print
received faxes. In this case re-configure the fax line to print on another printer.

The below table lists some features and settings that may require reconfiguration. Various other tweaks and re-
configurations may be required depending on your deployment scenario and environment.

Feature Notes

Fax archiving to
database

Microsoft® SQL/MSDE: ensure that the new server has access to the database server.
Microsoft® Access: re-configure path to database.

OCR Directory where OCR content is stored.

Log files Log files custom folder.
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Feature Notes

HP Digital Sender
and SAP

Directories where the HP Digital Sender and/or SAP pick up the fax information files.

Fax lines Locations where lines store copies of sent/received faxes and printer drivers.

Sending options Revise printer options.

Document con
version

Install any software that is used to convert attachments to fax format.

NetPrintQueue2Fax May require re-installation of printer driver on client machines when moving from a 32-bit server to a 64-bit
server.

Nuance eCopy
ShareScan

Update the connector server information from the Nuance eCopy ShareScan Administration Console.

Printers Install the old printer driver on the new server or re-configure new printers. When re-configuring new printers,
ensure that features using old printers are adjusted accordingly.

Junk fax filter Directory where junk faxes are stored.

SMS Install GSM modems (if applicable) on the new server.

7.2.8 Step 7: Test the new faxing setup
Ensure that the new fax setup is properly configured and fully functional.

Send test faxes to check fax transmission. Formore information, refer to Testing your installation (page 62).

It is also recommended to test individual features to ensure that the configuration is migrated successfully.

7.3 Version information
To review information about your GFI FaxMaker installation, fromGFI FaxMaker Configuration, right-click General >
Version information and select Properties.

You can also check for newer versions of GFI FaxMaker from the GFI web site.
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Screenshot 65: GFI FaxMaker version information

7.4 Product Patches
The Product Patches feature verifies if there are any software patches available for your version of GFI FaxMaker by
directly connecting to the GFI Update Servers.

NOTE
It is highly recommended to check for patches periodically to keep GFI FaxMaker updated.

1. FromGFI FaxMaker Configuration, go to General > Product Patches.

2. GFI FaxMaker connects to the GFI Update Server and lists all available updates.

3. Click the link of patches to download.

4. Decompress the downloaded patch file.

5. Follow the instructions included with the downloaded file to implement the patch.

NOTE
Incorrect patch installation (for example, by not following instructions) may cause GFI FaxMaker tomalfunction or
degrade its performance.
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8.1 Sending options
1. FromGFI FaxMaker Configuration, right-click Sending/Receiving Optionsand select Properties.

Screenshot 66: Sending options

2. Select Sending tab and configure the following options:

Option Description

Enhance fax image when
sending normal
resolution faxes

Improves the quality of low-resolution faxes.

Send fax report
attachments in the
following format

By default GFI FaxMaker attaches incoming fax in .FAX format. Select this option to customize the
attachment format, for example attach the fax in PDF format.

Automatically print
outgoing faxes if
successful

Automatically print all outgoing faxes that are sent successfully. Click Setup printers... to configure printer
options.

Auto print if failed Automatically print all outgoing faxes that fail. Click Setup printers... to configure printer options.

Automatically print
outgoing fax report if
successful

Automatically print transmission report after successfully sending a fax. GFI FaxMaker will also print 6 fax
pages on one printer page. Click Setup printers... to configure printer options, including how many pages
of the report to print.

Auto print report if
failed

Automatically print all transmission reports for outgoing faxes that fail. Click Setup printers... to configure
printer options.

Table 34: Sending options
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3. Click OK.

8.2 Document Conversion
GFI FaxMaker enables users to send faxes by attaching content to an email. GFI FaxMaker automatically converts the
attachment to fax. For this purpose, a built-in conversion engine is included for PDF, HTML, PNG, GIF, JPG, RTF and TXT
files.

NOTE
Microsoft® Office® 97 or higher is required on the GFI FaxMaker server to convert Microsoft® Office® file formats.
Microsoft® Office® 2007 or higher is required on the GFI FaxMaker server to convert Microsoft® Office® Open XML
files, such as DOCX and XLSX files.

1. FromGFI FaxMaker Configuration, right-click Advanced > Document conversion and select Properties.

Screenshot 67: Document conversion options

2. Configure the following options:

Option Description

File extension list to
ignore

Enter the extensions to ignore, separated by semi-colons - ;

File extension list
allowed for
conversion

List of extensions that can be converted by GFI FaxMaker.

Table 35: Document conversion options
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Option Description

Add To add new file formats for conversion, key in the Extension to add. In Command text box, key in the
Application Command that prints the file in Windows® Explorer (Usually this is Print). Click Add.
NOTE: To verify whether GFI FaxMaker can convert a file extension, from Windows® Explorer, right-click a file in
that format and select Print. The file must print successfully.

Remove Click to delete a selected file extension.

3. Click OK.

8.3 Transmission reports
GFI FaxMaker notifies the user about the status of sent faxes/SMS by sending a transmission report. The report contains
details of the fax/SMS transmission. Optionally you can configure to include the fax content and fax body.

Screenshot 68: Fax transmission report

8.3.1 Configuring fax transmission reports

1. FromGFI FaxMaker Configuration, right-click Advanced > Transmission reportsand select Properties.
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Screenshot 69: Fax transmission report options

2. Configure the following options:

Option Description

Report successful
outgoing FAX
transmissions

Send a transmission report when a fax is sent successfully.

Include attachments with
success reports

Includes the transmitted fax with successful transmission reports.

Report failed outgoing
FAX transmissions

Send a transmission report when a fax fails.

Include attachments with
failure reports

Includes the fax content with failed transmission reports.

Append original message
body

Include the original fax message body in the transmission report, below the report text. Using this option
allows users to re-submit faxes and find sent faxes.

Send one summary
report when faxing to
multiple recipients

When sending a fax to multiple recipients, GFI FaxMaker sends the fax to each recipient individually.
Select this option to group transmission reports in one summary report. When unselected, a transmission
report is sent for each fax recipient.

Table 36: Transmission reports options

3. Click OK.

8.3.2 Configuring SMS transmission reports

1. FromGFI FaxMaker Configuration, right-click Advanced > Transmission reportsand select Properties.
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Screenshot 70: SMS transmission report options

2. From the SMS tab, configure:

Option Description

Report successful outgoing
SMS transmissions

Send a transmission report when an SMS is sent successfully.

Send one summary report
when sending SMS to mul
tiple recipients

When sending an SMS to multiple recipients, GFI FaxMaker sends the SMS to each recipient individually.
Select this option to group transmission reports in one summary report. When unselected, a trans
mission report is sent for each SMS recipient.

Table 37: Transmission reports options

NOTE
A report is always sent if transmission of SMS fails.

3. Click OK.

8.3.3 Customizing transmission reports
The template of transmission reports can be customized. To do this:

1. Navigate to<GFI FaxMaker installation folder>\data\reports.

2. Open the template to edit in Notepad:

Report template Description

error.fbt Transmission report for failed faxes

Table 38: Fax report templates
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Report template Description

recv.fbt Fax report for received faxes

sent.fbt Fax report for sent faxes

smserror.fbt Transmission report for failed SMS

smsrecv.fbt Fax report for received SMS

smssent.fbt Fax report for sent SMS

summarysent.fbt Summarized transmission report when a fax is sent to multiple recipients.

summarysent_
details.fbt

The details of failed fax transmissions. This section is appended to summarysent.fbt for each failed trans
mission.

3. Modify the file using the following fields. Some fields may not be applicable for certain reports.

NOTE
Reports starting with htmlprefix (for example, htmlrecv.fbt), are the equivalent reports in HTML format. In this case
use square brackets [ and ] for fields instead of angled brackets.

Field Description

<status> Transmission status

<date> Transmission date

<time> Transmission time

<date_time> Shows both transmission date and time

<speed> Transmission speed

<connection_time> Duration of transmission

<pages> Number of pages sent

<total_pages> Total number of pages requested to be sent

<resolution> The fax resolution.

<remote_id> Recipient’s line number

<local_id> Local line number

<line> GFI FaxMaker line number.

<retries> Number of retries that GFI FaxMaker tried to establish connection with recipient.

<description> A description of the status of fax transmission.

<dtmf_did> The DTMF/DID number.

<subject> The subject of the email requesting the fax transmission.

<billing_code> The billing code.

<r_last_name> Recipient’s last name

<r_first_name> Recipient’s first name

<r_name> Recipient’s display name

<r_company> Recipient’s company name

<r_department> Recipient’s department

<r_email> Recipient’s email address

<r_fax> Recipient’s fax number

<r_voice> Recipient’s phone number

<s_last_name> Sender’s last name

Table 39: Fax report fields
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Field Description

<s_first_name> Sender’s first name

<s_name> Sender’s name

<s_company> Sender’s company name

<s_department> Sender’s department

<s_email> Sender’s email address

<s_fax> Sender’s fax number

<s_voice> Sender’s phone number

<total_faxes> Total number of faxes (summary reports only)

<succeeded_sendings> Number of faxes sent successfully (summary reports only)

<failed_sendings> Number of faxes that failed transmission (summary reports only)

8.4 Header/Footer options
GFI FaxMaker enables you to customize the header and footer text for all outgoing and incoming faxes.

8.4.1 Outgoing faxes

1. FromGFI FaxMaker Configuration, right-click Advanced > Header/Footer/Stamping and select Properties.

Screenshot 71: Header/Footer options for outgoing faxes

2. From the Header/Footer tab, configure:
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Option Description

Formatting and alignment Configure font, font size and alignment.
NOTE: During configuration, select the header and footer fields configuring to apply
different formatting.

Render this header text on all
outgoing faxes

Select to add a header on all outgoing faxes. Key in the text to display.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

Render this footer text on all outgoing
faxes

Select to add a footer to all outgoing fax. Key in the text to display.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

Table 40: Header and footer options

3. Click OK.

8.4.2 Incoming faxes

1. FromGFI FaxMaker Configuration, right-click Advanced > Header/Footer/Stamping and select Properties.

Screenshot 72: Stamping options for incoming faxes

2. From the Stamping tab, configure:

Option Description

Formatting and alignment Configure font, font size and alignment.
NOTE: During configuration, select the header and footer fields configuring to apply
different formatting.

Table 41: Stamping options
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Option Description

Render this header text on all
incoming faxes

Select to add a header on all incoming faxes. Key in the text to render.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

Render this footer text on all incoming
faxes

Select to add a footer on all incoming faxes. Key in the text to render.
Set to default - Click to reset text to default.
Insert field... - Select custom field to add where there is the cursor.

3. Click OK.

8.5 Coverpages
GFI FaxMaker enables you to include a front page to your fax content that includes custom information and design. This
page is attached and sent as the first page of a fax.

The coverpage typically includes important fax details (such as recipient and sender’s information) and the message text
(email body when user sends email via email client or fax message form).

By default, GFI FaxMaker includes a number of built-in coverpages. To access the list of coverpages, fromGFI FaxMaker
Configuration navigate to Coverpagesnode and select Coverpagesor Front Covernotes.

Configuring coverpage settings:

General coverpage options - enable/disable coverpages and conditions when to send a coverpage.

Adding new coverpages - add new and custom coverpages.

Default coverpage - the coverpage applied for all users that have no other coverpage configured.

Custom user coverpages - use different coverpages for different users or user groups.

Editing built-in coverpages - how tomodify built-in coverpages.

Preview built-in coverpage - preview built-in coverpages in web browser or editor.

Coverpage merge-fields - list of supported fields used to display useful fax information.

A Front Covernote complements a coverpage and is aimed to add a brief message before the coverpage (similar to a
‘With Compliments’ note). Formore information, refer to Front Covernotes (page 124).

General coverpage options

1. FromGFI FaxMaker Configuration, right-click Coverpages> Coverpagesand select Properties.
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Screenshot 73: Coverpage options

2. Configure the following options:

Option Description

Send coverpages Enable or disable coverpages.
NOTE: Disabling coverpages from the Coverpages properties dialog box also disables Front
Covernotes.

Only if message text is present Include a coverpage only when sending a fax that contains a message body (for example, when
sending a fax as an attachment via email and the email also contains an email body).

Use this coverpage when no default
coverpage is associated with a user

Select the default coverpage to use when a user does not have a custom coverpage
configured.

Table 42: Coverpages

3. From the Rendering tab set the coverpage margins (in Inches).

4. Click OK.

Adding new coverpages

Step 1: Create coverpage

You can create custom coverpages in HTML, RTF or MHT format, using custom designs, text and fields. Use your preferred
editor to create the page.
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NOTE
1. You can use fields to display useful information. Formore information, refer to Supported merge-fields (page
122).
2. Use UTF-8 encoding for HTML coverpages.

Step 2: Add coverpage to GFI FaxMaker

1. FromGFI FaxMaker Configuration, navigate to Coverpages> Coverpages.

Screenshot 74: Creating a new coverpage

2. Click New….

3. Key in a Displayname.

4. Click Add from file…, browse to the newly created coverpage and click Open.

5. Click OK.

6. Add any particular users to apply this coverpage for.

7. Click OK.

Default coverpage

The default coverpage is the coverpage applied for all users that have no other coverpage configured. To specify a
default coverpage:

1. FromGFI FaxMaker Configuration navigate to Coverpages> Coverpages.

2. Right-click the coverpage and select Set asdefault global coverpage.

Using a custom coverpage for a list of users

GFI FaxMaker can use different coverpages for different users or user groups. To apply a custom coverpage for a particular
user or user group:

1. FromGFI FaxMaker Configuration, navigate to Coverpages> Coverpages.

2. Right-click the coverpage to a associate custom user for, and select Properties.
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Screenshot 75: Coverpage users

3. From the Users tab add the users for which to apply the coverpage.

4. Click OK.

Editing built-in coverpages

1. FromGFI FaxMaker Configuration navigate to Coverpages> Coverpages.

2. Right-click the coverpage to edit and select Properties.
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Screenshot 76: Coverpage options tab

3. From the Options tab, click Edit. Coverpage is loaded in text editor.

4. Edit the page as required.

NOTE
When editing coverpages, you can use fields to show custom information. Formore information, refer to
Supported merge-fields (page 122).

5. Save and exit when complete.

6. Click OK.

Previewing built-in coverpages

To preview coverpages, navigate to<GFI FaxMaker installation folder>\coverpage\. Double-click coverpage to
preview in web browser (HTML or MHT format) or word editor (RTF format).

8.5.1 Supported merge-fields
The following fields are used in coverpages and front covernotes to display useful fax information.

NOTE
All fields must be in lower case.
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Sender’s details

Field Description

[s_last_name] Sender’s last name

[s_first_name] Sender’s first name

[s_name_fl] Sender’s first & last name

[s_name_lf] Sender’s last & first name

[s_company] Sender’s company name

[s_department] Sender’s department name

[s_fax] Sender’s Fax number

[s_voice] Sender’s telephone number

[s_e-mail] Sender’s email address

Table 43: Coverpage merge fields - sender’s details

Recipient’s details

Field Description

[r_company] Recipient’s company name

[r_department] Recipient’s department name

[r_first_name] Recipient’s first name

[r_last_name] Recipient’s last name

[r_name_fl] Recipient’s first & last name

[r_name_lf] Recipient’s last & first name

[r_fax] Recipient’s Fax number

[r_voice] Recipient’s telephone number

[r_e-mail] Recipient’s email address

Table 44: Coverpage merge fields - recipient’s details

Other fields

Field Description

[message] Show the email body text.
NOTE 1: Ensure enough space is allocated to fit in the email body.
NOTE 2: Emails normally include plain text and HTML formats for backward compatibility. By default, GFI FaxMaker shows
the HTML version. To choose the preferred format, right-click Coverpages node in GFI FaxMaker and select the preferred
format.

[time] Fax transmission time

[date] Fax transmission date

[longdate] Fax transmission date and time.

[subject] Shows the email subject

[total_
pages]

Total number of fax pages, including the coverpage.

Table 45: Coverpage merge fields
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8.6 Front Covernotes
A front covernotes are aimed to contain less details than a Coverpage, Front covernotes serve to add a brief message
before the coverpage (similar to a ‘With Compliments’ note).

By default, GFI FaxMaker includes a number of built-in front covernotes. To access the list of front covernotes, fromGFI
FaxMaker Configuration navigate to Coverpagesnode and select Front Covernotes.

NOTE
Front covernotes are aimed to compliment coverpages. Disabling Coverpages, disables also Front covernotes.

Configuring front covernote settings:

General front covernote options - enable/disable front covernotes and set covernote margins.

Adding new front covernote - add new and custom front covernotes.

Default front covernote - the front covernote applied for all users that have no other front covernote configured.

Custom user front covernotes - use different front covernotes for different users or user groups.

Front covernote merge-fields - list of supported fields used to display useful fax information.

General front covernotes options

1. FromGFI FaxMaker Configuration, right-click Coverpages> Front covernotesand select Properties.

Screenshot 77: Front covernote options

2. Configure the following options:
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Option Description

Use front
coverpage

Select this option to always send a front covernote for emails sent by all users. Specify the Front covernote to use when
the user does not have a custom associated front covernote configured.
By disabling this option, GFI FaxMaker only sends a covernote for faxes originating from users who have a Front
covernote configured.

Table 46: General front covernote options

3. From the Rendering tab set the covernote margins (in Inches).

4. Click OK.

Adding new Front covernotes

Step 1: Create Front covernote

You can create custom Front covernotes in HTML, RTF or MHT format, using custom designs, text and fields. Use your
preferred editor to create the page.

NOTE
1. You can use fields to display useful information. Formore information, refer to Supported merge-fields (page
122).
2. Use UTF-8 encoding for HTML Front covernotes.

Step 2: Add covernote to GFI FaxMaker

1. FromGFI FaxMaker Configuration navigate to Coverpages> Front covernotes.

Screenshot 78: Creating a new front covernote

2. Click New….

3. Key in a Displayname for the covernote.

4. Click Add from file…, browse to the newly created coverpage and click Open.

5. Click OK.

6. Add any particular users to apply this covernote for.

7. Click OK.

Default Front covernote

The default Front covernote is the covernote applied for all users that have no other covernote configured. To select a
different default covernote:
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1. FromGFI FaxMaker Configuration navigate to Coverpages> Front covernotes.

2. Right-click the covernote and select Set asdefault global front covernote.

Using a custom Front covernote for a list of users

GFI FaxMaker can use different Front covernotes for different users or user groups. To apply a custom front covernote for
a particular user or user group:

1. FromGFI FaxMaker Configuration navigate to Coverpages> Front covernote.

2. Right-click the covernote to associate custom user for and select Properties.

Screenshot 79: Front covernote users

3. From the Users tab add the users to apply the covernote for.

4. Click OK.

8.7 Call blocking
Call blocking enables you to control the fax numbers to which users can send faxes. GFI FaxMaker checks the call block
rules before fax transmission to block faxes sent to numbers starting with matching entries.

For example, to block specific users from sending faxes to international numbers, add a call blocking rule to your
international dial prefix (example, 00 or 011).
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Screenshot 80: Call blocking rules

1. FromGFI FaxMaker Configuration, navigate to Advanced > Call blocking node.

2. Click New….

Screenshot 81: New call block entry

3. Key in the number to block and click OK.

4. Assign users to the configured Call block or leave empty to apply the rule to every user.

5. Click OK.

8.8 Public contacts
Configure Public Contacts to enable GFI FaxMaker to retrieve user information when users send faxes using the email
client.

8.8.1 Important notes
1. Public Contacts do not have to be configured if:
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users are not using the email client to send faxes (for example when using the GFI FaxMaker Fax Message form only),
or

not showing user information on cover pages.

2. In a Microsoft® Exchange Server environment, MAPIClient and Collaboration Data Objects1.2.1 is required when
using Public Contacts. Install on GFI FaxMaker server, when:

not installing GFI FaxMaker on the Microsoft® Exchange server machine

installing on Microsoft® Exchange Server 2007/2010/2013

Download from: http://go.gfi.com/?pageid=FM_MAPICDO

3. When using Microsoft® Exchange 2013 as your mail server,further configurations are required due to certain
compatibility issues between Microsoft® Exchange 2013, and MAPI/CDO. Formore information, refer to Using Public
Contacts with Microsoft® Exchange 2013 (page 129).

8.8.2 Configuring Public Contacts
1. Ensure that you have a working profile, configured as the default profile, to connect to your Exchange Server.

2. FromGFI FaxMaker Configuration, right-click Advanced > Public Contactsand select Properties.

Screenshot 82: Public contacts node

3. Select Enable Exchange Public Contacts retrieval.

4. Click Add and select the public contacts list fromwhere to retrieve company information.

5. Click Test to ensure that GFI FaxMaker can query the listed public contacts folders.

6. Click OK.

http://go.gfi.com/?pageid=FM_MAPICDO
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8.8.3 Using Public Contacts with Microsoft® Exchange 2013
This topic describes how to enable Public Contacts in an environment running Microsoft® Exchange 2013 as the mail
server.

Step 1: Install MAPI/CDO

Install MAPIClient and Collaboration Data Objects1.2.1on the GFI FaxMaker server. Download from:
http://go.gfi.com/?pageid=FM_MAPICDO.

Step 2:Modify registry key

IMPORTANT
1. Apply these changes to the user profile used by GFI FaxMaker. Ensure that you are logged in toWindows with the
same user credentials used by GFI FaxMaker.

2. This process requires changes in the Windows Registry. It is important to follow these steps with attention as
incorrect configuration can cause serious, system-wide problems.

1. Go to Start > Run and key in regedit.

2. Locate the following key:

HKEY_CURRENT_USER\Software\Microsoft\WindowsNT\CurrentVersion\WindowsMessaging Subsystem

3. Right-click WindowsMessaging Subsystem node and click New > String Value.

4. Key in RPCHTTPProxyMap_GFIFaxMakerand press Enter.

5. Right-click the newly added key and click Modify.

6. Key in the domain mappings in the following format:

<domain>=<ProxyServer>,ntlm,ntlm,false

Where:

Property Description

<domain> Replace with your domain name

<ProxyServer> The FQDN of the RPC/HTTP endpoint (mail server) that should be used for the domains provided.

For example:

mydomain.com=https://mail.mydomain.com,ntlm,ntlm,false

Click OK.

7. Close registry.

Step 3:Configure MAPI Server in GFI FaxMakerPublic Contacts

1. FromGFI FaxMaker Configuration, right-click Advanced > Public Contactsand select Properties.

2. Select Enable Exchange Public Contacts retrieval.

3. Click Add.

4. For the first time only, the MAPI client requires the details of the Microsoft Exchange server. If a MAPI profile is already
configured, skip to step 9, else continue with the next step.

5. Select the Microsoft Exchange instance to use and click Next.

6. In Microsoft Exchange server, key in the personalized name of the RPC endpoint. To find this, from amachine on the
network that runs Microsoft Outlook 2007/2010/2013, press Ctrl + Right-clickon the Microsoft Outlook icon in the

http://go.gfi.com/?pageid=FM_MAPICDO
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system tray. Click Test E-mail AutoConfiguration.... Click Test. The personalized name of the RPC endpoint is the value
of Server in the Resultsview.

7. In Mailbox, key in the name of the mailbox that has access to the network public contacts and click Next.

8. Complete the wizard steps.

9. Select the public contacts list fromwhere to retrieve company information and click OK.

10. Click Test to ensure that GFI FaxMaker can query the listed public contacts folders.

11. Click OK.

8.9 NetPrintQueue2FAX
NetPrintQueue2FAX is a printer driver installed on user machines. This enables users to print content to transmit by fax,
directly from any application that supports printing.

For more information about which file types can be used with NetPrintQueue2FAX refer to
http://go.gfi.com/?pageid=FM_NPQ2FFileFormats

How it works

1. Users prepare content to fax using a third-party application (for example, Microsoft® Word® or an invoicing software).
The fax recipient details - number, name and company - must be embedded in the content.

2. Users print content to the NetPrintQueue2FAX printer driver. Ensure that the NetPrintQueue2FAX printer drivers are
installed on user machines. Formore information, refer to Installing NetPrintQueue2FAX printer driver on clients’
machines (page 132).

3. NetPrintQueue2FAX sends content to GFI FaxMaker.

4. GFI FaxMaker analyzes the content to determine fax recipient details. Formore information, refer to Configuring
NetPrintQueue2FAX options (page 131).

5. GFI FaxMaker sends fax.

HINT
You can use this method to automatically send a custom fax to a number of recipients. For example, through
Microsoft® Word® Mail Merge feature you can send a personalized fax to a large number of recipients. Formore
information, refer to Sending faxes using Microsoft Word Mail Merge (page 134).

http://go.gfi.com/?pageid=FM_NPQ2FFileFormats
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Screenshot 83: A document ready to be printed to NetPrintQueue2FAX

8.9.1 Configuring NetPrintQueue2FAX options
GFI FaxMaker needs to be configured to determine the identifiers for recipient details. For example, configure GFI
FaxMaker so that the text following the string Fax: is the recipient’s fax number.

To configure recipient identifiers:

1. FromGFI FaxMaker Configuration, right-click NetPrintQueue2FAX and select Properties.
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Screenshot 84: NetPrintQueue2FAX configuration

2. Configure the following options:

Option Description

Enable
NetPrintQueue2FAX

Enable/Disable NetPrintQueue2FAX feature

Recipient Key in the text that identifies recipient’s name. Default value is To:.

Company Key in the text that identifies recipient’s company name. Default value is Company:.

Fax number Key in the text that identifies recipient’s fax number. Default value is Fax:.

End of field
terminator

After GFI FaxMaker finds a search field and retrieves the string that comes after the search string, it needs to
identify the end of the search string. To do this, either do not put more text following that line or use a special
character to determine the end of the field. To use a field terminator, select this option and key in a terminator.

Case sensitive search Use this option to choose whether to match the case of field identifiers.

Table 47: NetPrintQueue2FAX configuration options

3. Click OK.

NOTE
If GFI FaxMaker fails to find the search fields in the document, the fax is not sent and GFI FaxMaker sends an error
report to the user.

8.9.2 Installing NetPrintQueue2FAX printer driver on clients’ machines
Install the printer driver on the client’s machines to enable users to use NetPrintQueue2FAX feature.
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NOTE

1. This procedure is the same as adding any other Windows® network printer driver.

2. When GFI FaxMaker is installed on Windows Server® 2003 64-bit, the Windows Server® 2003 32-bit installation
disc is required during the installation of NetPrintQueue2Fax printer driver on 32-bit client machines.

Select client’s operating system for information how to install NetPrintQueue2FAX printer driver:

Windows® Vista®/7

Windows® XP

Windows® 2000/2003

Windows® Vista®/7/8

1. From Control Panel select Hardware and Sound > Devicesand Printers> Add Printer> Add a network, wirelessor
Bluetooth printerand click Next.

2. Select NetPrintQueue2Fax printer from the list of found printers, or click The printer that Iwant isn’t listed tomanually
type the path of NetPrintQueue2Fax using the format \\FaxServerName\NetPrintQueue2Fax.

NOTE
If GFI FaxMaker is installed on a 64-bit machine, the driver needs to be located manually:

a. Click OK in the No driver found dialog to locate the driver manually.

b. Browse to the GFI FaxMaker server and open shared folder NetPrintQueue2Fax_Drivers.
c. Select npqf.inf and click Open to install the driver.

d. Windows® will verify the publisher of the driver software. Click Install thisdriversoftware anyway to proceed.

3. Click Finish to add the NetPrintQueue2Fax printer to the list of printers.

Windows® XP

1. On the client machine, select Start > Printersand Faxes> Add a Printerand click Next.

2. Select A networkprinter… and click Next.

3. Select Find a printer in the directory to select NetPrintQueue2Faxprinter from the Find Printersdialog.

4. If NetPrintQueue2Fax is not automatically found, close Find Printersdialog, select Connect to thisprinterand type the
path of NetPrintQueue2Fax using the format \\FaxServerName\NetPrintQueue2Fax. Click Next to
continue.

NOTE
If GFI FaxMaker is installed on a 64-bit machine, the driver needs to be located manually:

a. In Connect to a Printerdialog click OK to locate the driver manually.

b. Windows® will verify the compatibility of the printer with Windows® XP. Click Continue anyway to proceed.

c. In Insert Diskdialog click OK to browse for the printer driver.

d. Browse to the GFI FaxMaker server and open shared folder NetPrintQueue2Fax_Drivers.
e. Select npqf.inf and click Open to install the driver.

5. Click Finish to add the NetPrintQueue2Fax printer to the list of printers.
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Windows® 2000/2003

1. On the client machine, from Control Panel select Printers> Add Printer> Networkprinterand click Next.

2. Select Type the printername… and either:

type the printer path using the format \\FaxServerName\NetPrintQueue2Fax, or

click Next to browse for shared printers on the network and select NetPrintQueue2Fax from the fax mail server.

3. Click Next to add the NetPrintQueue2Fax printer to the list of printers.

8.9.3 Sending faxes using Microsoft Word Mail Merge
NetPrintQueue2Fax can be used to send out fax broadcasts fromMicrosoft Word, using the Mail Merge feature.

Mail Merge is a feature in Microsoft Word that enables users to author one template that can be used to produce
customized and personalized documents. A template contains fields that are then automatically filled in from a data
source.

Step 1: Creating the mailmerge

1. Create a new document.

2. From the Mail Merge feature settings, add the fax recipients list. Key in the list or import the recipients from a data
source such as a Microsoft Excel spreadsheet or a Microsoft Access database. This is a sample table containing the recip
ient information:

Fax Number Name Company
+420313414515 Joe ABC Inc.
+441273123456 John DEF Ltd.
+420313414517 Steve GHI Inc.
+441273123458 Bob JKL Ltd.
+420313414519 Kevin MNO Inc.

3. At the beginning of the document, specify the recipient fields required by GFI FaxMaker to resolve the recipient. Key
in the fields as specified in the NetPrintQueue2Fax configuration screen. For example, create a table in the document
to show the recipient information as follows:

To: Company: Fax:

4. Next to each label, insert the applicable Merge field.

To: <<Name>> Company: <<Company>> Fax: <<Fax_Number>>

5. Type or add any text and graphics to include in your fax. Youmay insert more merge fields in the content.

6. In a new line at the end of the document, add the characters @#. These 2 characters are referred to as the fax sep
arator characters, and are required to indicate to GFI FaxMaker that the next page is a new fax.

Step 2: Preview the fax

In Microsoft Word choose to preview the results. When this option is switched on, the merge fields in the document are
populated with real data from your data source. Toggle through each record and verify that the fields are properly
populated.

Step 3: Send the fax

When you are sure that the fax broadcast is ready to be sent, choose to finish and print the merged documents. Select
the NetPrintQueue2Faxprinter driver and click Print.

NetPrintQueue2Fax submits the print job to GFI FaxMaker, which in turn prepares the documents for transmission. Track
the status of the submitted faxes from the GFI FaxMaker Monitor and from email notifications.
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8.9.4 Using Text API commands in NetPrintQueue2Fax
In addition to embedding recipient information in the document, further commands can be embedded at the top of a
document to be sent using NetPrintQueue2Fax. Amongst others, this enables scheduling a fax and specifying fax
resolution.

To do this, enter commands at the top of the document, for example
::priority=high,billingcode=1234

GFI FaxMaker automatically removes these commands on detection.

For more information regarding the Text API commands refer to the GFI FaxMaker API manual available from:
http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=APImanual.

8.10 GFI FaxMaker APIs
With APIs you can integrate your third party software with GFI FaxMaker.

This process automation can be used for a wide variety of industries and applications, such as healthcare, retail and
banking.

For example, use XMLAPI with your invoicing software to create an XML report template for account statements and
balances. Periodically, generate this report for each client that owes money and store it to the XMLAPI pickup folder. GFI
FaxMaker automatically transmits the statements to their intended recipients.

Types of APIs available in GFI FaxMaker:

XMLAPI Send faxes or SMS using XML files. You can configure third party software to generate APIs automatically and transmit faxes
in bulk. GFI FaxMakerpicks up and transmits all xml files stored in a custom XMLAPI pickup folder.
XMLAPIs must be formatted to a standard convention, using fields and parameters which GFI FaxMaker can use to process
faxes and SMS. For more information refer to the GFI FaxMaker API Manual.

TextAPI Send faxes using plain text files. You can configure third party software to generate APIs automatically and transmit faxes in
bulk. GFI FaxMakerpicks up and transmits all text files stored in a custom TextAPI pickup folder.
TextAPIs must be formatted to a standard convention, using fields and parameters which GFI FaxMaker can use to process
faxes and SMS. For more information refer to the GFI FaxMaker API Manual.

Web
Service
API

The GFI FaxMaker Web Service API enables you to develop your own applications that can connect with GFI FaxMaker. You
can then send and receive faxes directly from your application. For more information refer to the GFI FaxMaker API Manual.

8.10.1 Enabling TextAPI
To enable and configure TextAPI:

1. FromGFI FaxMaker Configuration, right-click Advanced > Text-API/XMLAPInode and select Properties.

http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=APImanual
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Screenshot 85: Enabling TextAPI

2. From TextAPI tab, configure the following options:

Option Description

Enabled Enables TextAPI.

Folders to
scan

Specify the folders where Text APIs will be stored for GFI FaxMaker to process. Click Add to select folders. To run
recursive TextAPIs scanning on sub-folders, select Include Subfolders.

Store all
response files
in one folder

After processing a TextAPI which does not have the FROM parameter specified, GFI FaxMaker creates a response file.
By default, GFI FaxMaker stores response files in the pickup folders. To store all response files in one location, select
this option and specify a location.

Format text
using
coverpage

Select the coverpage to use for TextAPI faxes. For more information, refer to Coverpages (page 118).

Table 48: TextAPI options

3. Click OK.

Next step: Start creating XML APIs. For more information refer to the GFI FaxMaker API Manual.

8.10.2 Enabling XMLAPI
To enable and configure XMLAPI:

1. FromGFI FaxMaker Configuration, right-click Advanced > Text-API/XMLAPInode and select Properties.
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Screenshot 86: Enabling XMLAPI

2. From XMLAPI tab, click Add to select the folders where XMLAPIs will be stored. To also check sub-folders for XMLAPIs,
select Include Subfolders.

3. After processing an XMLAPI, GFI FaxMaker creates a response file (*.status extension). By default, GFI FaxMaker stores
response files in the pickup folders. To store all response files in one location, select Store all response files in one folder
and specify a location.

3. Click OK.

Next step: Start creating XML APIs. For more information refer to the GFI FaxMaker API Manual.

8.11 Billing
GFI FaxMaker enables you to enforce the use of billing codes when sending faxes. Users or groups of users use a
particular billing code to send faxes. This allows the administrator tomonitor fax usage by codes.

To use billing codes, when sending faxes, users add the following API command to the fax:

::b=<billing number> or ::billingcode=<billing number>

Replace <billing number> with the billing number assigned to the user. For example:

::b=22343

NOTE
1. Faxes without billing codes are not sent if billing codes are enabled.

2. Billing codes can also be included in the email subject. In this case, key in the command enclosed in square
brackets. For example,[::b=123456].

To enforce use of billing codes:
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1. FromGFI FaxMaker Configuration, right-click Billing and select Properties.

Screenshot 87: Enforcing billing options

2. Select Everyfaxsent must include a billing code.

3. Click OK.

8.12Multi-function peripherals
GFI FaxMaker enables sending faxes using network-connected multi-function peripherals - MFPs. This feature works with
MFPs that are managed using Nuance eCopy ShareScan.

8.12.1 How it works
1. Install and configure the GFI FaxMaker connector on the Nuance eCopy ShareScan server. Download the connector
from http://go.gfi.com/?pageid=FM_ShareScanConnector.

2. MFPs managed by Nuance eCopy ShareScan will now display the GFI FaxMaker connector interface, enabling users to
scan paper using MFPs and faxing them through GFI FaxMaker.

NOTE
This documentation includes information on how to configure the GFI FaxMaker connector only. It is assumed that
Nuance eCopy ShareScan is operational and configured properly for your environment. For more information refer
to the Nuance eCopy ShareScan documentation.

Go to:

http://go.gfi.com/?pageid=FM_ShareScanConnector
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Installing the GFI FaxMaker Nuance eCopy ShareScan Connector

Configuring the GFI FaxMaker Nuance eCopy ShareScan Connector

Sending faxes using the GFI FaxMaker Nuance eCopy ShareScan Connector

8.12.2 Configuring the GFI FaxMaker Nuance eCopy ShareScan Connector
After installation, configure the GFI FaxMaker connector:

1. Open the Nuance eCopy ShareScan Administration Console.

2. Go to Advanced tab, click Connectorsand select GFI FaxMaker from the Configure Connectors side pane.

Screenshot 88: GFI FaxMaker connector settings

3. In the Configure Connector (GFI FaxMaker) pane, click Edit to open the Settingsdialog.
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Screenshot 89: GFI FaxMaker Nuance eCopy ShareScan connector SMTP settings

4. From the SMTP tab, configure the following options:

Option Description

Server Key in the name or IP address of the GFI FaxMaker server.

Port Specify the SMTP port to use when communicating with GFI FaxMaker. Default SMTP port is 25.

Use SSL Select this option to use SSL.

Account & Pass
word

Specify credentials with permission to access the GFI FaxMaker machine.

Test Click to test the connection with the GFI FaxMaker machine, using the credentials specified. Ensure that the tests
succeeds. If the test fails, check keyed in details and troubleshoot network connection.

Default Email
address

Specify the default email address to use for fax transmission from Nuance eCopy ShareScan. Unless users specify a
different email address, this address is used for all communications from GFI FaxMaker, such as fax transmission
reports.

Enable users to
configure email
address

Select whether MFP users can customize the fax sender's email address from the MFP screen when sending faxes.
This allows users to receive notifications directly from GFI FaxMaker, such as fax transmission reports.

Table 49: GFI FaxMaker connector configuration

5. From the Format tab, configure the following options:

Option Description

Default Res
olution

Configure the default resolution when sending faxes over MFPs.

Table 50: GFI FaxMaker connector configuration
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Option Description

Default Pri
ority

Configure the default priority when sending faxes over MFPs.

Default Billing
Code

Specify the default Billing Code to use when sending faxes over MFPs. Leave field empty to not use a Billing code.

Send Cover
Page

Enable this option to include a cover page with the fax. For more information, refer to Coverpages (page 118).

Default Cover
Page

By default, GFI FaxMaker includes the default cover page as configured in the GFI FaxMaker Configuration console.
Leave this field empty to use the default cover page.
To use a different cover page when sending emails via Nuance eCopy ShareScan, specify the cover page name as
configured in GFI FaxMaker.

Manage Cover
Note...

To include a cover note with all faxes sent from MFPs, click this button and type the default cover note subject and
message here. Click OKwhen done.

6. From the AddressBook tab, configure the following options:

Option Description

New Click to add new recipients in the address book. Users can see all recipients that are added here directly
from the MFP.

Edit Select a recipient and click Edit to modify the recipient's information.

Delete Select a recipient and click Delete to remove the recipient from the Address Book. Deleted recipients are
not recoverable.

Enable Active Directory
recipients lookup

Enable this option to retrieve the list of addresses from Active Directory. This option requires that the
Nuance eCopy ShareScan machine communicates with the Active Directory server.

Table 51: GFI FaxMaker connector configuration

7. Click OK to save changes.

8. In the Settingspane, configure the following settings:

Category Option Description

Display Label Specify the GFI FaxMaker connector name that will be shown on the MFP. Default value is GFI FaxMaker.

Image Select the connector image to be shown on MFPs. Image size cannot exceed 48*48 pixels.

Description Specify a custom connector description that will be shown to the client. Note that the description cannot
exceed 255 characters. To enter a new line character, press Ctrl+Enter.

File
Format

File Format
Option

Specify the file format to use for sending the scanned document to GFI FaxMaker.

User
Modify

Select this option to allow users to modify the file format directly from the MFP.

Table 52: GFI FaxMaker connector configuration

NOTE
Other options can be configured from the Settingspane which are standard for all connectors. For more
information how to configure these options, refer to the Nuance eCopy ShareScan documentation.

9. Save settings.

8.12.3 Installing the GFI FaxMakerNuance eCopy ShareScan Connector

NOTE
During installation, some Nuance eCopy ShareScan services may be stopped by the installer.
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1. Close Nuance eCopy ShareScan Administration Console.

2. Download the GFI FaxMaker Nuance eCopy ShareScan Connector setup file from http://go.gfi.com/?pageid=FM_
ShareScanConnector.

3. Run the setup file on the Nuance eCopy ShareScan server and click Install.

4. Click Finish.

8.12.4 Sending faxes using the GFI FaxMaker Nuance eCopy ShareScan Connector
To send a fax from an MFP using the GFI FaxMakerNuance eCopy ShareScan Connector:

1. Place document to fax in the MFP feeder and select GFI FaxMaker.

2. When the document is scanned, click Next.

Screenshot 90: Nuance eCopy ShareScan Connector fax details

3. Key in the following details:

Option Description

Report
Email

Key in your email address. This email address is used to send transmission reports and also when routing incoming faxes.

Recipient
(s)

Key in the fax number of the recipient or click icon to select recipient from the address book. Separate multiple recipients
using semi-colons (;).

Subject Key in the subject of the fax.

Cover
note

Key in a fax message that will be included in the fax cover page.

Table 53: Nuance eCopy ShareScan Connector fax details

http://go.gfi.com/?pageid=FM_ShareScanConnector
http://go.gfi.com/?pageid=FM_ShareScanConnector
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Option Description

Format
Fax

Click icon to configure other optional settings:
Resolution - specify the resolution to use during fax transmission
Priority - select the priority to use when sending the fax.
Billing Code - key in your billing code.
Cover page - key in the name of the cover page template to use.
Scheduled time - specify the time when to send a fax. Time must be in the following format hh:mm. Optionally you

can also specify the seconds as follows hh:mm:ss.
Scheduled date - specify or select a date when to send a fax. Date must be in the following format mm/dd/yyyy.

4. Click Send to send details to GFI FaxMaker for fax transmission.
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9 Configuration - Receiving faxes
This topic contains information about:

9.1 Receiving Options 144

9.2 Fax routing 145

9.3 Printers 157

9.4 Junk Fax filter 159

9.1 Receiving Options
To configure fax receiving options:

1. FromGFI FaxMaker Configuration, right-click Sending/Receiving Optionsand select Properties.

Screenshot 91: Receiving options

2. From the Receiving tab, configure the following options:
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Option Description

Cut long pages to standard page size If a received page is longer than 1.5 times the selected page size, page is cut to the selected
size.

Paper size threshold Select the paper size for the received faxes. Incoming faxes more than 1.5 times the paper
size, are automatically cut to the selected size.

Route incoming faxes in the following
attachment format

Select the format in which received fax files are stored and forwarded to recipients.

Table 54: General receiving options

3. Click OK.

9.2 Fax routing
Fax routing enables GFI FaxMaker to determine the correct recipient of an incoming fax. When a fax is received, GFI
FaxMaker routes the fax to it's intended recipient.

GFI FaxMaker provides several methods for this, each with its advantages and disadvantages. Typically, DID routing is
recommended for larger installations, while MSN and Line routing are recommended for smaller installations.

Select the type of routing to use:

Routing method Description

DID/DTMF Routing
(ISDN/Analog/Digital)

Through DID routing, the telecommunications provider assigns you a range of virtual numbers that enable
individual users/printers/public folders to have their own fax numbers, without the need of a physical fax line
for each.
For more information, refer to DID/DTMF Routing (ISDN/Analog/Digital) (page 145).

MSN Routing
(ISDN only)

Route received faxes based on the line MSN number.
For more information, refer to MSN routing (page 147).

OCR Routing Route incoming faxes depending on the fax’s text content. Fax pages are converted to text using OCR
technology and text is searched for the user's first and last name and/or other configurable text phrases.
For more information, refer to OCR routing (page 147).

Line Routing Route faxes based on the fax line that the fax was received on.
For more information, refer to Line routing (page 149).

CSID Routing Caller Sender Identification routing uses the sender’s fax machine ID to route faxes to particular users.
For more information, refer to CSID routing (page 149).

Table 55: Fax routing methods

9.2.1 DID/DTMF Routing (ISDN/Analog/Digital)
Through DID routing, the telecommunications provider assigns you a range of virtual numbers that enable individual
users/printers/public folders to have their own fax numbers, without the need of a physical fax line for each. If you
already have ISDN you can use available lines from your PBX. On answering the fax call, the ISDN protocol passes the
number on which the call is being answered to GFI FaxMaker.

Pre-requisites

Configure the number of DID/DTMF digits to capture from the GFI FaxMaker device settings. FromGFI FaxMaker
Lines/Devicesnode, open the properties of the DID/DTMF device. Navigate to the Advanced tab and configure the
Numberof DTMF/DIDdigits to capture.

Adding DID/DTMF routes one-by-one

1. FromGFI FaxMaker Configuration, right-click Routing > DTMF/DID and select New….
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Screenshot 92: Creating a new DID route

2. Configure the following options:

Option Description

DTMF/DID numbers/ranges Key in the users’ routing number (or virtual fax number).
For example, for a 4 digit DID, enter the last 4 numbers.

Set number of DTMF/DID digits to Select this option to set the minimum number of digits for each number.
For example, if this value is 4 digits, number 1 is noted as 0001.

Table 56: DTMF/DID routing options

3. Click OKand repeat for all DTMF/DID numbers/ranges.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

Importing a range of DID routes

GFI FaxMaker can import a large number of DTMF/DID numbers and associated users from a CSV or TXT file in the
following format:

"DTMF/DID number", "user1", "user2", "user3", …

For example:"1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

NOTE
Specify the user name as either the Active Directory display name or the SMTP email address. Ensure that all user
names specified are included in the Licensed Users list.

To import a list of DID numbers:

1. FromGFI FaxMaker Configuration, right-click Routing > DTMF/DID and select Import DTMF/DIDrange.

2. Select the CSV or TXT file containing the data to be imported.

3. Click Open.

Exporting a range of DID routes

To export the list of DID numbers and associated user names in CSV format:
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1. FromGFI FaxMaker Configuration, right-click Routing > DTMF/DID and select Export DTMF/DIDrange.

2. Select the location where to export the list and specify a file name.

3. Click Save.

The list is exported in the following format:

"DTMF/DID number", "user1", "user2", "user3", …

For example:"1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

9.2.2 MSN routing
While similar to DID routing this method uses the available Multiple Subscriber Numbering (MSN) numbers instead of
dedicated DID numbers (ISDN only). Each ISDN line has 1 or more MSN numbers (usually 9) assigned to it. If your ISDN
line has 9 MSN numbers, you can have 9 different routes for a fax.

Pre-requisites

Before adding MSN routes, enter the MSN numbers in the ISDN card Device options. FromGFI FaxMaker Lines/Devices
node, open the properties of the DID/DTMF device. Navigate to the Device tab and enter all the MSN numbers to
answer.

Adding MSN routes

1. FromGFI FaxMaker Configuration, right-click Routing > MSN and select New….

Screenshot 93: Creating a new MSN route

2. Key in an MSNnumber for which to customize routing options.

3. Click OKand repeat for all MSN numbers.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

9.2.3 OCR routing
Optical Character Recognition (OCR) converts received faxes to text and routes faxes to:

Users assigned a custom set of phrases (OCR route). When a custom phrase is matched, GFI FaxMaker routes the fax to
its configured set of users. For example, route faxes containing text “Attention: Sales” to the sales department.

Text matching user names within the Licensed users list. For example, GFI FaxMaker forwards a fax containing text
“John Smith” to licensed user John Smith.
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NOTE
Formore information, refer to OCR (page 97).

OCR routing properties

Configure OCR settings to use while processing faxes for routing.

1. FromGFI FaxMaker Configuration, right-click Routing > OCRand select Properties.

Screenshot 94: OCR routing properties

2. Configure the following options:

Option Description

Matching ratio
percentage

The matching ratio is the confidence that GFI FaxMaker needs to have before matching a keyword or name to
a routing rule.
NOTE: The recommended matching ratio is between 60% and 80% since this is dependent on the fax quality.
Poor quality faxes cause OCR to not recognize all the letters and may result in faxes routed to the wrong users.

Route faxes using the
users’ first and last
names

Automatically routes faxes to users if OCR matches a name with the list of Licensed users.
NOTE: When both a user name and a custom search phrase (OCR route) are found, the custom search phrase
routing overrides the matching user routing.

Table 57: OCR routing options

4. Click OK.

Adding an OCR route

1. FromGFI FaxMaker Configuration, right-click Routing > OCRand select New….
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Screenshot 95: New search phrase - Creating a new OCR search phrase

2. Key in a phrase to search for.

3. Click OKand repeat for all OCR phrases.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

9.2.4 Line routing

Line routing enables fax routing based on the fax line (Lines/Devicesnode) that the fax was received.

Adding a line route

1. FromGFI FaxMaker Configuration, right-click Routing > Line and select New….

Screenshot 96: Creating a new Line route

2. Select a fax line.

3. Click OKand repeat for all fax lines.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

9.2.5 CSID routing
Call Subscriber Identification (CSID) routing routes faxes based on the FAX ID of the sender (the number that the
sender’s FAX machine/FAX card displays when sending a fax).



GFI FaxMaker 9 Configuration - Receiving faxes |150

NOTE
This method is not recommended since fax senders may hide the CSID.

Adding CSID routes

1. FromGFI FaxMaker Configuration, right-click Routing > CSID, and select New….

Screenshot 97: Creating a new CSID route

2. Key in the CSID.

3. Click OKand repeat for all CSID numbers.

For each rule created, configure how to process the received faxes:

Routing rule recipients

Automatically print incoming faxes

Backing up received faxes

Excluding routing rule from archiving

Importing a range of CSID routes

GFI FaxMaker can import a high number of CSID numbers and associated users from a CSV or TXT file in the following
format:

"CSID", "user1", "user2", "user3", …

For example:"1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

NOTE
Specify the user name as either the Active Directory display name or the SMTP email address. Ensure that all user
names specified are included in the Licensed Users list.

To import a list of CSID routes:

1. FromGFI FaxMaker Configuration, right-click Routing > CSID and select Import CSID….

2. Select the CSV or TXT file containing data to import.

3. Click Open.

Exporting a range of CSID routes

To export the list of CSID numbers and associated user names in CSV format:

1. FromGFI FaxMaker Configuration, right-click Routing > CSID and select Export CSID….

2. Select the location where to export the list and specify a file name.

3. Click Save.



GFI FaxMaker 9 Configuration - Receiving faxes |151

The list is exported in the following format:

"CSID", "user1", "user2", "user3", …

For example:"1234", "John Doe", "Bill Smith", "Roger Brown", "Joe Bloggs"

9.2.6 Received fax recipients
Routing rule transmission reports are sent by GFI FaxMaker to users configured to receive faxes that match a particular
routing rule. Transmission reports provide users with the received fax data, using one of the following methods:

Fax attached to transmission report

Link to the fax stored in a network share. Formore information, refer to Store incoming faxes to a network share
(page 154).

For each routing rule created, configure the list of users and the method to deliver the fax data:

Screenshot 98: Users to route incoming faxes to

1. From the routing rule properties Users tab, select one of the following options:

Option Description

Do not send transmission
report

A transmission report is not sent to users.

Send transmission report
with the fax attached

A transmission report is emailed to the list of users, with the fax attached to the report.

Table 58: Routing rules user options
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Option Description

Save fax and send
transmission report with
link to fax

A transmission report is emailed to the list of users, containing a link of the fax stored on a network
share. For more information, refer to Store incoming faxes to a network share (page 154).

2. If enabling transmission reports, click Add to specify the list of users to whom to send the transmission report.

3. Click Apply.

9.2.7 Automatically print incoming faxes

Faxes received on particular routing rules can be automatically printed on receipt.

NOTE
Configure printers before using this option. Formore information, refer to Printers (page 157).

Screenshot 99: Automatically print fax

1. From the routing rule properties dialog, select the Printers tab.

2. Select Enable faxauto-printing.

3. From the Select printer list, select the printer.

4. Click Apply.
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9.2.8 Backing up received faxes

Faxes received on particular routing rules can be backed up to a folder.

NOTE
1. The file name of each fax backed up contains the fax delivery time-stamp.

2. GFI FaxMaker does not create duplicates for faxes that match two or more routing rules and that have the same
Backup2Folder destination.

3. This feature requires that the target folder can handle 'long file names'. Hard-disk partition formats that handle
long file names include NTFS and FAT32.

Screenshot 100: Automatically backup faxes

1. From the routing rule properties dialog, select the Backup2Folder tab.

2. Select Automaticallybackup faxes to folderand specify where to backup faxes.

3. Select Backup faxes in this format and select the format in which to store faxes.

4. Click Apply.

9.2.9 Modifying routing rule name/number
To change a CSID, DID/DTMF or OCR route name or number:

1. From the routing rule properties dialog, select the Options tab.

2. Change the name or number of the routing rule.
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3. Click Apply.

9.2.10 Received faxes that match no routing rule
When a fax matches no routing rule, it is routed to the list of Default Routers.

To configure Default Routers:

1. FromGFI FaxMaker Configuration, right-click Routing, and select Properties.

Screenshot 101: Default fax routers

2. Select the Default Routers tab.

3. Click Add and specify the user/mailbox where to deliver faxes not routed.

4. Click OK.

9.2.11 Store incoming faxes to a networkshare
Received faxes can be stored in a shared folder. An email with a link to the saved fax is sent to the configured routers.

When receiving a fax on a routing rule that uses this option, GFI FaxMaker creates a sub-folder in the share as follows:

<networkshare path configured>\yyyy_mm\dd\

Where:

<networkshare path configured> - the shared folder where received faxes are stored

yyyy - year
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mm - month

dd - day

Step 1: Create network share

Create a shared folder with:

Full access to the GFI FaxMaker account (user credentials specified during installation) in order to be able to save
faxes.

Read permissions to all users that will be accessing faxes on this share.

NOTE
For security reasons, only fax recipients can access stored faxes. For example faxes routed to John Doe, are only
accessible by John Doe.

Step 2: Configure GFI FaxMaker

Specify the network share where routing rules with network sharing enabled store faxes.

1. In GFI FaxMaker Configuration, right-click Routing and select Properties.

Screenshot 102: Configuring the Network Share path

2. Select the NetworkShare tab.

3. Specify the network share path (for example,\\MyServer\MyFaxes).
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NOTE
Enter share in UNC format so that users can access it through the network.

4. Click Apply.

9.2.12 Users that receive all incoming faxes
Specify users that should receive all incoming faxes.

NOTE
Use this feature to store all incoming faxes to an exchange store or a public mailbox.

1. FromGFI FaxMaker Configuration, right-click Routing and select Properties.

Screenshot 103: Routing properties - users that receive all incoming faxes

2. Select the Receive all faxes tab.

3. Click Add and specify the user/mailbox that should receive all faxes.

4. Click OK.

9.2.13 Routing to a public folder in Microsoft® Exchange
GFI FaxMaker can route received faxes to a Microsoft® Exchange public folder so that these are accessible to everyone or
a particular group of users.

For example, route all faxes related to sales to a public folder dedicated to all sales communications and accessible by all
representatives.
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To do this:

1. Create amail-enabled public folder on your mail server.

NOTE
A dedicated user mailbox may need to be created and configured to forward all faxes to the mailbox.

2. Configure GFI FaxMaker routing options:

Fax routing to public
folder

Description

Faxes that match a
particular routing rule

Add the public folder mailbox (or the dedicated user mailbox) email address to the routing rules’ users lists.
For more information, refer to Transmission reports (page 112).

Route all received faxes
to public folder

Add the public folder mailbox (or the dedicated user mailbox) email address to the Receive all faxes list. For
more information, refer to Users that receive all incoming faxes (page 156).

Table 59: Fax routing to public folder

9.2.14 Excluding routing rules from archiving

You can exclude faxes received on particular routing rules from being archived.

1. From the routing rule properties dialog, select the Options tab.

2. Select Exclude thisnumber/phrase/line from all archiving options.

3. Click Apply.

NOTE
This setting overrides other fax archiving settings. Formore information, refer to Fax archiving (page 89).

9.3 Printers
To automatically print incoming faxes, first configure printers and print settings. Then configure routing options to print
to particular printers.

NOTE
Printers must be first added and pre-configured in the operating system’s printers list.

To add printers in GFI FaxMaker:

1. FromGFI FaxMaker Configuration, right-click Advanced > Printersand select New….

2. Key in a name for the printer.
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Screenshot 104: Configuring printers

2. From the General tab, specify how GFI FaxMaker should resize incoming faxes and the printers to use for each paper
size.

Option Description

Automatically fit to Select how to resize received faxes. Select from:
Nearest size - Resizes fax to the size nearest to the content

received.
A4 only - Resize to A4 paper size
Letter only - Resize to Letter paper size
Legal only - Resize to Legal paper size

A4 printer settings Click ... to select printer for A4 paper size.

Letter printer settings Click ... to select printer for Letter paper size.

Legal printer settings Click ... to select printer for Legal paper size.

Table 60: Printer properties

3. Click OK.

9.3.1 Auto-print options
GFI FaxMaker can be configured to never resize incoming faxes and to always print in the same size that a fax is received.

NOTE
If this option is enabled, faxes larger than the printer’s paper size will not fit and some areas may not be printed.

1. FromGFI FaxMaker Configuration, right-click Advanced > Miscellaneousand select Properties.

2. From the General tab, select Force 1:1printing.

3. Click OK.
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9.4 Junk Fax filter
GFI FaxMaker enables automatic deletion of faxes received from certain fax IDs.

Screenshot 105: The junk fax filter options

To block a fax ID:

1. FromGFI FaxMaker Configuration, right-click Advanced > JunkFaxfilterand select Properties.

2. Configure the following options:

Option Description

Delete faxes received from these FAX CSID’s Enables Junk Fax Filter. Add CSIDs of fax senders to block.

Delete faxes received from fax machines with
an empty CSID

Deletes faxes received from senders with no CSID.
NOTE: Use with caution since some senders can choose to hide CSID.

Keep a copy of junk faxes Store all junk faxes to a folder. Use this option to reviewed blocked faxes before
deletion (Recommended).

Table 61: Junk fax filter options

3. Click OK.
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10 SMS
GFI FaxMaker also features a complete SMS gateway that enables users to send SMS from their workstations.

10.1 How to send an SMS 160

10.2 Receiving SMS 162

10.3 SMS Requirements 162

10.4 Configure SMS settings 163

10.1 How to send an SMS

10.1.1 Method 1: Using Microsoft® Outlook®

To send an SMS fromMicrosoft® Outlook®, address an email to<number>@smsmaker.com. For example:
12345678@smsmaker.com

Key in the SMSmessage in the email body.

NOTES:

Remove email signature and any other not required content from the email body, as this will be included in the SMS
message.

The default fax (faxmaker.com) and SMS (smsmaker.com) domains can be customized by the GFI FaxMaker
administrator. Use the configured SMS domain accordingly.

This method is only applicable when routing emails via SMTP. This is not applicable when using the POP3 Down
loader to poll SMS from a POP3 Mailbox. Formore information, refer to Sending faxes/SMS via a POP3 Mailbox (page
85).
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Screenshot 106: Sending SMS from email client

10.1.2 Method 2: Using the GFI FaxMaker Client application
Use the GFI FaxMaker SMSMessage Form to send SMS.

GFI FaxMaker Client enables you to save the SMS number of users. When you select a recipient, GFI FaxMaker
automatically retrieves the mobile number of the contact.

For more information refer to the GFI FaxMaker Client Manual, available from:

http://support.gfi.com/manuals/en/faxmakerclient/Default.htm

Screenshot 107: Sending SMS from GFI FaxMaker Client

10.1.3 Method 3: XMLAPI
Use third-party tools to automatically generate XMLAPIs containing the information about the SMSs to send.

http://support.gfi.com/manuals/en/faxmakerclient/Default.htm
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Store XMLAPIs to a central location and GFI FaxMaker automatically processes files located in this folder.

A wide range of applications can be configured to automatically create such files and automating the SMS sending
process.

For more information refer to the GFI FaxMaker API manual available from:
http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=APImanual.

10.2 Receiving SMS
GFI FaxMaker routes incoming SMS directly to the user’s mailbox via email. The email contains details about the SMS
transmission and the SMSmessage.

Screenshot 108: Received SMS viewed in email client

Formore information, refer to Configure SMS settings (page 163).

10.3 SMS Requirements
Use one of the following types of SMS gateways:

GSMmodem

Web based SMS

10.3.1 GSM modem
Use a supported GSM modem connected to the GFI FaxMaker fax server machine.

For the latest list of supported mobile phones and GSM devices, refer to:

http://support.gfi.com/manuals/en/fax2014/default.htm#cshid=APImanual
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http://go.gfi.com/?pageid=FM_GSMDevices

NOTE
Using a GSM SMSmodem enables sending SMSwhen an internet connection is down. You can also receive
messages, which may not be possible using aWeb based SMS gateway.

10.3.2 Web based SMS
Use a customweb based service that allows sending SMSmessages via SMTP or subscribe to a supported web based
SMS provider:

Message Media - http://www.message-media.com/lp/gfi

Clickatell - http://www.clickatell.com

10.4 Configure SMS settings
Configure SMS options:

SMS gateway settings - select and configure the type of SMSmodem or device.

SMS options - various SMS options, such as maximum SMS length.

SMS Users - the list of users allowed to send SMS.

Routing received SMS - how GFI FaxMaker routes received SMS.

Archiving SMS - archive sent and received SMS to database.

SMS log files - SMS activity logs

10.4.1 SMS gateway settings
Configure the SMS gateway settings depending on the type of SMS gateway chosen.

GSMdevice

A custom Web based SMS provider

Clickatell web based service

Message Media SMS service

GSMdevice

Set up the SMS server to communicate directly with the GSM devices to send and receive SMSmessages.

NOTE
For the latest list of supported mobile phones and GSM devices, refer to:

http://go.gfi.com/?pageid=FM_GSMDevices

1. FromGFI FaxMaker Configuration, right-click SMS and select Properties.

2. In General tab, select Enable SMS Gateway.

http://go.gfi.com/?pageid=FM_GSMDevices
http://www.message-media.com/lp/gfi
http://www.clickatell.com/
http://go.gfi.com/?pageid=FM_GSMDevices
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Screenshot 109: Configuring the GFI SMS server

3. Select GFI SMS serverand configure:

Option Description

Automatic
Detection

Select this option to detect GSM devices connected to serial ports. In the GFI Device Detection dialog, click Start
Detection to automatically detect devices. Click OK.
If devices are not detected automatically, click Add Line to add device manually. Ensure that device drivers are
installed properly.

Add Line Click to manually add a line and configure its properties. Specify the following options:
Communication Port - Select the communications (COM) port that the GSM device is connected to. Click Val

idate to ensure that GFI FaxMaker finds and is able to communicate with the device.
Line name – Specify a friendly name for the new line.
Copy settings from installed device – Select this option to copy the settings of another device.

Edit Line Select a line to edit properties for and from the GSM Device tab, configure the following options:
COM Port - The communications (COM) port that the GSM device is connected to.
Baud Rate – Select the speed in bits-per-second (bps) at which PC and GSM device talk to each other. Check

with the device manufacturer for the best baud rate that the device can use.
Line name – (Optional) A friendly name for the line.
SMSC Number – (Optional) The Service Center Number given by the GSM network or SIM card provider.
Initialization String – (Optional) The initialization string used when initializing the GSM device. If empty, GFI

FaxMaker uses AT&F as the default initialization string.

From the Line Options tab, configure the following options:
Receive Incoming SMS – Select to allow SMS to be received on this line.
Send outgoing SMS – Select to allow SMS to be sent from this line.
Enable international numbers – Select this option to allow sending SMS from this line to international numbers.

Click OK.

Enable/Disable
Lines

From the SMS Properties dialog, select/unselect the checkbox next to the configured lines to enable/disable SMS
transmission over that line.

Table 62: SMS service properties
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Option Description

Delete Line Select a line to delete and click Delete Line. Click Yes to confirm deletion.
WARNING: Deleted lines are not recoverable. If in doubt, it is recommended to disable a line.

4. Click OK.

(Optional) To verify settings click Send test.... Key in a test recipient Number to send SMS to and customize the Text
message. Click Send to send the test message. Verify that the test SMS is received by the test recipient.

A customWeb based SMSprovider

Configure the following SMS gateway settings when using aWeb-based SMS service that allows SMS to be submitted via
SMTP:

1. FromGFI FaxMaker Configuration, right-click SMS and select Properties.

2. In General tab, select Enable SMS Gateway.

Screenshot 110: Configuring an SMS service provider

3. Select Generic SMS service provider template and configure the following settings:

Option Description

SMTP
server

Specify your own mail server or the mail server of the service provider.

SMTP
port

Specify SMTP port number.

From Specify your email address.

Table 63: SMS service properties
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Option Description

To Specify to which email address SMS are sent.
NOTE: If provider requires the SMS number to be inserted in the To address, use field [smsnumber] to replace the
recipient’s number. GFI FaxMaker automatically replaces this field with the recipient’s number. For example,
[smsnumber]@providerdomain.com.

CC (Optional) Specify if to send a copy of the message to another email address.

Subject (Optional) Specify an email subject.
NOTE: If provider required the SMS number to be inserted in the subject, include field [smsnumber]. GFI FaxMaker
automatically replaces this field with the recipient’s number.

Body
line 1 -
X

Key in text to show in each email body line, as required by the provider. Fields that can be used:
[smsnumber] - replaced by the recipient’s mobile number.
[smstext] - replaced by the SMS text to be sent.

4. Click OK.

(Optional) To verify settings click Send test.... Key in a test recipient Number to send SMS to and customize the Text
message. Click Send to send the test message. Verify that the test SMS is received by the test recipient.

Clickatell web based service

When using Clickatell service, a number of settings are automatically pre-configured.

NOTE
When using the Clickatell SMS service, ensure that users always include the country code of recipients.

Configure the following options:

1. FromGFI FaxMaker Configuration, right-click SMS and select Properties.

2. In General tab, select Enable SMS Gateway.
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Screenshot 111: Configuring the Clickatell service

3. Select Clickatell Web2SMS service.

4. Select the following options and click Edit... to configure:

Option Description

API Identifier Value assigned by Clickatell on signing up to the service.

From (Optional) Specify the sender value of an SMS message, for example ‘MyCompanyName’.

User name Value assigned by Clickatell on signing up to the service.

Password Value assigned by Clickatell on signing up to the service.

Table 64: Clickatell SMS service properties

5. Click OK.

(Optional) To verify settings click Send test.... Key in a test recipient Number to send SMS to and customize the Text
message. Click Send to send the test message. Verify that the test SMS is received by the test recipient.

Message Media SMS service

When using the Message Media service, a number of settings are automatically pre-configured.

To create a Message Media account for GFI FaxMaker, go to http://go.gfi.com/?pageid=FM_MessageMedia.

http://go.gfi.com/?pageid=FM_MessageMedia
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NOTES

1. When using the Message Media SMS service, ensure that users always include the country code of recipients.

2. The Message Media SMS service does not support Unicode.

Configure the following options:

1. FromGFI FaxMaker Configuration, right-click SMS and select Properties.

2. In General tab, select Enable SMS Gateway.

Screenshot 112: Configuring the Message Media service

3. Select Message Media Service.

4. Select the following options and click Edit... to configure:

Option Description

Username Your Message Media username.

Password Your Message Media password.

SMS Receive Polling Interval Key in the frequency in minutes for GFI FaxMaker to check for new incoming SMS.

Table 65: Clickatell SMS service properties

5. Click OK.

(Optional) To verify settings click Send test.... Key in a test recipient Number to send SMS to and customize the Text
message. Click Send to send the test message. Verify that the test SMS is received by the test recipient.
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10.4.2 SMS options
Configure SMS sending settings:

1. FromGFI FaxMaker Configuration, right-click SMS and select Properties.

Screenshot 113: SMS options

2. From the SMS Options tab, configure:

Option Description

Send multiple SMS messages if
text length is greater than one
standard SMS message

Select to split messages longer than the allowed length into multiple SMS messages. Specify
the maximum number of SMS messages allowed.
NOTE: Each short message is up to 160 characters when using Latin characters, or 70 characters
when using non-Latin characters such as Arabic and Chinese.

Append user information to
outgoing SMS messages

Add one of the following sender information fields either before or after the SMS message:
Display Name
Name
Surname
Company
Department

Detect and remove personal
signature. Truncate SMS message
on the first blank line.

Select to automatically send the text before the first blank line. This ensures that email
signatures are not sent as part of an SMS.

Table 66: SMS options
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Option Description

Enable automatic routing for
incoming messages

Received SMS are automatically routed to the user who sent an SMS to that number.
For example, Joe Bloggs sends an SMS to number 123456. When number 123456 replies back,
SMS is automatically routed to Joe Bloggs.
NOTE: If more than one user sends an SMS to the same number, GFI FaxMaker routes replies to
the latest sender. However, replies are always routed to all users that had sent an SMS to the
same number in the previous 5 hours.

3. Click OK.

10.4.3 SMS Users
To specify the list of users allowed to send SMS:

Screenshot 114: Configuring SMS users

1. FromGFI FaxMaker Configuration, right-click SMS > SMS usersand select New SMS user….

2. Select users to add:

Active Directory: Add users or groups from the Active directory user dialog.

No Active Directory: Select the users allowed to send SMS from the Licensed users list.

3. Click OK.

10.4.4 Routing received SMS
Configure how GFI FaxMaker routes received SMS.

NOTE
GFI FaxMaker can automatically route received SMS to the user that originally sent SMS. To enable option, select
Enable automatic routing for incoming messages from SMS Options. Formore information, refer to SMS
options (page 169).
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1. FromGFI FaxMaker Configuration, right-click SMS > SMS Routing and select Properties.

Screenshot 115: SMS routing properties

2. Configure the following options:

Tab Description

Default SMS Routers Users to whom GFI FaxMaker routes all SMS that have no associated users.

Receive All SMS Messages Users to route all SMS messages to.

Table 67: SMS routing properties tabs

3. Click OK.

10.4.5 Archiving SMS

All inbound and outbound SMS are archived in the same archiving database as fax archiving. Formore information,
refer to Fax archiving (page 89).

10.4.6 SMS log files
GFI FaxMaker logs all activity of incoming and outgoing SMS in two log files within the GFI FaxMaker installation folder:

Log file Description

sms_
sent.log

Contains a log of sent SMS in the following format:
Date,Time,Sender,Recipient,Status,Message,Details
For example:
"7/6/2014","8:23:38 AM","jsmith@masterdomain.com","123126","Success","This is a test
SMS sent from GFI FaxMaker - John Smith","Success. SMS posted to destination."

Table 68: SMS log files
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Log file Description

sms_
recv.log

Contains a log of received SMS in the following format:
Date,Time,Sender,Recipient,Status,Message,Details
For example:
"7/6/2014","8:52:39 AM","621321","bjones@masterdomain.com","Success","This is a test
SMS received by GFI FaxMaker","Success. SMS received."
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11 Uninstalling GFI FaxMaker
This topic describes how to uninstall GFI FaxMaker.

NOTE
Any configurations done on other machines, such as send and receive connectors on the mail server, are not
removed.

1. Exit GFI FaxMaker.

2. From Control Panel select:

Add orRemove Programs - Windows Server® 2003, Windows® SBS 2003.

Programsand Features - Windows Server® 2008/2012, Windows® SBS 2008/2011.

3. From the list of installed software select GFI FaxMaker2014 and click Remove or Uninstall.

4. Follow on-screen instructions.

11.0.1 Removing the Microsoft® Exchange 2007/2010/2013 Connector
This topic describes how to remove the GFI FaxMaker connectors.

Removing the connectors automatically

GFI FaxMaker installed on Microsoft® Exchange Server

If the connectors were created automatically during installation of GFI FaxMaker, the connectors are automatically
removed during uninstall.

No further configuration is required.

NOTE
If the connectors are not named GFIFaxMaker (for example, if connectors were renamed or were manually
created using a different name), remove the connectors manually. Formore information, refer to Removing the
connectorsmanually (page 173).

GFI FaxMaker installed on a separate machine

If the connectors were created automatically by running the GFI FaxMaker setup on the Microsoft® Exchange server, the
connectors are automatically removed by uninstalling GFI FaxMaker from the Microsoft® Exchange server.

No further configuration is required.

NOTE
If the connectors are not named GFIFaxMaker (for example, if connectors were renamed or were manually
created using a different name), remove the connectors manually. Formore information, refer to Removing the
connectorsmanually (page 173).

Removing the connectors manually

GFI FaxMaker installed on Microsoft® Exchange Hub Transport Server

From the Microsoft® Exchange Management Shell, run the following commands:
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NOTE
If a custom name was given when creating the connector manually, replace GFIFaxMaker with the name of the
connector.

1. Remove Receive Connector:

Remove-ReceiveConnector "GFIFaxMaker"

2. Remove Send Connector:

Remove-SendConnector -identity "GFIFaxmaker" -confirm:$false

GFI FaxMaker installed on a separate machine

From the Microsoft® Exchange Management Shell, run the following commands:

NOTE
If a custom name was given when creating the connector manually, replace GFIFaxMaker with the name of the
connector.

1. Remove Receive Connector:

Remove-ReceiveConnector "GFIFaxMaker"

2. Remove Foreign Connector:

Remove-ForeignConnector -Identity "GFIFaxmaker"

11.0.2 Removing the Microsoft® Exchange 2000/2003 Connector
This topic describes how to remove the GFI FaxMaker connectors.

Removing the connector automatically

GFI FaxMaker installed on Microsoft® Exchange Server

If the connector was created automatically during installation of GFI FaxMaker, it is automatically removed during
uninstall.

No further configuration is required.

NOTE
If the connector is not named FaxMakerSMTPConnector (for example, if it was renamed or was manually created
using a different name), remove it manually. Formore information, refer to Removing the connector manually
(page 175).

GFI FaxMaker installed on a separate machine

If the connector was created automatically by running the GFI FaxMaker setup on the Microsoft® Exchange server, it is
automatically removed by uninstalling GFI FaxMaker from the Microsoft® Exchange server.

No further configuration is required.
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NOTE
If the connector is not named FaxMakerSMTPConnector (for example, if it was renamed or was manually created
using a different name), remove it manually. Formore information, refer to Removing the connector manually
(page 175).

Removing the connector manually

FromMicrosoft® Exchange, access the connector from:

1. Launch Exchange System Managerand expand Connectorsnode.

2. Right click the GFI FaxMaker connector name (default value is FaxMakerSMTPconnector) and click Delete.
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12 Troubleshooting and support
This topic explains how to resolve any issues encountered during installation of GFI FaxMaker. The main sources of
information available to solve these issues are:

This manual - most issues can be solved through the information in this help system.

GFI Knowledge Base articles

Web forum

Contacting GFI Technical Support

If this manual does not satisfy your expectations, or if you think that this documentation can be improved in any way, let
us know via email on: documentation@gfi.com.

A list of common issues encountered when using GFI FaxMaker:

12.1 Error “Call failed 46” when sending fax 176

12.2 Cannot send SMS via GSM device 177

12.3 Problems with Microsoft® Office® attachments 177

12.4 Email2FaxGateway test fails 178

12.5 Error 1701 during document conversion 178

12.6 Error 1706 during document conversion 178

12.7 Receiving errors C-0001 or C-0007 179

12.8 No calls answered on a particular fax number 179

12.9 Transmission failure report when using online fax services 180

12.10 Troubleshooting options 180

12.11 Other troubleshooting resources 181

12.1 Error “Call failed 46” when sending fax

Issue encountered

An error Call failed: 46 is shown in the GFI FaxMaker Monitor or in the debug logs.

Causes

This is a generic error indicating that GFI FaxMaker attempted to dial a fax number, but failed to set up the call. The
reasons for this failure can be various depending on the environment where GFI FaxMaker is installed. For example:

The fax device is behind a PABX that does not accept the local fax ID when making an outbound call

The fax number is invalid

The fax line requires a prefix to dial out

CLIP is required to authenticate outbound fax calls

Old Dialogic (Eicon) Diva Server drivers

mailto:documentation@gfi.com
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Possible solutions

Check manually whether the fax number can be dialed and can hear a fax tone

Check if the issue persists only with this fax number and if it is reproducible

Check if a prefix is required in order to dial out

If GFI FaxMaker is behind PABX that does not accept the local fax ID when making an outbound call, remove the
Local fax ID value from the Lines/Devices settings in GFI FaxMaker.

Check if CLIP is required

If using Dialogic (Eicon) Diva Server, download and install the latest drivers fromDialogic website.

If these initial approaches do not resolve the issue, then the root of the problemmight be outside of GFI FaxMaker.

12.2 Cannot send SMS via GSM device

Issue encountered

GFI FaxMaker cannot send SMS via a GSM device

Possible solutions

GFI FaxMaker is not configured to use the COM port as a fax modem.

GSM modem is not installed as a modem in control panel. Other applications such as RAS or Microsoft® Fax may
attempt to take control of the modem.

Test SIM card with amobile phone. Check operation, checking amongst others that there is reception, no pin num
ber has been set, there is enough credits to send SMS.

If no issues are found, perform other checks on GSM device. Refer to:

http://go.gfi.com/?pageid=FM_IssuesSMS

12.3 Problems withMicrosoft® Office® attachments

Issue encountered

GFI FaxMaker encounters problems when converting Microsoft® Office® files to fax.

Possible solutions

Verify that Microsoft® Office® 97 or later is installed on the GFI FaxMaker server. Microsoft® Office® 2007 or higher is
required to convert Office® Open XML files, such as DOCX and XLSX files.

Ensure that Microsoft® Office® is not in trial mode or has an expired license.

Ensure Microsoft® Office® was installed using the same account as that used by GFI FaxMaker fax server services.

Confirm that the account used for installing GFI FaxMaker and Microsoft® Office® has administrator rights.

Run all Microsoft® Office® applications, such as Microsoft® Word® and Excel®, to clear any messages displayed the first
time the applications are run.

Ensure that GFI FaxMaker printer driver is set as the default printer for the machine.

Re-start GFI FaxMaker machine to ensure that changes take effect.

http://go.gfi.com/?pageid=FM_IssuesSMS
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12.4 Email2FaxGateway test fails
The Email2FaxGateway settings specify how GFI FaxMaker communicates with the mail server for sending and receiving
faxes.

From the Configuration Wizard or Email2FaxGateway dialog, click Test to ensure correct communication between the
two servers.

If the test fails, refer to table below for most common causes and solution:

CDO Error Possible Solutions

The transport failed to connect to the server. Connection with the mail server couldn’t be established. Confirm the following
settings:

IP address of the mail server.
SSL settings.
Check if firewall is blocking connection between GFI FaxMaker and the mail

server.

The server rejected one or more recipient
addresses. The server response was: 550 5.7.1
Unable to relay for <email address>

Connection with mail server was established but mail server refused the domain
of the recipients address.
This normally occurs because relaying is not allowed from the GFI FaxMaker
server. Configure SMTP server to accept relaying from the GFI FaxMaker machine's
IP or allow relaying for the internal email domain only.

The server rejected the sender address. The
server response was: 530 5.7.3 Client was not
authenticated.

GFI FaxMaker can connect with mail server but user authentication details are
missing. Select Use SMTP Authentication and key in credentials.

The message could not be sent to the SMTP
server. The transport error code was 0x80040217.
The server response was not available

GFI FaxMaker can connect with mail server but user authentication details are
invalid. Check credentials.

12.5 Error 1701 during document conversion

Issue encountered

Faxes in the GFI FaxMaker Monitor get stuck converting attachments when processing outbound fax jobs. Eventually
conversion times out with error 1701 and message:

Document conversion timeout, or

Coverpage Conversion timeout

Solution

There are various causes for this issue. To determine cause and applicable solution, refer to:

http://go.gfi.com/?pageid=FM_Error1701

12.6 Error 1706 during document conversion

Issue encountered

When sending a fax that contains an attachment, the sender receives a report with the following error:

1706 :DocumentConversion Timeout.

There is no application associated with the file extension of the attachment.

Cause

This issue normally arises when there is no application associated with the extension of the file to fax.

http://go.gfi.com/?pageid=FM_Error1701
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Possible solution

On the GFI FaxMaker server, ensure that the file format sent in the fax can be printed. In Windows® Explorer, right-click a
similar (same extension) file and ensure the option Print is available.

If printing is not available, install an application that can open and print that extension. For example, install an
OpenDocument Text reader (such as OpenOffice) to open and print ODT files.

If printing is available, try using the print option to check whether the association is working correctly

12.7 Receiving errors C-0001 or C-0007

Issue encountered

When sending faxes through the GFI FaxMaker Fax Message Form, the following error codes are returned:

Error: C-0007

Error: C-0001

Possible causes

Interference from a local anti-virus program

The user/email address is incorrect

Mail server settings are incorrect

CDO.Message is corrupt.

Solution

To determine cause and applicable solution, refer to:

http://go.gfi.com/?pageid=FMerrorC0001-7

12.8 No calls answered on a particular fax number

Issue encountered

GFI FaxMakerdoes not answer calls on a particular fax number.

Cause

This issue usually arises when MSN numbers are specified incorrectly.

Possible solution

Configure MSN numbers that GFI FaxMaker should answer from the device properties.

To determine the MSN numbers to answer:

1. Send a fax to GFI FaxMaker, dialling the number that youwant GFI FaxMaker to answer.

2. FromGFI FaxMaker Monitor FaxServernode, take note of the number displayed.

3. Enter this MSN number in the list of MSN numbers of the device properties. Click OKand restart the GFI FaxMakerFax
Server service.

http://go.gfi.com/?pageid=FMerrorC0001-7


GFI FaxMaker 12 Troubleshooting and support |180

NOTE
To answer a whole range of numbers (for example, when using DID routing), enter the starting number of the
range of numbers. For example: to answer all numbers from 35922410 to 35922419, enter 3592241.

12.9 Transmission failure report when using online fax services

Issue encountered

Receiving a transmission failure report when sending faxes using an online fax service

Possible cause

Online fax services require the full recipient number, including the international dial symbol "+", the country and area
codes. Do not use hyphens, spaces or dashes between any parts of the fax number.

The full recipient number is also required when sending faxes locally.

Possible solution

Re-send fax using the full fax number that includes the "+" international dial symbol, the country and area codes.

Formore information, refer to Fax services (page 94).

12.10 Troubleshooting options
This topic describes the available options in GFI FaxMaker that assist in troubleshooting issues:

Performance options

Debug mode

12.10.1 Performance options
Configure the following options that can help improve performance.

FromGFI FaxMaker Configuration, right-click Advanced > Miscellaneousand select Properties. Configure:

Option Description

Allow same
number dial

Enables sending multiple faxes concurrently to the same fax number. If disabled, GFI FaxMaker does not allow
dialling faxes to the same recipient fax number since calls may be rejected due to busy tone.

Do not cache
users on startup

Disables caching of users to speed up startup time. Select for large environments (2000 licensed users or more).

Disable batch
processing

Enable when using an intelligent fax board to speed up fax send process.

Table 69: Performance options

12.10.2 Debug mode

By switching on the GFI FaxMaker debug mode, GFI FaxMaker creates more detailed log files in the logs folder within
the installation directory.

To enable this option, fromGFI FaxMaker Configuration, navigate to Advanced > Miscellaneousand select Properties.
Select option Enable debug mode.
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12.11 Other troubleshooting resources

12.11.1 Knowledge Base
GFI maintains a comprehensive Knowledge Base repository, which includes answers to the most common installation
problems. In case that the information in this manual does not solve your installation problems, next refer to the
Knowledge Base. The Knowledge Base always has the most up-to-date listing of technical support questions and
patches. Access the Knowledge Base by visiting: http://kb.gfi.com/.

12.11.2 Web Forum
User to user technical support is available via the GFI web forum. Access the web forum by visiting:
http://forums.gfi.com/.

12.11.3 Request technical support
If none of the resources listed above enable you to solve your issues, contact the GFI Technical Support team by filling in
an online support request form or by phone.

Online: Fill out the support request form and follow the instructions on this page closely to submit your support
request on: http://www.gfi.com/support/technical-support-form

Phone: To obtain the correct technical support phone number for your region visit: http://www.g
fi.com/company/contact.htm

NOTE
Before contacting Technical Support, have your Customer ID available. Your Customer ID is the online account
number that is assigned to youwhen first registering your license keys in the GFI Customer Area at:
http://customers.gfi.com.

We will answer your query within 24 hours or less, depending on your time zone.

http://kb.gfi.com/
http://forums.gfi.com/
http://www.gfi.com/support/technical-support-form
http://www.gfi.com/company/contact.htm
http://www.gfi.com/company/contact.htm
http://www.gfi.com/company/contact.htm
http://customers.gfi.com/
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13 Glossary

A

Active Directory
A technology that provides a variety of network services, including LDAP-like directory services.

AD
See Active Directory

B

Backup2Folder
A feature of fax routing rules that automatically backs up received faxes in a folder.

Basic Rate Interface
An ISDN channel intended for small systemswhich achieves up to 128kbps data rate.

BRI
See Basic Rate Interface

C

Called Subscriber Identification
An identification string transmitted by the recipient's fax device to the sender during a fax transmission.

CAPI
See Common ISDN Application Programming Interface

Common ISDNApplication Programming Interface
A standard interface that enables applications to communicate with ISDN devices.

Coverpage
A page containing information attached and sent as the first page of a fax. This page is customizable and
can contain company logo and colors, sender and recipient information, fax details and more.

CSID
See Call Subscriber Identification

D

Default routers
A list of users that receive faxes when an incoming faxmatches no routing rules.

Dialtone
A tone heard at the start of a telephone call indicating connectivity with the telephone exchange system
and that the ine is ready for dialing.
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DNS
See Domain Name System

Domain Name System
A database used by TCP/IP networks that enables the translation of hostnames to IP addresses and
provides other domain related information.

DTMF
See Dual-tone multi-frequency signalling

Dual-tone multi-frequencysignalling
The tone generated by the telephone (or fax) device when dialling. This is used for communicating with
the telephone line provider.

E

ECM
See Error correction mode

Errorcorrection mode
A faxmode that automatically detects and corrects errors during fax transmission.

Exchange connector
A Microsoft Exchange feature that forwards sent or received emails to a certain server or domain.

F

Faxadministrators
Users who monitor and manage the fax server. They are also notified by email when critical conditions
occur.

Fax line
A physical telephone line or software-based (FoIP) line, linked to a fax device (modem or ISDN/fax card).

Faxover Internet Protocol
Fax transmission over the internet, rather than the telephone line.

Faxrouting
The methods used by GFI FaxMaker to determine how to route faxes to internal recipients.

FoIP
See Fax over Internet Protocol

FQDN
See Fully qualified domain name

Fullyqualified domain name
The absolute domain name of a network device that specifies the exact location of the device in a
domain's hierarchy.
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G

GFI FaxMakerClient
An application installed on clients' machines used to send faxes and SMS.

GFI FaxMakerserver
The machine where GFI FaxMaker is installed.

Global System forMobile Communications
A standard that defines the protocol for digital 2G cellular networks that is usually used bymobile
phones.

GSM
See Global System for Mobile Communications

H

HTTP
See Hypertext Transfer Protocol

Hypertext TransferProtocol
A protocol used to transfer hypertext data between servers and internet browsers.

I

IIS
See Internet Information Services

IMAP
See Internet Message Access Protocol

Initialization string
A command transmitted between two devices while initiating a connection, used to specify important
parameters of the connection.

Integrated servicesdigital network
A technology enabling digital transmission of data and voice signals over a telephone network.

Internet Information Services
A set of Internet-based services created byMicrosoft Corporation for internet servers.

Internet Message AccessProtocol
One of the two most commonly used Internet standard protocols for e-mail retrieval, the other being
POP3.

ISDN
See Integrated services digital network
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J

Junkfax
Unwanted incoming faxes that are not to be delivered to users.

M

Mailbox
A directory or folder on the mail server used for receipt, filing, and storing messages of emails.

MFP
See Multi-function peripheral

Microsoft Exchange System manager
A specialized MMC console that enablesmanaging your Microsoft Exchange Server organization.

MSN
See Multiple Subscriber Numbering

Multi-function peripheral
A device that performs a selection of common office tasks such as printing, scanning and faxing.

Multiple SubscriberNumbering
A service given by the telephone company that enablesmultiple telephone numbers on one telephone
line.

N

NDR
See Non delivery report

NetPrintQueue2FAX
A GFI FaxMaker printer driver installed on client machines and used for sending faxes. On printing to this
driver, it delivers content to GFI FaxMaker for transmission. GFI FaxMaker determines fax recipient details
from within the printed content.

Non deliveryreport
An automated email sent to the sender on an email delivery problem.

O

OCR
See Optical Character Recognition

Optical CharacterRecognition
The process of converting received faxes into text.
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P

PABX
See Private Automatic Branch Exchange

POP3
See Post Office Protocol 3

POP3Downloader
The GFI FaxMaker feature that retrieves faxes and SMS from a POP3 mailbox for transmission.

Post Office Protocol 3
A protocol used by local email clients to retrieve emails from mailboxes over a TCP/IP connection.

PRI
See Primary Rate Interface

PrimaryRate Interface
An ISDN channel intended for larger systemswhich is capable of achieving higher speeds than Basic Rate
Interface.

Private Automatic Branch Exchange
A digital telephone system within a network. This enables internal calls within the network and tele
phone connectivity with the external system.

PSTN
See Public switched telephone network

Public folder
A common folder within Microsoft Exchange that allows users to share information.

Public switched telephone network
A global telecommunications network that operates the traditional telephony system.

R

Routing
See Fax routing

S

Secure SocketsLayer
A protocol that ensures integral and secure communication between networks.

Short message service center
The center that routes and regulates SMS functionality of a wireless network.

SIMcard
A card that plugs in to a GSM cellular device which stores cellular subscription information.
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Simple Mail Transport Protocol
An internet standard used for email transmission across IP networks.

SMSC
See Short message service center

SMTP
See Simple Mail Transport Protocol

SMTPConnector
The GFI FaxMaker process that connects to the mail server and uploads emails for transmission to internal
users.

SSL
See Secure Sockets Layer

T

Transmission report
An email sent by GFI FaxMaker to internal users that contains information about sent/received faxes/SMS.

U

UNC path
A standard that specifies the location path of a network resource.

URL
The Uniform Resource Locator is the address of a web page on the world wide web.

V

Voice over Internet protocol
A digital telephone system that uses the internet as the transmission medium, rathen than the PSTN.

VoIP
See Voice over Internet protocol
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ANALOG CAPI2.0 devices 72

API Identifier 167

Archiving 14, 51, 89-90, 93, 104, 106, 146-147, 149-150, 157,
163, 171
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Auto-print 75, 158

B

Backup faxes 75, 153

Baud Rate 164

Billing 115, 137, 141, 143

Brooktrout fax board 14, 58, 60, 72, 105

C

Call blocking 126

Call failed 176

CDO error 178

Character delay 79

Clickatell 163

Cluster 13, 23

Communications ports 78

Configuration Wizard 15, 40, 43-44, 55, 60, 178

Country code 57, 88, 94, 166

Coverpages 11, 60, 118-122, 124-126

CSID Routes 150

CSID Routing 145, 149

D

Data initialization string 79

Debug mode 180

Default coverpage 118-120

Default routers 42, 44-45, 154

Dial prefix 74, 88, 94

Dial tone 72

Dialling options 87

DID 72, 145, 147, 153, 180

DLE codes method 79

Document conversion 60, 107, 111, 178

Dual-tone multi-frequency signalling 72, 115, 145, 147

E

Email2Fax gateway 69, 83

Email2FaxGateway test 178

Error correction mode 74

Exchange Connector 19

F

Failed faxes 66, 89, 101, 114

Fax administrators 59, 81

Fax class 79

Fax initialization string 79

Fax lines 57, 61, 68, 71, 77, 106, 149

Fax modem 14, 71, 78, 106

Fax transmission 11, 14, 16, 86, 88, 103, 107, 112, 123, 126,
140, 143

faxmaker.com 16-19, 23-24, 38, 40, 42, 44-45, 50, 60-63, 66,
85, 94, 99, 160

Firewall 15, 178

Flow control 79

Footer 116

Forum 176, 181

Front Covernotes 118-119, 124-126

G

Gateway devices 72

Gateway settings, SMS 163

GFI FaxMaker Client 56

Gmail 44, 51

Google Apps 14, 39, 44

GSM modem 162, 177

H

Hardware 13, 53, 58, 60, 133

Header 74, 116

HPDS 100

HPFSCAN 101

Hub Transport role 14, 17-18

I

IIS SMTP 14, 49-50, 55, 61

Inbound queue 69

Initialization String 73, 164
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International dialling 89

Internet Address 22, 32

Internet Message Access Protocol 25, 32

ISDN 58, 71-72, 145, 147

ISDN BRI CAPI2.0 devices 72

J

Junk fax 107, 159

K

Knowledge base 176, 181

L

Licensed users 63, 76, 79-81, 85, 90, 146-147, 150, 170, 180

Line Routing 145, 149

Local fax ID 74, 177

Log files 51, 98, 104-105, 171, 180

Lotus Domino/Notes 24, 31, 35

M

Max. resolution 74

Max. speed 74

Merge-fields 118, 122, 124

Message Media SMS service 163

Microsoft Exchange 2000/2003 18-19, 23, 174

Microsoft Exchange 2000/2003/2007/2010/2013 16-18, 20,
23, 54

Microsoft Exchange 2007/2010/2013 16, 18, 23, 173

Microsoft Office 365 14, 39-40, 42, 86

Modem type 73, 78-79

MSN 72, 145, 147, 179

Multi-function peripheral 63, 138, 140-142

Multiple mail servers 50

N

National dialling 89

NetPrintQueue2Fax 11, 51, 55, 61, 63, 107, 133-135

Network Share 51, 151, 154

Nuance eCopy ShareScan 61, 63, 107, 138-139, 141-142

O

OCR 11, 97, 104, 145, 147

Operating systems 13, 61, 133, 157

Optical Character Recognition 97, 147

Outbound Queue 69

P

PABX 74, 176

Performance options 180

POP3 14, 16, 24, 29, 32, 49-50, 56, 61, 69, 84-85

POP3 Downloader 50, 64, 84-85, 160

Port 47, 56, 83-84, 99, 140, 177

Pre-command delay 79

Printers 75, 107, 110, 133, 145, 152, 157

Public folder 156

R

Receive all faxes 62, 156-157

Receiving faxes 10-11, 14, 17, 24, 42, 44-45, 49, 51, 57, 61-62,
67, 70, 74-75, 80, 90, 95-97, 99, 106, 110, 115, 144-
147, 149-150, 153-154, 156, 158, 178-180

Receiving SMS 51, 162

Remote Monitor 54, 69

Requirements, SMS 162

Routing, fax 11, 145, 149, 157

Routing, SMS 163, 170

S

Sangoma fax board 58, 72

SAP 4.7 49-50

Secure Password Authentication 40, 43-44, 57, 83

Sending faxes 17, 24, 42, 44, 49-50, 61, 63, 65, 70, 73, 85, 88,
94, 109, 126, 134, 137-138, 140, 142, 179-180

Sending SMS 160

SIM card 164, 177

SMS

Archiving 163, 171

Log files 163, 171

smsmaker.com 16-19, 23-24, 38, 40, 42, 44-45, 50, 61-62, 64,
66, 85, 99, 160

SMTP Connector 19, 48, 83, 174

SMTP/POP3 mail servers 10

SR140, Brooktrout 58

SSL 40, 52, 57, 83, 85, 178

Suffix 74

Supported mail servers 13

Supported operating systems 13
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System Requirements 13, 40, 42, 44, 106

T

Technical support 176, 181

Test fax 42-43, 45, 49, 62, 77, 87, 99

TextAPI 56, 61, 106, 135

Thread priority 79

Tone 72, 177, 180

Transmission report 17, 24, 49, 51, 62, 65, 97, 110, 112, 142,
151

Troubleshooting 176, 180-181

Truncate 169

U

Uninstall 60, 173-174

Upgrading installation 53, 60, 105

Use SMTP Authentication 40, 43-44, 57, 83, 178

Use SSL 40, 43-44, 57, 83, 85, 140

Users, SMS 163, 170

V

Voice chipset 79

Voice initialization string 79

W

Web based SMS 162-163

Wizard 59

X

XMLAPI 106, 135-136, 161

GFI FaxMaker Index |190



USA,CANADAAND CENTRALAND SOUTH AMERICA

4309 Emperor Blvd, Suite 400, Durham, NC 27703, USA

Telephone: +1 (888) 243-4329

Fax: +1 (919) 379-3402

ussales@gfi.com

UKAND REPUBLIC OF IRELAND

Magna House, 18-32 London Road, Staines-upon-Thames, Middlesex, TW18 4BP, UK

Telephone: +44 (0) 870 770 5370

Fax: +44 (0) 870 770 5377

sales@gfi.co.uk

EUROPE,MIDDLE EAST AND AFRICA

GFI House, Territorials Street, Mriehel BKR 3000, Malta

Telephone: +356 2205 2000

Fax: +356 2138 2419

sales@gfi.com

AUSTRALIAAND NEWZEALAND

83 King William Road, Unley 5061, South Australia

Telephone: +61 8 8273 3000

Fax: +61 8 8273 3099

sales@gfiap.com

mailto:ussales@gfi.com
mailto:sales@gfi.co.uk
mailto:sales@gfi.com
mailto:sales@gfiap.com

	1 Introduction
	1.1 How fax sending works
	1.2 How fax receiving works

	2 System Requirements
	2.1 Software requirements
	2.2 Hardware requirements
	2.3 Backup software
	2.4 Anti-virus software
	2.5 Firewall settings

	3 Mail server configuration
	3.1 Microsoft Exchange
	3.2 Lotus Notes/Domino
	3.3 Hosted email
	3.4 Other mail environments
	3.5 Using GFI FaxMaker without a mail server

	4 Installing GFI FaxMaker for the first time
	4.1 Installation procedure
	4.2 Run the GFI FaxMaker Configuration Wizard
	4.3 Upgrading to the latest version while retaining all settings
	4.4 Downloading the latest version of GFI FaxMaker
	4.5 Installing GFI FaxMaker on Windows 8.1, 8, 7 or Vista
	4.6 Testing your installation

	5 Using GFI FaxMaker
	5.1 How users send faxes
	5.2 How users view received faxes
	5.3 Monitoring GFI FaxMaker operation

	6 General configuration settings
	6.1 Fax Lines
	6.2 Licensed users
	6.3 Fax administrators
	6.4 Mail server settings
	6.5 POP3 Downloader
	6.6 Fax and SMS domain names
	6.7 Dialling Options
	6.8 Fax archiving
	6.9 Fax services
	6.10 OCR
	6.11 Log files
	6.12 HP Digital Sender integration
	6.13 Storing faxes
	6.14 Licensing information

	7 Maintenance
	7.1 Configuration backup
	7.2 Moving your installation to a different server
	7.3 Version information
	7.4 Product Patches

	8 Configuration - Sending faxes
	8.1 Sending options
	8.2 Document Conversion
	8.3 Transmission reports
	8.4 Header/Footer options
	8.5 Coverpages
	8.6 Front Covernotes
	8.7 Call blocking
	8.8 Public contacts
	8.9 NetPrintQueue2FAX
	8.10 GFI FaxMaker APIs
	8.11 Billing
	8.12 Multi-function peripherals

	9 Configuration - Receiving faxes
	9.1 Receiving Options
	9.2 Fax routing
	9.3 Printers
	9.4 Junk Fax filter

	10 SMS
	10.1 How to send an SMS
	10.2 Receiving SMS
	10.3 SMS Requirements
	10.4 Configure SMS settings

	11 Uninstalling GFI FaxMaker
	12 Troubleshooting and support
	12.1 Error “Call failed 46” when sending fax
	12.2 Cannot send SMS via GSM device
	12.3 Problems with Microsoft® Office® attachments
	12.4 Email2FaxGateway test fails
	12.5 Error 1701 during document conversion
	12.6 Error 1706 during document conversion
	12.7 Receiving errors C-0001 or C-0007
	12.8 No calls answered on a particular fax number
	12.9 Transmission failure report when using online fax services
	12.10 Troubleshooting options
	12.11 Other troubleshooting resources

	13 Glossary
	14 Index

